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Notes on this guide 

- Colored texts indicate buttons of the program- 
Otherwise, italic text generally means designations in the program- 
Further information is partly in small print- 
The first part "Quick Start Guide" is an introduction. In the second part, "Planning and Managing 
Measurement Tasks", recommendations and important information are given, while in the third 
part, "Advanced Functions", extensive possibilities are presented; however, knowledge of these is 
not absolutely necessary for the basic use of the program. 
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Quick Start Guide BlueDAQ 
BlueDAQ (long form: BlueDAQchannel) is an application program for displaying and 
recording measurement data and for configuring digital amplifiers. The following models 
are supported: BX8, BX6, BSC4D, BSC1, BSC2 and BSC8D. One or more strain amplifiers can 
be used at the same time, so that up to 127 measurement channels can be displayed and 
processed. 

Connecting the Amplifier 
After starting the BlueDAQ software, the functions 
Add Channel, Open Session and File Monitor are available. 

 
Add Channel opens the dialog for entering the connection data to open a strain gage 
amplifier or additional channels of a device. 
Please select the device model with device type, the COMport number1 and the desired input 
channel(s). 
Repeat Add Channel until you have all the channels and devices you want. 

 

 
Tips: For devices with multiple input channels, Open all input channels allow you to open all available 
inputs from this amplifier. The default setting of the communication bit rate (bits/s) is automatically 
pre-selected based on the device model. If this is different, it must be set correctly. 

 
 

1In the BSC8D, BX3-HD44-CON, and the BX6-ETH/CAN it is a device number; here the communication interface 
is set or set accordingly. 
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Configuration tab 
In this tab, navigate to the desired channels by selecting Actual Channel in the upper right 
corner. The names of the channels, e.g. "Chan. 3_1" you can overwrite Channel name with 
your own name in the text field and finish typing with Enter. Alternatively, you can do this 
from the menu bar with channel > name. 

 
With the four buttons in the center, you define the essential properties of the sensor on the 
currently selected channel: 
Set Zero: Performs a zero adjustment of the sensor. The button in yellow-orange color 
indicates that this setting is stored in the memory of the amplifier/sensor. 
Note for temperature and voltage inputs: By default, the software prohibits zeroing of temperature 
and voltage inputs. This can be changed in Menubar→Options, see S.85. 

User Scaling: This opens a window for entering the scale or calibration data for the sensor. 
As a rule, this setting must be made once during commissioning, see S. 8. Before changing 
the scale, the Input Type should be set, if it is not already set correctly. 
Data Frequency: This is where the number of measured values sent via the interface per 
second is entered. Please select the frequency required for the measurement task. For 
multi-channel devices, it is automatically the same for all input channels. 
For multi-channel devices, it means the number of whole data frames with input channels, i.e. the 
total number of all measured values of all channels = Data Frequency x Input Channels. The lower 
the frequency, the lower the noise, i.e. the better the effective measurement resolution, s.p. 16. 

Input Type: Here the input type and the electrical measuring range are selected, see S. 7. 
This step is usually performed first to configure a new sensor. 
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Load Settings can be used to restore the factory settings (default) of the amplifier or those 
that have previously been stored by the user in the memory of the device with Save Settings 
(Users 1-6, if available for the device model). 

Input Type 
The Input Type button opens the dialog for setting the electrical input range for the selected 
channel; if necessary, different physical input types can be selected. The adjustment options 
depend on the model of the connected amplifier; In the following, they are shown as 
examples of the BX8. 
Three measuring ranges of 2.0 mV/V, 3.5 mV/V and 7.0 mV/V are available for sensors with 
strain gages. The three measuring ranges of the BX8 are connected to three permanently 
assigned bridge supply voltages. 

• 2 mV/V: 8.75 V (Note: This supply voltage is not recommended for some sensors; 
see the sensor data sheet for more information). 

• 3.5 mV/V: 5.0 V 

• 7 mV/V: 2.5 V 
 

The selected measurement range should be greater than or equal to the electrical output 
range of the sensor, i.e. greater than its characteristic value at its nominal value. 
Tip: For some amplifiers, e.g. BSC4D and BX8, temperature sensors or single-ended voltage inputs 
can also be selected. Other types of sensors almost always need to be connected to other ports on 
the device, and other cables may need to be used. The operating instructions of the devices provide 
information on this. 
The definition of the bridge type (full, half or quarter bridge) for strain gages is also done via the 
hardware of the multiple strain gage amplifier, for example via other connections or 
switches/jumpers. See its instruction manual and S.45 
Note: If the input type is changed, the scaling (user scaling) is usually automatically reset, so that a 
previous sensor configuration may be overwritten! This is done so that the strain gage amplifier 
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displays the new electrical input variable (or temperature) correctly. The scaling may then need to be 
readjusted for a specific sensor. 

Scaling 
The User Scaling button opens the dialog for entering or calculating the scaling factor with 
which sensors are adjusted. 
The scaling factor is calculated from: 

• The measuring range of the sensor (Physical Full Scale) 

• The output signal change of the sensor at this 100% load (Electrical Full-Scale output). 
This usually corresponds to the characteristic value specified in the test protocol of 
the sensor. 

• The physical measuring range of the amplifier (input range). This is usually read 
automatically by the software. 

The choice of unit does not affect the result; it is merely a label. Enter the Physical full scale 
of the sensor accordingly. 

 

 
Enter the values and then press Calculate and then OK / Set to save the scale in the 
amplifier. The value will then appear in the Configuration tab next to User Scaling under 
Range. It corresponds to the full electrical input range, but usually not to that of the sensor, 
which is usually smaller. 
Tip: If you connect sensors with TEDS, you don't need to enter the scale because it is set 
automatically. See p. 49 
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Recorder Yt 
In the Recorder Yt tab, the measured values are displayed graphically in real time over the 
current time. 
Use "Start Measuring" or "Stop Measuring" to start or stop the graphical display. Start 
Recording, Stop Recording, to start or stop recording measurement data to a file. 
The displayed index card may be changed at any time, even during a measurement or 
recording, which is not affected by it. 
Set All Zero performs zeroing for all channels. Note that the Set Zero button may be disabled 
for individual channels, e.g. for force/torque sensors or for other calculated channels. Then 
Set All Zero should be used. 
Right-clicking on the graphic opens the context menu for various settings, such as: 
Autoscale. 

 

If Autoscale Y is disabled, you can click on the minimum and maximum values of the y-axis 
and change them by changing the full scale values and pressing Enter. 
You can set the temporally visible range with Time Visible. 
Under Display There is a selection of options for the display of the numerical measured 
values with a turquoise background, the so-called "Numerical Values". Single Value Display: 
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For example, by Max-Min the noise amplitude or by Resol Parts PP a quality number 
"measuring range / noise amplitude" can be displayed, see p.18. 

 

 
With the button Configure Recording , the properties for the recording of measured values, 
e.g. start and stop conditions as software triggers, can be defined. See p. 58. 
With the Add Graph Window button you can open more graphic windows, e.g. to display 
forces and moments in different windows with their own graphical scaling or to perform a 
spectral analysis (FFT). 

Load and save measurement job 
All settings regarding the graphics window and naming of channels, as well as interface 
numbers etc. can be saved in a session file of type *.ucf when leaving the program or with 
the help of the Save Session button, and can be restored by Open Session or by double-
clicking on the ucf file before starting the program. No amplifier settings are stored in this 
file. 
When restoring the channels, all saved channels of all devices are opened and other settings 
are also loaded, see S. 14. 
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Graphic Display Graph Display 
The Graph Display tab provides graphical displays over time for each channel. 

 

The right-click menu offers similar capabilities as in Yt Recorder. Up to 16 channels can be displayed 
here. 

Large Value Display 
Below this index card, a large numerical display of all channels is available. 

 

 
 
Display of recorded measurement data 
With File Monitor in the index card Configuration a file selection window opens, in which the 
last file with Start Recording is pre-selected. After confirming with OK, the display window 
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for measurement data files opens. They can be displayed graphically or as a table of values 
and with Export can also be converted to other formats such as Excel or CSV. With the 
mouse scroll wheel or the zoom options of the graphics palette, the display can be enlarged, 
reduced or moved, and cursors for various functions can also be displayed; see p.67 

Further help and sources of information 

• Context Help can be opened under the menu bar → Help → Show Context Help. This 
is a small help window that displays information for each control when you hover 
over it. 

• On the Internet, on the website me-systeme.de there is more information 

• For some special functions, e.g. MathScript/MathChannel (only for PRO version) has 
its own instructions 

• The operating instructions of the amplifiers used should be read during initial 
commissioning 

 
 
General Information About the Software 

• Buttons or other controls that cause settings to be saved in the device are 
highlighted in yellow. 

• When operating functions that require multiple inputs within a dialog box, 
the operating order is usually from top to bottom and/or from left to right. 

• All buttons and other input elements of the main window are also 
accessible via the menu bar at the top. This does not apply the other way 
around, i.e. there are also functions or dialog boxes that can only be 
accessed via the menu bar. 

• For many functions, the menu bar also mentions keyboard shortcuts (so-
called hotkeys) that also trigger this function. If it is noted here: Ctrl+< key>, 
press and hold the Ctrl key (control) first, while then pressing <key>, e.g. Ctrl+PageUp: 
First hold down Ctrl, then scroll up: Enlarge the displayed channel in Configuration. 

Scheduling and Managing Measurement Tasks 
Before carrying out a measurement, it is useful to clarify the following questions: 

• Which sensors and measurement channels are needed? 

• Which measurement data rate should be chosen? 

• Should the evaluation only take place during the measurement runtime, i.e. as a live 
view in real time, or should the measurement be recorded first and evaluated later? 

Especially in the case of measurements with important results or those that are time-
consuming to perform, it is recommended to carry out one or more test measurements 
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after planning and configuring the measurement system. If possible, this should be done 
with the same device, and sensor copies in the same place and on the same PC where the 
actual measurement is to take place. 

Channels 
A measurement channel represents a physical quantity that is usually converted by sensors 
into electrical quantities that the amplifier captures and digitizes. In this process, the analog 
values are converted into numbers with a fixed number of measured values per second, the 
measurement data rate (data frequency). The BSC2 and BSC1 amplifiers have only one 
measurement channel; for all others, the input to which the measurement channel belongs, 
as well as the device name, are displayed next to Input in the upper right corner of the 
Configuration tab. The device serial number appears next to Device Serial No. 

 
The channel number that you see next to Actual Channel is 
determined by the order in which the channels were added by Add 
Channel and is usually freely selectable. An exception to this is 
MathChannels, which represent calculated software channels and are 
added to channels according to the hardware, or are automatically sorted 
accordingly, as 2 well as counter channels, see below. 

It is convenient to give the measurement channels descriptive 
names. You can do this by changing the name directly in the 
Channel Name display field and then pressing the Enter key or 
by clicking on the menu bar → channel → name... click. 
When the channels are added, up to 32 different colors are 
automatically assigned. You can change them in the Add 
Channel dialog at the bottom left or later with the menu bar → 
Channel → Color... 
This color is also used to display the channel name under 
Channel Name in the configuration tab, and graphs of recorded 

measurement data files are also displayed in the File Monitor with this color. 

Types of Devices and Measurement Channels 
In the free version of BlueDAQ there are currently two basic types of channels: analogue 
channels and counter input channels. The BSCD8, BX6BT and BX8 amplifiers provide 
counter inputs that can be used to count digital pulses or measure frequency. A counter 
channel can be added after at least one analog channel of the same device has already 
been added. To do this, select Function = Digital Counter in the Add Channel dialog on the 
right. 

 
 
 

 

2Calculated channels (MathChannels) are only available with BlueDAQ PRO. This function is described in a 
separate manual. 
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For the BX8 and BX6BT, the meter must be 
activated and configured once, see p. 120. 
Scaling can also be used for meter inputs 
with User Scaling (but not calculated by 
every method). 
In addition to the device or COM port 
number and input channel, the channel 
type also determines the default channel 
name. 

BlueDAQ PRO offers additional special channels, which are created by opening the following devices 
(device type): 

• GPS / GNSS for satellite-based positioning: Latitude, Longitude, Altitude , Speed and UTC 
time 

• Math Script: Math Channels Calculated by Custom Script 
• User Device: Devices from other manufacturers that send measured values as a text string 

via a serial interface, see105. 
These special channels have only limited configuration options; only the channel name, unit and 
color can be changed. 

Load and save measurement session 

The channel list can be saved with Save Session. You can then restore them at any time, 
even after restarting BlueDAQ, with Open Session. This file also contains information about 
how the integrated devices are opened (COMport number, baud rate, input channel) and 
how they are displayed (channel name, color) and, in the case of special channels, also the 
unit and, if necessary, settings via special functions. With Open Session, the embedded 
channels are opened, and the display properties are restored. 
By double-clicking on the session file (e.g. in Windows Explorer) BlueDAQ can be started and 
then this session will be opened automatically. 
The session file does not contain the configuration data of the amplifiers (i.e. those that are 
stored with yellow buttons in the device). Instead, amplifier settings can be saved to a file 
using Save Settings → Save to file and restored → Load from File using Load Settings. 
A backup with all settings files of all integrated amplifiers, including the session file, can be 
created using the menu bar → Help → Create Settings Archive. It is a ZIP archive that 
contains these files. 

Master-slave synchronization with multiple amplifiers 
If more than one strain gage amplifier device is integrated and the measurement data rates 
are relatively high or the recording time is rather long, it makes sense that the amplifiers are 
synchronized. Otherwise, due to the asynchronous data transmission, temporal errors can 
accumulate (i.e. magnify), so that after a certain time after the start of the measurement, 
the measured values of the different devices no longer coincide in time. 
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With master-slave synchronization, the time of transmission of a measurement data frame 
is adjusted via the serial ports of all devices (i.e. also via USB, Bluetooth, Ethernet). 
It is a hardware feature that can be enabled on BSC4D, BX6BT/CPU and BX8 devices 
(available as an order option on BSC1USBx2). In this case, a line must connect certain digital 
I/O connections of the devices with each other, i.e. a digital I/O port and (D)GND must be 
connected to the devices by cable. Exactly one of the devices is configured as the master 
and this generates a digital synchronization signal, namely a rectangle with the frequency of 
the set data rate. At one of the edges (usually rising, i.e. low→high) the master also 
transmits its measurement data frame, and the slaves recognize this edge and also send 
their measurement data frames. 
If the master-slave function is activated for all connected strain gage amplifiers, BlueDAQ 
will apply a sync sequence when clicking on Start Measuring; in which the transmission is 
temporarily stopped, the data buffers are deleted and the master is then started, so that all 
devices start sending measurement data at the same time. 
The prerequisite is that synchronization is activated in the program options and that all 
connected devices support master-slave, are properly wired (see above) and configured 

(see below). In the software settings, under the menu bar → Options 
→ Hardware -> Master / Slave synchronization, if available, must be 
set to Synchronization, which is the case in the default settings. 

Master-slave synchronization is configured and verified in the strain gage amplifiers in the 
following ways : In the Configuration with Actual Channel tab, select a channel that belongs 
to the device you want to configure or verify. Then click on Device in the menu bar and select 
Advanced Settings... In this dialog, the master-slave mode is displayed in the Value Mode tab: 

 

Tx-Sync. Slave Mode Enabled 
 
 
 
 
 
 

Tx-Sync. Master Mode Enabled 
 

This indicator is only available on BSC1, BX6 and BX8. 

 
Without Tx-Sync. 

Master or slave mode is activated in the Digital I/O tab in the Advanced device Settings. To do 
this, use the I/O number to select the digital I/O port to which the synchronization line is to 
be connected. Usually (and if this cable was purchased pre-assembled from Interface) these 
are the following: 

• BX8: I/O number 16 for master and for slave 

• BX6: I/O number 1, 2 or 3 for master and 4 (TRIG) for slave 
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• BSC4D: any from 1 to 8 for master and for slave 
In this case, it is best to put the slave into 
its mode first, in order to avoid accidentally 
connecting two outputs (master) through 
the connected sync cable, because this 
would be tantamount to a short circuit. To 
do this, select Sync. Slave with I/O type off. 
Then Store to device. 
Then configure the master by setting this 
I/O type to Sync. Master 's degree. 
With the BX8, you may receive an intermediate 
message warning that all I/Os 13-16 (i.e. those 
of the group of four to which the selected I/O 
belongs) will be switched as input or output. 
This must be confirmed; if these three other 

I/Os are intended for an incompatible function, other I/Os may need to be used. 

If a slave device does not receive a synchronization signal, e.g. because the cable is not 
connected or the master is turned off, it does not send any readings, so that timeout will 
appear in the reading display of the configuration tab. 

Remove channels or devices 

In Configuration the channel displayed on the tab can be viewed with Remove Channel to be 
removed. If you want to remove one or more hidden channels, you will first have to remove 
all hidden channels with the menu bar -> Channel -> Unhide All be brought out. Hidden 
channels were previously used with Channel >Hide hidden, e.g. because they are only 
needed as the input value of a calculation, but should not be displayed, see e.g. S. 42 

To remove all channels belonging to a particular 
device, you can click on Menu 
Bar->Device->Close. If several devices are open, a 
dialog will appear in which you select the device 
to be removed with Remove on the right and then 
confirm with OK. Then all channels of this device, 
whose name (model), comport and serial number 
(Serial No) are displayed on the left, will be 
removed, including hidden channels. 

Selection of the measurement data rate 
The data frequency is the number of measured values (samples) that the amplifiers take 
and transmit per second and per channel. If several amplifiers are used, it should be set as 
much as possible in the same way for all devices; otherwise, you may receive a warning 
message when you click on Start Measuring. The measurement data rate of multi-channel 
amplifiers is always the same for all measurement channels and it is to be understood as a 
single sample rate, i.e. per channel (i.e. multiplied by the number of input channels results in the 
sum sample rate). 
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To change it, activate a channel belonging to the amplifier with Actual Channel and click 
Data Frequency, which opens the Change Data Rate dialog. After successful modification, 
the same measurement data rate is displayed for all its channels. 

The range of values of the measurement data rate 
depends on the amplifier model and is displayed in the 
Change Data Rate dialog under minimum and maximum: 
For many device models, the maximum also depends on 
other settings and configurations. If the serial UART or 
RS232 interface is enabled, this maximum is strongly 

dependent on the communication bit rate, for example, s. S.99 
It is not possible to set all measurement data rates continuously. It is therefore possible that 
the data rate closest to the desired value is set; this is especially true for the BSC4D, BX6 
and BX8 models, especially at high values. The operating instructions of the devices provide 
more detailed information on this. 

 
Which measurement data rate is chosen depends on the measurement task. It should 
always be as low as possible, but sufficiently large if even short changes such as peaks or 
vibrations are to be recorded. 
High measurement data rates (i.e. those above 50/s, depending on the application) and low 
data rates have the following advantages and disadvantages: 

 

 High data rate Low data rate 

Advantages Rapid changes are recorded, e.g. peaks, 
oscillations 

Lower noise, i.e. better effective amplitude 
resolution 

Good frequency representation possible 
with FFT 

Smaller files for data recording 

High temporal resolution Reduced load on the PC 

In some cases, there is less time delay 
(latency) between signal change and 
measured value change3 

Better suppression of disturbances, e.g. 
electromagnetic 

Disadvanta 
ges 

Higher noise, i.e. poorer amplitude 
resolution 

Rapid changes in the measurement signal 
are not detected 

Large files during data recording, 
resulting in slower file processing and 
more complex evaluation 

Frequency representation (FFT) not very 
meaningful 

Increased utilization of the PC The portion of latency that depends on the 
data rate is longer 

 
 
 

3There is a constant fraction tk of this delay time and one dependent on the data rate, so the total latency= tk + 
t(Fdata). 
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Each amplifier has a maximum frequency of measurable signals, i.e. a limited bandwidth, so 
it always acts as a low-pass filter. In the case of digital amplifiers, this bandwidth is 
determined, among other things, by the measurement data rate; it is typically about 0.3 to 
0.4 x measurement data rate. However, the bandwidth can be even lower, e.g. due to 
analogue pre-filters. The larger the bandwidth, the higher the noise, i.e. the dynamic, 
normally distributed portion of the measurement uncertainty increases with the bandwidth. 
How much greater the noise is at a higher data rate also depends on the amplifier and the 
strength of external interference sources. Most amplifiers operate internally at a higher 
sampling frequency, which they then reduce by averaging or decimating digital filters. To 
compare the signal-to-noise ratio change when comparing two data frequencies f1 and f2, 
with f1>f2, the following is a rough rule of thumb: 
R(f1) ≈ R(f2) x √(f1/f2) 
Example: At the measurement data rate f1 = 1000/s, the self-noise R(f1) is about 10 times 
greater than at f2 = 10/s, because √(1000/10) = 10. Self-noise only includes the noise 
generated by the amplifier itself without external sources of interference. 

Analysis of noise and signal-to-noise ratio 
In many applications, it is possible to find out the most suitable measurement data rate 
through test measurements. It is advisable to start with a rather high data rate. As a result, 
external sources of interference can also be detected, especially if the test measurement 
takes place at the same location, in the same environment, for example with machines 
switched on nearby, as during the actual measurement. 
For example, you can start with half (or more) of the maximum adjustable data rate. 
Then leave the sensor alone for the time being, i.e. avoid changing the useful signal. Now 
you can determine the signal-to-noise ratio and, if necessary, find interference frequencies. 
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To do this, start a measurement and select one of the following settings using the Display 
pull-down selection element : 

 

Selection Description Unit Internal calculation 

SNR [dB] Signal-to-noise ratio: Signal-to-noise ratio 
Short peaks are smoothed out! It is related to 
the input measuring range, the average value 
is subtracted and the result is converted into 
decibels. 

Db 
 

 

Resol. Parts 
pp 

Resolution in Parts pp: Relative peak 
resolution relative to the input measurement 
range 

none 
 

 

Max-Min Absolute peak resolution in the unit of 
physical quantity. 

such as 
measurand 

Maximum - Minimum 

RMS/StDev Root-Mean-Square / Standard Deviation in 
the Unit of Physical Quantity. 
In the process, short peaks are smoothed 
out! 

such as 
measurand 

 

 

Range is the measuring range of the amplifier input, as it is usually displayed in the Configuration tab. 
xi are all measured values of the sample, Max is the maximum value, and Min is the minimum value 
of the sample. The sample is recorded via N=100 values or over one second, i.e. at a measurement 
data rate > 100/s, N = measurement data rate. 

The result is displayed in the turquoise green field on the right. By selecting SNR [dB] or 
Resol. Parts pp, the noise can be judged independently of the measuring range. Interface 

http://www.interfaceforce.com/


7418 East Helm Drive • Scottsdale, Arizona 85260 • 480.948.5555 • www.interfaceforce.com 

20 

 

 

usually specifies the peak value resolution for amplifiers (Resol. Parts pp), other manufacturers often 
only use the signal-to-noise ratio SNR. 

If a sensor is already connected and adjusted, Max-Min can be used to check peak noise 
and RMS/StDev can be used to check standard deviation, both in physical units. 
The following table shows typical noise levels of a BX8. External interference has been 
eliminated here. 

 

Fdata [Hz] Input SNR[dB] RMS [nV/V] NoisePP [parts] NoisePP [nV/V] 

10 2 mV/V 119 2,24 100000 20 

10 3.5 mV/V 113 7,84 100000 35 

10 7 mV/V 115 12,45 100000 35 

1000 2 mV/V 103 14,16 24000 83,33 

1000 3.5 mV/V 103 24,78 24000 145,83 

1000 7 mV/V 103 49,56 24000 291,67 

12000 2 mV/V 94 39,91 6500 307,69 

12000 3.5 mV/V 94 69,83 6500 538,46 

12000 7 mV/V 94 139,67 6500 1076,92 

In the specification SNR and RMS, you get better values for the same test measurement, 
because short peaks are averaged away. 

 
The illustration of the Recorder Yt above shows a test shot with a BX8 at a measurement 
data rate of 6000/s of a sensor with a measuring range of 2500 N. The absolute peak 
resolution Max-Min is therefore 0.89 N. The graph already shows a clear interference signal 
in the time domain. To find out the cause, a spectral analysis is often very helpful. To do this, 
click on Add Graph Window and first of all the configuration dialog for this additional 

graphical 
display 
opens. 
Set 
Diagram 
Type to 
FFT, click 
Add Plot 
and then 
select the 
channel 
with Select 
Channel for 
actual plot. 
An FFT 
window 
can only 
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display one channel at a time, but you can open up to 6 Graph Windows at a time by running 
Add Graph Windows multiple times. 
The FFT spectral display opens: 

 

The displayable frequency range is always measured data rate / 2, in this case 3000Hz. 
Disturbance peaks can be clearly seen. To identify the frequency of the first one, you can 
disable Autoscale X (right-click on the graph) and edit the frequency range at the bottom 
right: 

Here you can see interference at 50 Hz and odd multiples of it. This is a typical behavior in 
the case of poor cable laying, lack of shielding or, as in this case, the use of an unsuitable 
power supply of the amplifier: the mains frequency of 50 Hz varies greatly (the multiples of 
this are probably generated by the unsuitable power supply, which induces a kind of square 
wave oscillation). 

For comparison, the original power supply of the BX8 is now used: 
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The peak resolution is now much better with 8000 parts; it would correspond to an absolute 
resolution of 0.32 N with the above-mentioned sensor. The 50Hz mains frequency still sprinkles 
in somewhat, but by about 20 dB less (corresponding to an attenuation of 10). It is probably due to 
the fact that a short sensor cable was used, but without shielding. 

Grounding the housing of the amplifier (if it is made of metal) often helps; the BX8 comes 
with a green grounding wire for this purpose. However, it does not always improve 
interference suppression. Grounding the sensor is also often helpful, especially if its metal 
body is isolated from the cable shield, as is usually the case with ME sensors. 
It is recommended to eliminate or at least dampen interference at the source; for example, 
amplifiers and sensors should be placed as far away as possible from strong sources of 
interference (such as frequency converters for motors). 
If this does not help, the measurement data rate can be reduced or - with the BX6 and BX8 - 
a digital filter can be configured as a band lock, see S. 92. 
With the above-mentioned procedure, the success of a measure against disturbances can 
be directly observed. 

Noise Cut 

The BSC2 and BX8 devices can be configured to set the readings to exactly =0 when they 
are within a configurable amplitude range around zero. The noise floor close to zero is thus 
cut off. If this function is not enabled and readings are consistently exactly =0 even though enough 
decimal places are displayed, this indicates a malfunction. However, when using the noise-cut mode, 
it can no longer be detected when measured value =0, which can be disadvantageous. 

Noise-Cut is configured under Menu Bar -> Device -> Advanced Settings... -> Value Mode -> 
Noise suppression: 
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In the case of BX8 , the number of the input channel to which the threshold value should 
apply must be entered under Input Channel; 0 sets the specified threshold value for all 
channels. With Noise-cut enabled, the function is activated for all channels. If it is desired that 
it should only apply to certain channels, the threshold value was set to 0 for channels where it should 
be disabled. Under Noise-cut threshold, the upper, positive threshold value for the amplitude 
range of the Noise-Cut function is entered. The range then goes from threshold to threshold, 
e.g. from -0.175 to 0.175 as shown. At the end, click on Store to device at the bottom . 
Due to the decimating averaging of numerical live display, it can happen that a displayed measured 
value is briefly within the noise-cut interval; however, this is only a display effect that does not affect 
the original measurement data, see p. 32. 

Manage device settings data 
In most amplifier models4 , you can also store data sets with configurations. After all, all 

amplifiers always restore the last valid settings when 
switched on. In addition, there are user records for 
alternative settings or backups. This is useful, for example, 
if you want to connect different sensors to the same 
channels of a device, or if you want to test different 
measurement data frequencies or filters, and much more. 
You don't always have to repeat the individual configuration 

procedures. 
To save these settings records, click Save Settings in the Configuration tab and then select 
the record you want to save to. By default, it is labeled User 1 to User 2 or User 6; how many 
data sets are available depends on the model. There are two for BSC1 and BSC4D, six for all 
others (except BX6). 

 
 

4With the exception of the BX6 (so far, but also planned with this for future versions) 
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Alternatively, you can use Save to File to save your device settings to a file. This is useful, for 
example, if you want to use a different amplifier copy of the same model with the same 
sensor(s), then you can save the settings in a file and then load it into the other device. 
To load the settings, click on Load Settings. 

With Load from File, you can restore the settings from a file 
and with User 1 to User 6 (2) you can restore the settings 
from the above-mentioned data sets in the device. 
In addition, there is the possibility to restore the data that 
was valid at the time of switching on with Last Session. This 
can be useful if you have accidentally selected unfavorable 
settings (e.g. Load User 1 to 6 or Default) or wanted to try 

something as a test that should not be stored permanently. Last Session Charging is only 
available on the BSC2 and BX8 (because these models do not save the current settings until 
shortly after switching off, so the power-on data is still available in the non-volatile memory). 

In addition, you can use Default to reload the manufacturer's settings. These are the factory 
settings that the amplifier has by default. In the case of normal series of devices, this 
corresponds to the configuration of the delivery condition (but this does not apply if the 
manufacturer has configured the device differently at the customer's request, e.g. to calibrate it for a 
specific sensor). 

Factory Settings Loading is available on all amplifier models. The operating instructions or 
protocol documentation often provide information about the specific factory settings, often also the 
type plate. The default measurement data rate is usually 10/s. 

Basically, Load Settings overwrites the current settings, i.e. they are lost (only with the BSC2 
and BX8, you can undo it with Last Session). 

Assign and name device setting data for the BSC2 
With the BSC2 you have the possibility to give your own names to the user records and to 
set this configuration as associated with a specific sensor or measurement campaign. This 
can be done by clicking on Device -> Advanced Device Settings in the menu bar. and select 
the Administration tab: 
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Prior to this, the current device settings 
should be configured as desired, e.g. 
input type, zero-point, user scaling, user 
offset, measurement data rate, etc. 

Then you first select the record number 
with Data record No, where 1 
corresponds to the default name "User 
1", up to No. 6 for "User 6". Then enter a 
suitable name in Displayed name 
(maximum 13 characters long). 
Then click on Assign to assign the 
current settings to this data record. 

 
 
 

 
This will change the output as shown on 
the left. 

Lastly, click on Store Record name to device: 
 

This assignment is automatically removed when device settings are subsequently changed. 
This can be prevented by setting write protection, see S. 28 
The new name of the record is now also displayed in the Load Settings and Save Settings 
dialog and also in the display on BSC2 models with keyboard menu when entering the 
corresponding menu item. 
As long as the assignment of the settings (to the sensor or measurement) remains the 
same, because no relevant settings have been changed, the name of the data record is 
displayed on the display after the manufacturer's name, e.g.: 3: Scale>g 
In Administration (see above), Reset to Default can be used to undo the naming and assignment. 

Restoring Device Settings Files from a Settings Archive 
If you click on Help -> Create Settings Archive, a ZIP file will be created that contains all 
relevant files with settings. The settings of all amplifiers that are open during this time are 
stored in files of this archive, as well as the last opened or saved Session File (see p. 14) is 
included with the original file name in the root directory of the archive. 
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The device settings files are in the root directory of the archive and have the file name 
pattern <Device Model><Serial Number>.ucf. 

 

In the example shown, a BX8 and a BSC2 were open. The device settings file of the BX8 is 
BX8_16256044.ucf and that of the BSC2 is BSC2_rev1_15454833.ucf. The default name of 
the session file is session.ucf. 

The archive also contains the *.dat and *.matrix files of all multi-axis sensors, both software-
calculated and those contained in the BX6 and BX8 devices, see p.39. BX8 also stores a file 
containing the contents of the error memory, here BX8_16256044Faults.txt. info.txt contains general 
information about the software version. 
With the BX8 you can also open the Settings Archive directly to load all six-axis sensor data back into 
the device. This may be useful after a firmware update. To do this, click the Recover All Six-Axis 
Sensors from Settings Archive button in the menu bar → Device → Advanced Settings → 
Administration and then select the *.zip file. 

Porting the device settings on the BSC8D 
In reality, the BSC8D and GSV-1A16 USB amplifiers cannot store their device settings in the device 
(unlike all other strain gage amplifiers). Instead, the device settings are emulated in files located on 
the PC in the directory C:\ProgramData\ BlueDAQ and in the Settings Archive in the subdirectory 
BlueDAQ. In it, you have the file name <Serial Number>.ucf. 
To run a BSCD8 with the same settings on another computer, you can copy these settings. To do 
this, first create the Settings Archive and unzip it on the target PC. On this you have to make the 
system directory C:\ProgramData visible with Windows Explorer, because it is usually hidden. Once 
you have done this, copy this file settings into the directory C:\ProgramData\BlueDAQ without 
changing the name. BlueDAQ should not be open. Then start BlueDAQ and open the BSC8D /16 with 
Add Channel and save the channel list in a session file if desired. 
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Porting the session file to another PC 
The session file contains a list of all integrated channels and other software settings such as 
additional Graph-Windows with their window scales and Trigger Paste and Copy-Paste Settings (see 
p.75). 
It is a configuration file in text format, divided into sections whose entries are of the form <key 
name> = <value>. Section names are enclosed in square brackets [name]. 
Each channel has its own section called [ch<Nr>]. On another PC, all settings can be valid as well, 
except for the COMport numbers of the connected devices and, if applicable, the window scaling of 
the Graph Windows. 
In order to port the session file, the COMport numbers that the amplifiers have on the target PC 
must be known. To do this, they would have to be connected once and you can then look them up in 
the Windows Device Manager or open them with Add Channel as a test. 
The session file can be opened with any text editor, e.g. notepad.exe. 
In all sections [ch<Nr>] that belong to an input channel of a device, the values of the entries ComNr 
must then be changed. Example: 
[ch1] 
device="BX8" 
ComNr=17 
Input=1 
BaudRate=115200 
OpenFlags=0 
Name="Chan. 17_1" 
SerNr = 16256044 
Color = 16777215 
IsHidden = FALSE 

[ch2] 
device="BX8" 
ComNr=17 
Input=2 
BaudRate=115200 
OpenFlags=0 
Name="Chan. 17_2" 
SerNr = 16256044 
Color = 16711680 
IsHidden = FALSE 

As you can see e.g. in the section [ch1] with ComNr = 17, this BX8 has the COMport number 17 on 
the old PC. To port the session file to the new PC, change all values of ComNr (e.g. ComNr = 5) in all 
sections that belong to this device instance. Identical device copies have the same serial numbers, 
i.e. the entries SerNr have the same value. 
In the BSC8D/16-USB, the ComNr corresponds to an entry DevNo = <no>, where the number is 
assigned by the driver. It will be listed in the drop-down list of the Add Channel dialog. 
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Protect device settings from modification 
With the BSC2, BSC1, BX6 and BX8 models, you can protect the device settings from 
unauthorized or accidental changes via hardware write protection. If write protection is set, 

the attempt to change settings in the device will be 
rejected, and an error message will appear for the 
BX6 and BX8. 
To set write protection, click on Device -> Advanced 
Device Settings in the menu bar... and then select 
the Administration tab: 
Under Inhibit parameter changing, you can set write 
protection with Device is write-protected and 
remove it again with Writes are allowed. 
This may open a sub-dialog for entering a 

password. The password to be entered depends on the model, with the BX6 and BX8 it is 
already selected in the password dialog, so that you only have to confirm with OK: 

• BSC2 and BSC1: Immutable password: berlin 

• BX6: Immutable Device Password: USC1 

• BX8: Changeable Device Password, Default: Beln5 
If write protection is not set, i.e. changing settings is allowed, the soft-LED Connected 
Interface has write-access lights up bright green. If it does not light up, i.e. is dark green, this 
may have another cause in addition to the set write protection: In devices with multiple 
interfaces (BX8 and BSC2 CANopen), the communication interface with which the device 
was opened may not have write permission because the other interface has write 
permission. The following applies: In the fieldbus systems CANopen and EtherCAT, the 
fieldbus system usually always has write permission when it is on and not in the STOP-
state. 
In the case of serial interfaces USB / UART / RS422 / RS232, the interface with which the 
device was first opened with an application program such as BlueDAQ has write permission. 

Observation and evaluation of live data during the measurement period 
The measurement data can be observed during the measurement in several ways: 

Numerical: As a large display in the index card Value Display, s. S.11. Here, the 
measured values are always updated, even if Start Recording (Recorder Yt) has not 
yet been clicked. Other numeric displays include the Value display in Recorder Yt and 
in the Recorder XY and the single value display in Configuration. Basically, numerical 
displays are updated every 0.2 s (i.e. 5x per second) or less frequently when new 
measurement data is available less frequently. The latter depends on the measurement data 

 

 
5The BX8 allows you to change the device password, but it is not currently supported by BlueDAQ, so it is 

unlikely that the device password will be different. However, if this is the case, it must not be forgotten, 
otherwise the BX8 would have to be sent to the manufacturer for repair. 
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rate (hardware setting), the software acquisition interval and, if applicable, the Value 
displaytype ab, see below. 

Graphically: In the index card Graph Display individual graphs are available for each 
measurement channel, but only for the first 16 channels, see p. 11. These graphs 
represent the readings over time. The scale of the Y-axis can be changed for each 
individual graph, as well as the Autoscale Condition (see below). The temporal 
latitude corresponds to that of the Recorder Yt under Time Visible. Also in the Graph 
Display the measured values are always updated, even if Start Recording (Recorder Yt) 
has not yet been clicked. 
In Recorder Yt all channels are represented in a graph over time, after the 
measurement with Start Recording begun, s. S. 9 
In Recorder XY one or more channels are displayed on top of another, i.e. not over 
time, see p. 56. 
With the button Add Graph Window Up to six additional windows can be opened that 
display live data, either as a Yt or XY chart or as an FFT spectrum, see below. 18. The 
Graph Window Windows are also displayed with name, position, type, etc. in the 
Sessionfile, s.S. 14. You can → them with the menu bar View → Sort Graph Windows 
evenly distributed on the screen. 

For each graphical display, the scaling of the axes can be done automatically 
if the autoscale function is activated. This can be changed with the right-
mouse button context menu by right-clicking in the graph. 
With Autoscale X , the entire course of the measurement from the start time 
is displayed in the graph in the Yt recorder. The start time then remains 
constant on the left edge of the (horizontal) timeline. However, the following 
should be noted: 

• The total time with which this is possible is limited. As soon as this has been 
exceeded, the time at the left full scale of time also continues to run and 
measurements that are older would be lost. This time is at least about 7 minutes. It 
can be enlarged with BlueDAQ PRO from version 2.01 onwards, see S. 32. 

• With a high measurement data rate (and/or high system load from other programs), 
BlueDAQ requires a relatively large amount of RAM and processing becomes slower 
as a result. As a result, the total time with Autoscale X is often longer6, but it can 
happen that the program reacts very sluggishly. 

Autoscale Y adjusts the full scale values of the Y-axis to match the visible readings. If there 
is no useful signal, but only noise, one can come to wrong conclusions about the noise 
amplitude because it is displayed optically enlarged. 

 
 
 

 
6The reason is that the Yt signal diagram can hold up to 5120 data packets (v. 2.01) and at high data rates the 

individual packets become larger. The slower the program becomes, the larger they become, i.e. the 
packets contain more and more readings. 
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It can be useful to use the Autoscale Y function in a test measurement and direct the 
sensors to an area where you want to measure and then enlarge that area slightly as full 
scale values: 

For each graphical display, the scale of the measured value axis (usually the Y-
axis) can be changed, unless it is set automatically by autoscale. This axis 
scaling only affects the visibility of the graph, it has no effect on the scaling of 
the measured values by the amplifier. 
Left-click on one of the two full scale values, enter the new value, and finish 

typing with the Enter key. It will be restored the next time the program starts. 

Numerical display in recorder Yt and XY 
In the Recorder Yt and Recorder XY, the measured values of all channels are displayed as 
numbers in addition to the graphical view. The display type can be configured with the 
Display drop-down menu and you can choose from the following options: 

• Actual Val: Current reading as it is 

• Maximum: Maximum value of the current measurement. 

• Minimum: Minimum value of the current measurement. 

• MAX(abs): Maximum value of the amount of the current measurement, thus taking 
negative minimums into account. 

• SNR [dB]: Standard deviation, based on the measuring range in dB, see p. 18 

• Resol. Parts pp: Peak value noise related to the measuring range in dB, see p. 18ff. 

• Max-Min: Range between maximum and minimum value, see p. 18ff. 

• Mean: Average, averaged over 100 values in the initial configuration and decimated. 
Alternatively, the time over which you want to average can be configured under Menu 
Bar->Options->Single Value Display -> Mean. This interval also determines the refresh 
rate of the mean (so it's not a moving average). 

• Integral: The measured value is integrated, according to the settings under Options 
(see below) 

• RMS/StDev: Standard deviation, see p. 18ff. 
All of these values are reset when the measurement starts (Start Measuring), when the type 
is zeroed, and when the type is changed. In the display, Wait... 

The results are determined by SNR [dB], Resol. Parts pp, Max-Min and RMS/StDev above 100 
values or over one second if the measurement data rate is greater than 100/s. This interval 
also determines the refresh rate of the value display. 
Exceptionally, the Integral display must be selected before starting the measurement. It can 
be configured, among other things, with regard to the integral boundaries under Menu Bar -> 
Options -> Single value Display. Choose Configure Value Type = Integral. 
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Starting Type can be used to specify which criterion should 
apply to the left integral boundary: 

• None: Consecutive Intervals means that after reaching 
the right integral boundary Interval End, a new integral is 
automatically formed. To form the indeterminate, ever-running 
integral, this setting is combined with Interval End = Infinite. 

• Above Threshold: If the starting threshold is exceeded, a 
new integral is formed (Y-condition of the left integral 
boundary). 

• Below Threshold: If the starting threshold falls below the threshold, a new integral is formed 
(Y condition of the left integral boundary). 

Interval End / Acquisition Type can be used to define the criterion for the right integral boundary: 

• Infinite: The integral calculation continues for the whole measurement (indeterminate 
integral) 

• Above Threshold: If the Interval End Threshold is exceeded, the integral is terminated (Y 
condition of the right integral bound). 

• Below Threshold: If the interval end threshold falls below the interval end threshold, the 
integral is terminated (Y condition of the right integral bound). 

• Number of values: The integral is calculated using the number of measured values specified in 
Number of Values (time condition of the right integral bound: time = number / measurement 
data rate). 

Processing can be used to specify whether only one integral should be formed (First Event only) and 
all subsequent start conditions ignored, or several (All Events), so that after reaching the right integral 
boundary, the first integral limit is again waited for the left integral boundary to be fulfilled. After 
completing an integral, the last result value for both settings is recorded in the Single Value Display, 
making it easy to read. In the case of the indefinite integral (see above), this setting has no effect. 
With Interpolate, an additional input value is created (interpolated) between two consecutive input 
values, which can lead to a more accurate result in some applications. 

The values displayed in the Single Value Display can be copied to the clipboard at the time of 
measurement or pasted directly into other programs at the touch of a button. To do this, 
configure the menu bar -> Options -> Copy & Paste -> Value Type to Copy/Paste to As Shown 
in Single value Display, s. S. 75. 
The memory behavior of the Single Value Display type can be configured under Menu 
Bar->Options ->Preferences. In the initial state, this is not saved and is set to Actual Val when 
the program starts. If the Save and restore Single Value Display checkbox is set, the set type 
will be restored the next time the program starts. 
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Configuring the Time Duration of the Acquisition Interval 
The time duration of the acquisition interval is the time that the software waits and collects 
readings until it displays them, so it is also the refresh interval. After an interval has elapsed, 
a data packet is passed on for processing and graphical display, so its length over time 
determines the packet size. This, in turn, depends on the storage depth of the graph in the 
Recorder Yt together. It is relevant if you Autoscale X (s.S. 28ff.) or if you want to use 
Configure Recording -> Save Memory Data to copy the values stored in the Yt graph into a 
measurement data file (see p.62). The storage depth is in the Recorder Yt set to 5120 
packets, in the counts of the index card Graph Display there are 768 parcels each. With 

BlueDAQ PRO from v. 2.01 it may be 
possible to change this interval under 
menu bar -> Options -> Preferences -> 
Measured data acquisition Interval. This 
setting only applies when using only 
one amplifier or several, all of which are 
synchronized with each other via 
master-slave. It also does not apply to 
the BSC8D/16.7 

In the delivery state and in the standard 
version, the acquisition interval is 
determined automatically, then Set 
Automatically is selected and the 
acquisition interval is between 0.1 s and 

0.2 s, i.e. it is updated between 5x and 10x per second. 
If Set Automatically is not set, you can set the acquisition interval under Data Acquisition 
Interval or have it calculated by entering the temporal storage depth of the recorder Yt in 
Recorder Yt time length (in hours). 
If you choose the acquisition interval large, the program can become slow and sluggish with 
a high measurement data rate and many channels. If the product 
Acquisition interval x measurement data rate² x number of channels is 
greater than 20 million, a warning is issued when the measurement starts. 
Regardless of the setting of this acquisition interval, the display interval for numeric displays 
is always 0.25 s, i.e. a new number is displayed 4 times per second. If the measurement 
data rate is higher, it is decimated to 4/s by averaging, if it is lower, the display interval 
corresponds to the measurement data period. 

Decimal Places of Numerical Readings 
Basically, the number of decimal places depends on the display normalization User Scaling 
and the maximum number of posts. The latter is configurable and is 6 decimal places out of 
the box. If the number of decimal places exceeds the numerical resolution of the 

 
7These two restrictions may be removed for versions > 2.01; the revision history will provide information on 

this. 
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measurement data from the amplifier, lower-order decimal places are set to 0. This can be 
the case with the BSC2 and BSC1, for example, if the ASCII reading output is activated and 
configured accordingly, see S. 101. In the case of 16-bit amplifiers such as BSC1, BSC4D 
and BX6 (version 1.x), this can also be true with binary measurement data formats. The 
natural maximum of significant decimal places is 5 digits for 16-bit devices and 8 digits for 
24-bit devices (BSC2, BX8 and BX6 v.2.x). 
The maximum number of decimal places displayed can be configured under Menu Bar -> 
Options -> Preferences -> Measured data numeric display; the value range is 4 to 8. 
The number of decimal places is usually calculated as follows: 
Number of decimal places = number of decimal places - rounding up (log10(User Scaling)) 

Examples: Number of decimal places=5, User Scaling = 3.5: 4 decimal places 
Number of decimal places = 5, user scaling = 10,000: one decimal place 
Number of decimal places = 4, User scaling = 150,000: no decimal place 
Number of decimal places = 4, user scaling = 2: 3 decimal places 
Number of decimal places=4, User scaling = 1: 4 decimal places 

Recording of measurement data and subsequent evaluation 
BlueDAQ provides a wide range of options for storing measurement data. The configuration 
of the data recording is from S. 58 described and the evaluation with the File Monitor from S. 
67. Among other things, measurement data can be converted into CSV or Excel files, the 
recording can be started and stopped automatically, and much more. 
It is even possible during a data acquisition (i.e. when Start Recording is active) at the same 
time a preliminary result of the *.tdms measurement data file with the File Monitor to look at. 
You will then see the temporal start of the file without the part that is currently being written 
to. However, it is not possible to take notes (Annotations) as described on p. 84 be set or 
modified, because the file will not be replaced by the File Monitor may be stored. Notes are 
set during the measurement period as set to S. 81 described. 

Configuration of data logger devices 
The Amplifier Models BX6BT and BSC2MSD-DI offer the possibility to record measurement 
data in the device on an SD memory card, i.e. measured values can be stored independently 
of the PC. These functions are described in the user manuals (a separate one for the 
BX6BT). The logged measurement data files are available in a readable text format, but can 
also be opened with the File Monitor, see S. 67, converting them to tdms file format. With 
both amplifier models, the measurement data files can be copied from the SD card without 
having to remove it from the device, see S. 37. In the case of the BX6BT, it is often useful to 
ensure that the Measurement application for recording after closing the communication 
link, which starts from S. 103 described. 
First of all, it is important that the built-in real-time clock is set correctly. After a change or 
drain of the battery or after a long time, the watch may be adjusted. To read the clock and 
set it, click on Device -> Advanced Settings in the menu bar and select the Administration tab: 
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By clicking on Sync, the clock will be set as close as possible to the 
time of the PC. Before that, you can specify with the BX6BT 
whether you want to set the clock to the local time zone (Set local 
time) or to UTC world time (Set UTC). In the view, the time is read from 
the device every 3 seconds. 

To configure the logger function, if you have several amplifications open, first select a 
channel that belongs to the device you want to configure. Then click on Device in the menu 
bar and select Advanced Settings. Select the Administration tab and click on Settings under 
Measuring values Logger. 

Here is the dialog on a BX6BT with an 
SD card inserted. The radio buttons 
under Data Recording have the 
following meaning: 

• Disabled: Recording is turned 
off 

• Log permanently (if device on): 
The measurement data is constantly 
recorded as long as the device is 
connected and an SD card is 
inserted. 

• Single Log by Command 
(BX6BT only): A line of measured 
values is recorded by a device 

command given by software. This can be done, for example, by clicking on the Log 
One Row button. 

• Single log by OK Key (BSC2 MSD-DI only): A line of measured values is written by 
pressing the OK key. 

• Single Log Periodically (BX6BT only): The slow recording mode is activated. The time 
interval between two lines of readings is configurable from 2s to several hours under 
Logging Period. Since the BX6 is put into standby mode in the meantime, this mode is 
energy-saving, especially for periods of one minute or more, so that the battery lasts 
a long time. 

• Log while Trigger Input = active (BX6BT only): It is recorded when the TRIGGER digital 
input has an active level and the BX6 is on (green LED is on). For this purpose, digital 
input must be configured accordingly, see S.109 

The settings under Logging Period affect the recording interval and apply only to the BX6BT. 
Their appearance and meaning depend on the data recording mode. 
With Data Recording = Log permanently and Log while Trigger Input = active, they mean the 
following: 

• Multiply TX freq by: This allows the recording rate to be higher than the measurement 
data rate, which is transmitted via Bluetooth. This is useful if you want a high 
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recording rate on the SD card and at the same time want to avoid connection 
problems with Bluetooth that can occur with high data transfer rates. Under Factor 
you can enter the factor between SD recording rate and transfer rate or you can enter 
the desired recording rate directly under Logging Frequency. The correlation is: Logging 
Frequency = Transmission Rate x Factor. 

• Divide frequency by: This allows the recording rate to be smaller than the 
measurement data rate, which is transmitted via Bluetooth. Under Decimator you can 
enter the divisor between the transmission rate and the SD recording rate or you can 
enter the desired recording rate directly under Logging Frequency. The correlation is: 
Logging Frequency = Transmission Rate / Decimator. 

With Data Recording = Single Log periodically , they mean the following: 

• 3..59 Seconds: The measurement data recording interval is in the range between 3 
and 59 seconds. It can be entered under Seconds. This setting is only slightly energy-
efficient because the amplifier remains on the entire time. 

• Minutes / Hours / Days: The measurement data recording interval ranges from one 
minute to several days. The number of days is entered under Days (may =0), the 
hours under Hours (0 to 23) and the minutes under Minutes (1 to 59). Since the BX6 
is put into standby mode in the meantime, this mode is particularly power-saving, so 
that the battery lasts a long time, the longer the recording interval, the longer. 

Under File Format, the formatting of the measurement data files can be influenced. 
Examples of file contents below. 

• Print File Header: A header is written at the beginning of each file. It contains 
information about the meaning of the columns, the number of channels, 
normalization, modes, unit if applicable, and recording rate. This checkbox is set by 
default. Omitting the header is not highly recommended, because importing the text 
file with the File Monitor may not have a good result. 

• Print Unit: If this checkbox is set, the BX6BT writes the units of all configured 
channels in a line in the header; the BSC2MSD-DI writes them after each measured 
value in a column (currently not deactivable for the BX6BT). 

• Log Max-, Min- and Mean (BSC2MSD-DI only): If this checkbox is set, the BSC2 
determines the maximum, minimum and mean value in addition to the current 
measured value, so that 4 measured value columns are written. Example BSC2 MSD-
DI, language = German: 
Normalization: +100,000 Data rate: 10,000 Hz  ← Print File Header activates 
Date Time Value Max Min Wed Unit  ← Max-, Min- and Mean activates 
23/11/23,19:43:38.25886  +5.913  +5.914  +5.913  +5.914  g  ← Print Unit activates 

Under Time Stamp, the timestamp columns can be formatted. They are written to the first 
column of the measurement data file. 

• None (BSC2MSD-DI only): No time or date. This setting is not recommended because 
the import of the text file with the File Monitor may not have a good result regarding 
the timestamps of the tdms file. This is especially the case if Print File Header is 
disabled at the same time. 
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• Time only: The timestamp contains only the time with fractions of a second, not a 
date. Example BSC2 MSD-DI, language = German: 
Normalization: +100,000 Data rate: 10,000 Hz ← Print File Header activates 
Time Value Unit  ← Print Unit activates 
19:20:13.61203 +6.328 g 

• Date only (BSC2MSD-DI only): The timestamp contains only the date, not the time. 
This setting may also not be recommended, see None. Example BSC2 MSD-DI, 
language = German: 
Normalization: +100,000 Data rate: 10,000 Hz ← Print File Header activates 
Date Value Unit  ← Print Unit activates 
23/11/23 +6.256 g 

• Both Date & Time: The timestamp contains both the date and the time. Example 
BSC2 MSD-DI, language = German: 
Normalization: +100,000 Data rate: 10,000 Hz← Print File Header activates 
Date Time Value Unit   ← Print Unit activates 
23/11/23,19:21:59.04858 +6.166 g 

Under File Size, you can specify how large the file should be. This is useful so that the files 
do not become too large, which is particularly relevant for permanent data recording. The 
input is made as a specification of the maximum number of rows under Max. Number of 
Rows or as a specification of the maximum time over which a file contains measurement 
data, where the input is made under Hour, Min (minutes) and Sec (seconds). The time and 
line information are converted into each other when entered, based on the currently set 
measurement data rate. Only the number of lines is stored in the device. If this is reached 
during the recording, a new file is created. 
Note: The minimum time length should never be less than one second, otherwise it will not 
be possible to create individually different file names, i.e. the minimum number of lines is 
equal to the measurement data rate. 
The reason for this is that the file names consist of date and time, including the second. 
With the BSC2MSD-DI, you can specify under New Directory whether a new directory should 
be created for the measurement data files every day (Every Day) or every month (Every 
Month), see the operating instructions. 
If the BX6BT Data Recording is set to Single Log by Command, Single Log File Creation can be used 
to specify whether the lines of measured values should always be appended to the last written file 
(Append to previous) or whether a new file should be created every day (New File Every Day) in which 
the measured value lines should be written. If Data Recording is set to Log while Trigger Input = active, 
you can choose between Append to previous and New File Every Trigger Event. With the latter, a new 
file is created every time a recording is started by activating the trigger level, and this has the 
advantage that the timestamps will also be correct when importing the file into a tdms file. For 
attached data, the timestamps in the converted tdms file are incorrect. 

 
 

At the bottom of the window are some soft LEDs and buttons, which are immediately 
executed in the device on the BX6BT and have the following meaning: 
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• Card Inserted: When this soft LED is lit, an SD card is inserted and mounted. 

• Logging File Open: When this soft LED is lit, a file is open for writing. Attention: The SD 
card must not be removed! 

• Currently Logging: Data is recorded. 

• Open File: Clicking this button will open a file for writing 

• Close File: A data recording is stopped, and the file is closed 

• Mount SD: An SD card that has just been inserted is mounted. Note: If an SD card is 
inserted when the BX6BT is turned on, it will automatically mount it. 

• Eject SD: The inserted SD card is deactivated so that it can be removed afterwards 

• Log One Row: If the Data Recording type is set to Single Log by Command, a line of 
readings will be written when this button is clicked 

• Start Logging: If the Data Recording type is set to Single Log Permanent, clicking this 
button will start data recording 

 
In the BSC2MSD-DI, the elements at the bottom have the following meanings: 

 

• Logging enabled: This soft LED lights up when data recording is enabled. 

• Charge by USB Power, if possible: If this checkbox is active, the device tries to draw 
power via the USB interface. When it is on, these 500mA are not enough to charge the 
built-in accumulator, but when it is switched off, it is possible. In this state, it acts as a mass 
storage device on USB. 

• MSD-DI Firmware Version: Version of the embedded software of the (second) controller for 
the management of USB, SD card, data recording, power management and logger menu. 

 
Accessing the recorded measurement data of the data loggers 
The BSC2MSD can be switched to USB mode via the user menu to be able to use it as a 
card reader. To do this, the device can also be turned off instead; in both cases, the use of 
BlueDAQ is not possible at the same time. In USB card reader mode, the SD card is 
accessed, e.g. with Windows Explorer, see user manual. 
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For the BX6BT, BlueDAQ 
provides a file browser for 
copying files; it can be 
opened via Menu Bar -> File -> 
Device File Browser or Menu 
Bar -> Device -> Advanced 
Settings -> Administration -> 
File Browser. 
In the upper left corner, next 
to Last file logged, the path to 
the last recorded file is listed. 
If in the top right corner under 
Which file? Recently logged, it 
can be downloaded directly by 
clicking on Download File. 
If Selected File is selected, 
select the directory in the file 

view under Directory / File Names; it will be formed from M<Year>_Monat>. Double-clicking 
on it will unfold it, as shown here for M2023_06. Now you can mark the file. Entries in bold in 
the file view are measurement data directories and files, where Yes is also listed under 
Logger Item. Then click on Download File, select the destination directory on your PC and 
the download will start, indicated by a progress bar. Copying (downloading) can take a long 
time for large files. The file size is displayed under Size [kB] and the download time can be 
estimated: time in seconds = file size [kB] x 0.12. 

When it's done, it will ask if you want to convert the downloaded 
text file to tdms format. If you let Yes do this, the file can be opened 
with the File Monitor. It is not necessary, because the text file can 
also be opened directly with the File Monitor. 
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Additional features 
Note: Most of the configuration options shown below are applied to the device to which the 
channel set with Actual Channel (Configuration tab) belongs. 

Integration of multi-axis sensors 
When using 6A or 6ADF six-axis sensors or 3AR series three-axis sensors, a calibration 
matrix must be loaded once.8 It can be found in the files that came with the sensor. In the 
case of the BX6 and BX8 amplifiers, the calibration matrix for six-axis sensors is usually 
stored in the instrument because they can perform the calculation themselves (exceptions 
and limitations: see table below). Otherwise, the files with the calibration data of the multi-axis 
sensors must remain stored on the PC, because BlueDAQ needs them at the measurement 
runtime to calculate the forces and torques. In this case, at least 6 channels per sensor 
must always be open. 
These files with the calibration data have the following naming convention (please do not rename): 
<Sensor Serial Number>.dat<Sensor Serial Number>.matrix 
Both files must be in the same directory. 

 
First of all, all required input channels must be open and all of them must have the same 
input type, i.e. the same input sensitivity. If this is the case, click on Special Sensor, then the 
following intermediate dialog will open, which you leave as it is and confirm with OK: 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8The K3A and K3D series do not require a calibration matrix. F6D sensors with an e at the end of the model 
designation have a built-in BX6 amplifier and the calibration matrix is usually already installed. 
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Then the dialog for multi-axis sensors appears: 

 
Click on Add Sensor in the top left corner , then a sub window will open: 

Click on Open File/Dir to load the calibration data for the first time. 
In the file selection window that opens, select the *.dat file 
belonging to the sensor. 

 
 

The multi-axis sensor dialog then looks like this on a standard six- 
axis sensor: 

To be on the safe side, please first compare the serial number on the sensor's nameplate 
with the one shown under Sensor Serial No; they must match. 
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First, select the first channel of Input Component 1, with Component 1. If your BX6 or -8 
amplifier will perform the calculation itself (the Calculated by device checkbox is then 
enabled), components 2 to 6 will be selected automatically. Otherwise, i.e. for software-
calculated sensors, you must select all input components manually. The dialog now looks 
like this: 

 

 
 

If desired, the output channels of the calculation can be automatically renamed with 
Rename Channels, so that the channel name denotes the physical size and direction. To then 
enable six-axis sensor measurement and, if necessary, save the sensor data to the BX6 or 
BX8, click OK Enable this sensor. 
If the six-axis data is stored in the device and data already exists there, you will be asked if 
you want to overwrite an existing record or create a new one. In case of overwriting, you 
may be able to specify the memory index: 

BX6 and -8 can store up to 11 such sensor data sets. You will 
then be asked for the device password when saving and 
calculating in the device. As a rule, this is not adjusted; So, you 
can confirm the pre-selected password with OK. For BX8 it is 
"Beln" 

 
If the sensor 
calculation has been 
activated, you will 
receive a confirmation 

message and the dialog will close. 
The status messages in the Configuration and Recorder 
tabs show the multi-axis sensor being activated: 
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After loading the six-axis data, a zero adjustment should be performed with the sensor 
unloaded, by clicking on Set All Zero in Recorder Yt (see p. 84). 
To deactivate the multi-axis calculation, open the Multi-axis Sensor dialog again. The green 
soft-LED Enabled is now lit. You can now disable the sensor with Disable this sensor. 

Learn more about the Multi-Axis Sensor Dialog 
Under Sensor Mode, you can see the sensor type or mode. In the case of six-axis sensors, it 
depends on the type of sensor and the selected calibration data. In the case of three-axis 
sensors, it is possible to switch between three different calculation modes. There are the 
following types, or modes: 

Sensor Mode Sensor 
Models 

Computable 
by BX8 

Computable 
by BX6 

Matrix Remarks 

Six-axis 6A, 6ADF Yes Yes 6 x 6 Determined by sensor data 
Six-axis,2nd 

order 
6A, 6ADF Yes No 2 matrices 

of 6 x 6 each 
Determined by sensor data 

Three-axis 
Fz,Mx,My 

3AR No9 Yes 9 3 x 4 Three-axis mode selectable, here 
force, 2x torque 

Three-axis 
Fx,Fy,Fz 

3AR Yes 9 Yes 9 3 x 4 Three-axis mode selectable, here 
3 forces 

Three-axis 
Fz,sx,sy 

3AR Yes 9 Yes 9 3 x 4 Three-axis mode selectable, here 
force, 2x travel 

Six-axis,6x12 
Matrix 

6A-225 No No 6 x 12 Determined by sensor data, 12 
input channels required 

Notes on sensor modes: 
• The "Six-axis, 2nd order" mode corresponds to the Matrix Plus solution. Here, the 

second, square matrix is also displayed in an additional index card. When calculated 
by the BX8, the maximum data frequency is limited to 2000/s. 

• For the modes calculated by software, all input components must be selected 
individually under Channel assignment in the General tab. As a rule, these are input 
channels 1-6 for multi-channel devices. 

• By the 6x12 Matrix Mode must be additional Components 7 to 12 can be selected by 
selecting the checkbox Compo 7 to 12 in Channel assignment is activated. Most of 
the time, these are the first 6 input channels of a second amplifier. In this case, a 
"master-slave" synchronization of the measurement data transmission of both 
devices is recommended, for which, however, hardware requirements exist, see p. 14. 

 
 

 
9The calibration files can be changed by the manufacturer ME in such a way that the calculation by BX6 or BX8 

is still possible. However, channels 5 and 6 will then become unusable. 
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• For the three-axis modes Three-axis Fx,Fy,Fz and Three-axis Fz,sx,sy, a lever arm 
length must be entered on the right under Distance offsets; the input elements are then 
marked in red. 

• In the case of the three-axis sensor, the input channel 4 has no significance as the 
output channel. In the 6x12 matrix mode, this applies to input channels 7 to 12. 
Although these are required as input values for the calculation, they do not have a 
physical output value assigned to them. According to Rename Channels, she has the 
designation "dummy." You can hide these channels in the main window so that they 
are no longer visible by selecting this channel with Actual Channel in the Configuration 
tab of the main window and then clicking on Channel -> Hide from the menu bar. 

• For the sensors/modes calculated by software, it is useful to save the entire 
configuration in a session file. Then the above-mentioned selection process of the 
sixth-axis data does not have to be carried out again, but after the next program 
starts you can simply restore them with Open Session. 

• In the case of the sensors/modes calculated by software, when recording 
measurement data (see p. 9 and 58) has created an additional TDMS file containing 
the raw data, i.e. the mV/V values that the sensor outputs directly. The file names of 
the raw data are in the form <date-time>RAW.tdms, i.e. RAW is appended to the file 
name of the file with the normal physical measurements. The raw data may help to 
determine the cause of problems, or you can use a different matrix afterwards. 

 

Channel assignment for sensor with 6x12 matrix 

 
Changing the sensor configuration and using multiple multi-axis sensors 

• If you want to load different calibration data for the same sensor, or if you want to 
store other calibration data in the same BX6/-8, it is recommended to disable the 
sixth-axis calculation with Disable this sensor beforehand if it is active. If the data was 
stored in the device, it will be retained (unless it is overwritten by reloading by 
specifying it in the store in the device memory dialog). 
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• If you want to use other calibration data stored in the device , proceed as shown 
above (after the current sensor has been disabled), 
but set the checkbox Use sensor data stored in 
device in the Select Sensor intermediate dialog and 
then select the desired sensor based on the serial 
number and the storage space with Select Sensor 
from. The input components are then automatically 
assigned because they belong to the amplifier and 
cannot be changed. 

 
• In the BX6 or BX8, only one of the stored calibration data arrays is active, always the 

one that was last activated with OK Enable this sensor. The number of the active 
sensor is also part of the user settings User 2 to User 6 of the BX8, so that you can 
also switch between sensor data with Load Settings if the configuration  has 
previously been saved with Save Settings. 

• If several multi-axis sensors are to be used for a measurement, repeat the above-
mentioned charging process without removing sensors first. Accordingly, there must 
be enough input channels in the measuring system for this purpose. In the Multi-axis 
Sensor dialog you can select the one you want to display with Sensor displayed in the 
upper right corner. The number of active sensors is displayed at the top in Number of 
Sensors. With the BlueDAQ PRO variant, up to 8 multi-axis sensors can be used, with 
the standard variant up to 4. 

 
Other display and control elements in the Multi-Axis Sensor window 
General: Distance Offset: Here you can enter distances of a force application point, which are 
taken into account when calculating the torques. The calibration matrix is usually 
determined by the manufacturer in such a way that the torques at the sensor origin apply. 
Often, however, there are still attachments to the measuring platform and you want to 
measure the moments at this point. The directions of the distance offsets up to and 
including program version 2.00 are opposite to those of the sensor coordinate system; from 
2.01 onwards they correspond to the coordinate directions of the sensor in the case of a 
software-calculated system. 
General: Maximum Value: The maximum values of the sensor. Within these limits 
±maximum, the accuracy specifications of the sensor apply. If the maximum values are 
exceeded, this is indicated by the red Sensor Overload button at the top of the main window. 
This can then be clicked to get more detailed information about the maximum value 
exceedance. 
Zero Signal: Basic detuning values at no-load of the sensor at the time of calibration of the 
sensor by the manufacturer. With their help, previous zeroing of the sensor (with Set All 
Zero) can be cancelled by clicking on the yellow Untare button. You can then see the current 
upset. 
Matrix: The elements/coefficients of the calibration matrix. 
Storing location: Storage location of the calibration matrix. If the device (Device...), the 
memory index is also displayed under Index in memory. 
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Enable Distance measuring for 6-axis sensor: With the BX8, instead of the forces Fx and Fy, 
the distances Sx and Sy can be calculated in meters, which indicate the distance of a force 
application to the sensor origin; i.e. a force <>0 must be applied. 

Measuring with strain gages 
Strain gages (strain gages) are small sheets of metal mesh that are glued to a body to 
measure its surface strain or compression. The elongation is a ratio and is given in μm/m, 
this (pseudo-) unit is equivalent to microstrain (μInch/Inch) and others, generally: 
"Elongation x 10-6" 
In order to adjust the strain gauge so that it measures correctly in μm/m, it is necessary to 
know the K-factor, which indicates how much the resistance or output voltage changes. In 
addition, you need to know the type of bridge; Single strain gages are always quarter bridges 
and require a bridge addition, which is placed either externally or in the amplifier, see its 
operating instructions. In the case of bridges with transverse contraction, it is also 

necessary to know the transverse contraction 
number of the material to which the strain 
gauge is glued. It indicates the ratio of 
longitudinal to transverse elongation. 
To adjust, click on Sensor->Strain gage... or on 
User Scaling and then select the small tab 
Strain gage. 
Use Bridge type to select the type of bridge: 
Full (4): Full bridge with all 4 strain gages in 
the longitudinal direction. No bridge addition 
necessary. 

Half (2): Half bridge with 2 strain gages in the longitudinal direction. Half-bridge 
extension necessary. 
Quarter (1): Single DMS. Quarter bridge extension necessary. 
Half (1+μ): Half bridge with one strain gauge in the longitudinal and one in the 
transverse direction. Half-bridge extension necessary. Transverse contraction 
number Poisson's ratio must be specified. 
Full (2+2μ): Full bridge with 2 strain gages in longitudinal and two transverse 
directions. No bridge addition necessary. Transverse contraction number Poisson's 
ratio must be specified. 

Under Gage factor, the K-factor is entered, and under Poisson's ratio, if applicable, the cross-
contraction number. The Input Range is displayed correctly on most amplifiers, with the 
exception of the BSC1. 
Then click Calculate, and then click Store to Device. The new user scaling is set and the unit 
is then μm/m. 
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Stress measurement with rosette strain gages 
When using triple-rosette strain gages (SGS), BlueDAQ can be configured to convert the 
signals from the strain gages into mechanical stresses and angles of the main stress. 

Mechanical stress is a measure of the stress on a body (to 
which the rosette strain gauge is glued) due to its external 
load. 
Rosette strain gages are used, which have an angle of 45° to 
each other. These three individual strain gages have to be 
completed on the hardware side with quarter bridge additions 
to the full bridge and at least three channels are required. The 

BX6BT and BX8 amplifiers meet this requirement, as does the BSC4D after internal 
modification. The corresponding user manual explains how to connect quarter-bridge strain 
gages correctly. 
To configure this type of voltage measurement, click on Special Sensor in the Configuration 
tab, then the following intermediate dialog opens, in which Calculate principal Stress is 
selected: 

 

Alternatively, you can select Sensor>Rosette Stress in the menu bar. 

Then the Rosette Sensors dialog opens. In it, click Add Rosette to add a stress measurement. 
 

With Channel assignment, you then have to select the channels to which the respective input 
components (Component Ea, Eb, Ec), i.e. the individual strain gages a, b and c, are 
connected. Under Elastic Modulus, the modulus of elasticity (modulus of elasticity) of the 
material to which the strain gages are glued is entered, under Poisson's ratio, its transverse 
contraction number. The picture above shows typical values for pure aluminum as 
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examples. Under Rosette Strain gauge next to Gage factors a, b and c, the K-factors of the 
strain gages used are entered; with All same, you only have to do this once, as long as all 
three are the same. The Input Sensitivity of the amplifier is automatically displayed correctly 
on most strain gage amplifier models. Finally, click OK. The channels are then renamed 
Sigma 1 for the main voltage, Sigma 2 for the shunt voltage and Phi for the angle of the main 
voltage direction to the strain gauge a, also the units are changed to N/mm² and ° 
respectively: 

 

When using multiple rosette strain gages for multiple measuring points of mechanical 
stress, this configuration is repeated for each rosette. The channel names are then 
appended with _1, _2, and so on. The channel names can then also be changed manually 
(see p.6), but the units do not. It's a good idea to do this whole configuration with Save 
Session so that they can be used the next time the program is started (see p.56) easily with 
Open Session can be restored. 

Switching between stress and strain measurement 

When voltage measurement is activated, the status message Rosette Sensor: 
Stress enabled appears. In the meantime, without losing the configuration data 
of the stress measurement, you can switch to strain measurement. To do this, 
click on Special Sensor again and then select Display measured strain 
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Alternatively, you can also click on Sensor>Rosette Strain in the menu bar. The 

 

units, channel names and status messages change: 
To return to the voltage measurement, select Calculate principal stress or Menu 
bar>sensor>rosette Stress in the Select Special Sensor intermediate dialog and 
confirm the rosette dialog with OK. 
Note on saving the rosette configuration: The channel names are stored in the 
session file, but the voltage measurement data is only stored if the voltage 
measurement is active at the time of saving. The strain configuration results 
from the user scale, which is stored in the amplifier as well as the units. 
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Sensors with TEDS 
Some sensors have a memory module in whose memory individual configuration data for 
this sensor is stored. These are standardized in the TEDS standard according to IEEE 1451.4 
(Transducer Electronic Data Sheet). 
Currently, only the BX8 and BX6 amplifiers support sensors with TEDS (BX6 only on channel 
1). 
When connecting a sensor with TEDS or powering it on with the sensor connected, the BX8 
reads the memory and sets scaling (User Scaling), unit and input sensitivity automatically so 
that correct physical readings are displayed, i.e. User Scaling cannot and does not have to be 
set as on S.8 described. 
When this is done, the label of the User Scaling button changes to Scaling by TEDS: 

 

In general, the user does not have to do anything else. To explicitly read the memory content 
or change the TEDS loading options, you can access the TEDS dialog by clicking this button 
or by clicking on the menu bar -> sensor -> TEDS... 

 

The display TEDS usage -> Sensor Info 
With BX8, each line shows whether a sensor is connected and whether the TEDS data has 
been loaded. With BX6, only channel 1 is valid. The entries mean: 

• Input Type. TEDS templates with IDs 33 and 35 (see below) can only be used with 
bridge inputs, ID 25 only with voltage input. 
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• Sensor Plugged? The BX8 can usually determine whether a bridge sensor is 
connected, in which case the entry is Yes; otherwise No or Unknown is unknown. The 
latter is regularly the case with input type = voltage or temperature as well as with the 
BX6. 

• TEDS used: This soft LED "glows" bright green when TEDS data has been successfully 
loaded. In this case, EEPROM is also connected. 

• EEPROM connected: This soft LED "glows" bright green when a TEDS memory device 
has been connected and detected. This applies even if the content of the data could 
not be interpreted as known and compliant; in this case , TEDS used does not light up. 
This is regularly the case with empty memory modules. 

• TEDS auto-load: This soft LED "glows" bright green if the BX8 has been configured to 
use TEDS data on this channel, see TEDS usage. 

Configuring TEDS Device Behavior 
The strain gage amplifier is configured by the manufacturer's settings in such a way that it 
tries to load TEDS data when it is switched on (BX8 even when changing sensors); In 
addition, there are four checkboxes for detailed settings, which only apply if TEDS data is to 
be loaded for this channel. 

• TEDS Usage Input Ch. <no> Basic TEDS charging property for the channel selected in 
the upper left corner under Input Channel 

• Set unit from TEDS data: If set, the unit is also set based on the TEDS data (valid for 
all channels with TEDS enabled). 

• Set input range from TEDS dat: If set, the input measurement range / input sensitivity 
is also set based on the TEDS data (valid for all channels with TEDS enabled). 

• Set offset from TEDS: If set, the zero point is also set based on the TEDS data (valid 
for all channels with TEDS enabled). If this is set, zeroing with Set Zero (main 
window >configuration) is still possible, but after the next power on, the zero point is 
loaded from the TEDS again. 

• Set analog output from TEDS: If set, the scaling factors of the analog outputs are set 
based on the TEDS data so that the maximum physical value corresponds to the 
analog nominal output value (valid for all channels with TEDS enabled). 

If you want to change the basic TEDS charging property, you can use Apply this to all input 
channels to specify whether the selected setting should apply to all input channels. Then 
click Store to strain gage amplifier device. 
With the light blue button Refresh you can update the displays after changing settings or 
reconnecting a TEDS module. 
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Reading and viewing TEDS content 
After clicking on Read from TEDS device, the contents are displayed in the Basic TEDS data 
and TEDS 33 data (or TEDS 33 data) tabs. TEDS 35 data or TEDS 25 data). The different 
templates correspond to different data formats for different categories of sensors. The 
basic TEDS data is organized in the same way for all templates, they contain an ID for the 
sensor manufacturer, the template ID and the serial number as well as the entries ModelNo, 

 

Version Letter and Version Number, which the manufacturer can set as desired. 

In the case of sensors from ME-Meßsysteme, the sensor serial number is in Manufacturer 
Serial number. 

The BX6 and BX8 support Template ID 33 for Wheatstone bridge sensors and ID 35 for 
strain gages, while the BX8 also supports ID 25 for accelerometers. 
The template ID-specific data content is displayed in the right-hand tab; In the following, only 
ID 33 for bridge sensors is described. 
If you have opened the TEDS window via the menu bar -> Sensor -> TEDS, some entries with 
the BX8 are displayed with a green background; these are those that experienced users can 
modify for certain reasons - e.g. during a recalibration - in order to then write the data back 
to memory, but this is only possible with the BX8 (see below). The white ones are immutable 
properties of the sensor, which are usually not changed. 
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The entries in detail: 

• Physical Measurand: The physical measurand of the sensor to which this calibration 
also applies. This also determines the unity. Based on this value, the unit of the strain 
gage amplifier is set, if configured accordingly. 

• Minimum physical value: X-coordinate "Pmin" of the lower point of the two-point 
shape of the sensor characteristic, see drawing below 

• Maximum physical value: X-coordinate "Pmax" of the upper point of the two-point 
shape of the sensor characteristic, see drawing below 

• Select Precision: Numerical representation of the coordinate points (Pmin/max, Emin/max). 
32 bits are recommended. 

• Minimum electrical value: Y-coordinate "Emin" of the lower point of the two-point 
shape of the sensor characteristic curve in mV/V, see drawing below 

• Maximum electrical value: Y-coordinate "Emax" of the upper point of the two-point 
shape of the sensor characteristic curve in mV/V, see drawing below 

• Bridge Type: Sensor Bridge Type (Full, Half, Quarter) 

• Sensor impedance. Sensor internal resistance in ohms 

• Response time: Settling time of the sensor in case of rapid changes (jumps) of the 
measured variable, in seconds 

• Excitation amplitude nominal: Recommended sensor power in volts 

• Excitation amplitude minimum: Minimum sensor power in volts 

• Excitation amplitude maximum: Maximum sensor power in volts 
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• Calibration Date: Date of last sensor calibration 

• Calibration Initials: Initials of the person who calibrated 

• Calibration period: Recommended time to recalibration, in days 

• Measurand location ID: User-specific identification number of the measuring point 

Editing and writing TEDS data 
The BX8 can also be used to write memory devices (so-called 1-wire EEPROMs). The following 
types are supported: 24B33, MAX31826, 28E07,10 243110 

In order to be able to write, the TEDS dialog must be activated via menu bar -> sensor -> 
TEDS... , then (except for an empty module) you must first read with Read from TEDS device. 
The green entries in the index cards with the TEDS data can be changed directly and then 
written by clicking on Write to TEDS device . The device password of the BX8 (default: Beln) 

Example of a sensor characteristic. The red 
coordinates correspond to the TEDS data shown; The negative yellows are alternatively 
possible. 

must be entered or confirmed. 
To describe a previously empty block or to modify and write the white entries and those in the Basic 
TEDS data, experienced users proceed as follows: 

1. Click on Edit All , then enter the unlock password MEsysTEDS42 . Flashcards of all three 
supported templates 33, 35 and 25 open. 

 
 
 

 
10Only from hardware version 4.2 
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2. Edit data, making sure that only the data in the template = index card used is changed. The 
template itself, i.e. the sensor category, is selected in Basic TEDS data -> TemplateID . If the 
memory module was previously empty, all entries must be checked and, if necessary, set. 

3. Click Write data to TEDS device, then enter device password. 

It is also possible to write TEDS data to a file using Write TEDS data to file and read such a 
file again using Read TEDS data from file. 

Adjusting Sensors with a Known Load 
General sensors that do not fall under the previously mentioned categories of multi-axis 
sensors with calibration matrix, sensors with TEDS or rosettes strain gages for voltage 
measurement are usually adjusted according to the data mentioned on the test or 
calibration report, as shown on S. 8 shown. 
If you no longer have this data at hand, or if the sensor may have changed its transmission 
characteristics due to aging or harsh environmental conditions, you can adjust it using an 
interactive process. This may also be possible when using strain gages, namely when a 
mechanical quantity such as force, pressure or torque leads to a significant and 
reproducible elongation at the strain gages. 
For the adjustment process, it is necessary that a precisely known load can be applied to the 
sensor. It is recommended to choose this load in such a way that it either corresponds 
approximately to the maximum value of the range in which you actually want to measure or 
so that it is in the range of approx. 30% to 100% of the nominal measuring range of the 
sensor. 
It is also necessary that the load (more precisely: the load to be measured) can be removed 
from the sensor. First, do this and observe the reading. If it deviates significantly from zero, 
it is recommended to set it to zero with Set Zero before starting the procedure. 

Then you can start the procedure, either 
by menu bar -> sensor -> Calibrate... or 
by clicking on User Scaling and 
selecting the small Calibration tab : 
In the example shown on the left, a 
force sensor with a nominal range of 2 
kN is to be adjusted with a weight of 20 
kg. However, it is meant to be measured 
in newtons. To do this, multiply the 
mass in kg by the gravitational 
acceleration factor g, the mean value of 

which is 9.81 m/s². The result of the calibration load in the unit to be measured is entered in 
Calibration Load . 
The input sensitivity Input Range on the right is displayed correctly on most amplifiers. 
Then click on Execute Calibration . You will first be asked to confirm that the sensor is load-
free: 

http://www.interfaceforce.com/


7418 East Helm Drive • Scottsdale, Arizona 85260 • 480.948.5555 • www.interfaceforce.com 
55 

 

 

 

 
Confirm this with Yes. Subsequently, some readings are taken; Meanwhile, a bar display 
appears: 

 
Then you will be asked to apply the load: 

Do that. If this causes the sensor to oscillate slightly, wait a 
moment until it is still and then click OK. 

 
Then some measurements are taken again until this message appears: 

 

The recalculated User Scaling value is displayed under Scaling: 
 

Now click OK to save the new scaling value in the device. 
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Startup 
BlueDAQ can also be started by double-clicking on a session file that was previously saved 
with Save Session.11 Then this session will be loaded. It is also possible to open a *.tdms 
measurement data file by double-clicking, then BlueDAQ is started and this file is opened 
with the File Monitor . However, if BlueDAQ is already open, this method cannot be used. 
You can also start BlueDAQ with a program shortcut and call parameters, so that actions 
are executed automatically. This can be created in Windows in the startup menu, so that the 
program opens automatically when the PC starts. This is useful, for example, if measured 
values are to be recorded continuously, so that after a power failure or an automatic restart, 
this recording is started again. 
Up to 3 call parameters are possible. 
First parameter: There are three options for this: 

1. "-l" When the program starts, the last downloaded or saved session is 
automatically opened, see below. 

2. First Call Parameter = Complete Path to Session File (*.ucf): This device 
session file is loaded 

3. First call parameter = Complete path to measurement data file (*.tdms): This 
measurement data file is opened with the File Monitor 

Re 1.: If the first call parameter is "-l", up to two additional parameters can optionally be 
specified. 
Second parameter: 
"-rYt": After the session has been loaded, a recording with the Yt recorder is automatically 
started, see S. 9. The recording configuration defined with Configure Recording applies, see 
S. 58. 
"-rXY": After the session has been loaded, a recording with the XY recorder is automatically 
started, see S. 56. Either the recording configuration defined with Configure Recording (see 
S. 58.) or threshold-based triggering, if it was previously enabled. Furthermore, the last 
selected channel applies to the X-axis 
Third parameter: recording time in seconds. At the end of this time, the program will be 
closed. This is useful, for example, to prevent the measurement data file from becoming 
very large, possibly even filling up the drive. 

XY Recorder 
In the Recorder XY tab, one or more readings can be displayed over a different channel. 
Therefore, at least two channels must be open. In contrast to the recorder Yt, the measured 
values are not displayed according to y= f(t) over time, but over another channel y= f(x). The 
channel projected to the X-axis is selected when entering this tab. 

 
 

11After the initial installation, Windows may ask once if you want to open the file with BlueDAQ. If this is 
confirmed, Windows saves this file <-> program association. 
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Essentially, the XY recorder provides similar functions to the Yt 
recorder. 

 
In addition, it offers a threshold-dependent display or recording. If this is active, only 
individual values (i.e. points that are connected to each other) are displayed, and only if the 
value of the channel projected on the X-axis exceeds the previously defined thresholds. 
The thresholds must therefore be set in advance; to do this, please click on Trigger 
Thresholds. Then a window will open in which you can set the threshold values, which you 
can do manually by entering them directly (activate manually) or you can have the threshold 
values generated automatically (automatically) by entering the start, end value and 
increment (From, To and Increment). 

 

Up to 11 threshold values are displayed here, if there are more, you can change the first one on the left with the 
index element on the far left (marked here in black). There are no greyed-out entries. 

Then start the measurement (if you haven't already) and click on the Activate checkbox, 
which will then change to Activated. 

 

 
Note: The Configure Recording defined settings (see p. 58) apply with trigger thresholds 
enabled. not.?????????? What is this „not“? 
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Example: XY Recorder for Force-Displacement Measurement 

Software Options for XY Recorder 
The question of choosing the channel of the X-axis can be suppressed, so that the same X-
channel is used every time you switch to the recorder XY index card. You can do this by 
removing the checkbox for Ask for selection of X-channel under Menu bar -> Options -> 
Preferences -> When changing to XY-diagram. 

The other checkbox in this field describes the behavior when 
comparing the trigger threshold of the XY recorder under XY Trigger 
threshold compare. At measurement data frequencies >5 Hz, when 
Fastly, without Average is not enabled, an average of approximately 200 

ms is formed in the output configuration and the average is compared to the current 
threshold. If this checkbox is set, this is done without averaging each individual measured 
value. 

Configuring the recording of measurement data 
Clicking on the Configure Recording button in the Recorder Yt or Recorder XY tab opens a 
window in which the recording can be prepared and configured. This is only possible as long 
as the recording is not (yet) running, i.e. its configuration cannot be changed while the 
recording is running. The measurement data is stored in an efficient binary file format, the 
tdms format. In addition to the measurement data, it also contains metadata, so-called 
metadata. Properties. These files can be viewed and exported with the File Monitor. 
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Automatically start and stop recording 
Various conditions for starting or stopping can be defined in the Trigger Recording tab in the 
Configure Recording dialog. The contents of this tab may change depending on the settings 
you choose, so it is recommended to follow the order of operation from top to bottom. First 
of all, the top radio button under Start Recording and/or Finish Recording must be set to 
Automatically. 
Launch 
The Start Trigger Type start condition can be the exceeding of the measured value of a 
given channel with a definable threshold value or (only for the BSC4D, BX6 and BX8 amplifier 
models) a digital level of a line connected to the digital input of the strain gage amplifier. In 
this case, the type of digital input is usually set to GP input (under the menu bar → Device → 
Advanced Settings→Digital I/O); however, this is not necessary, i.e. other I/O types may also 
be selected in the device settings. 

• Value exeeds threshold: The recording is started when the measured value is > 
threshold value and the previous measured value was <= threshold value, i.e. when 
the threshold value is exceeded 

• Value drops below threshold: The recording is started when the measured value is < 
threshold value and the previous measured value was >= threshold value, i.e. when 
the threshold value is not exceeded 

• Value change delta threshold: The recording is started when the difference in amount 
of a measured value with its predecessor is greater than or equal to the threshold 
value, i.e. if |Reading(k) - Reading(k-1)| >= threshold value. 

• Digital I/O: Recording starts when there is a digital level change. The level edge is 
defined with the Level Change Edge switch and the number of the digital connection 
(line) is selected with the Digital I/O selection element . 

 
For the threshold-dependent start condition, the threshold value must be entered under 
Threshold Value, and the Trigger Channel selector must be used to enter the channel whose 
measured value is to be compared with the threshold value. 
If you enter a number > 0 under Number of Pre-Trigger values , measured values with the 
defined number will be recorded even before the start condition occurs. You can also set 
the checkbox Auto-Create Annotation at Trigger, so that when the trigger condition is 
reached, a note (annotation) is automatically created at this point, depending on the type, 
one of the texts "Start Rec: Threshold exceeded", "Start Rec: Fallen below Threshold", "Start 
Rec: D-threshold exceeded", "Start Rec: Digital-In Rising" and "Start Rec: Digital-In Falling".12 
Under Event Number you can specify whether the start condition for admission is tested 
once or several times. If Record single event (file) is selected, it will no longer be checked 
after the automatically started recording due to the defined trigger condition. In the case of 
Record several events (files), the trigger operation is checked again after the automatically 

 
12The Pre-Trigger Values function is only available with BlueDAQ PRO 
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started recording has ended, so that several automatically started measurement data files 
can be generated. 
Termination Condition 
To automatically stop recording, you can choose from two basic categories under End 
Condition Type: 

• Time / Number of values: After an adjustable time or after reaching a number of 
measured values, the recording is stopped 

• Signal Trigger: A threshold condition or digital I/O level stops recording 

 
Time / Number of values can be used to select one of the following termination conditions 
under End condition time/number: 

• Number of values: Once the number has been reached, the recording will be stopped. 
To the right of it, enter the number: 

• Relative Time: After reaching this time, counted from the start of the recording, it is 
finished. To the right of it, enter the time under HH (hours), MM (minutes), and SS 
(seconds): 

 
• Absolute Time (Daily file): At the specified time, the recording is stopped and then 

recorded to a new file every day. The When finished: Generate new file checkbox is 
automatically checked. To the right of it, enter the time under HH (hours), MM 
(minutes), and SS (seconds). 

• Absolute Date, Time: At the specified date and time, the recording stops. A new file 
cannot be created automatically, so the checkbox When finished: Generate new file is 
disabled. To set the date and time, click on the calendar icon on the right and select 
the date in the following dialog at the bottom and enter the time in the format 
<hour>:<minute>:<second> at the top, confirm with OK. 

 

 
Signal Trigger allows you to select one of the following termination conditions under End 
Trigger Type: 
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• Value exeeds threshold: The recording is terminated when the measured value is > 
threshold value and the previous measured value was <= threshold value, i.e. when 
the threshold value is exceeded 

• Value drops below threshold: The recording is stopped when the measured value is < 
threshold value and the previous measured value was >= threshold value, i.e. when 
the threshold value is below 

• Value change delta threshold: The recording stops when the difference in amount of a 
measured value with its predecessor is greater than or equal to the threshold value, 
i.e. if |Reading(k) - Reading(k-1)| >= threshold value. 

• Digital I/O: Recording stops when a digital level change occurs. The level edge is 
defined with the Level Change Edge switch and the number of the digital connection 
(line) is selected with the Digital I/O selection element. 

 
For a threshold-dependent termination condition, the threshold value must be entered under 
Threshold Value, and the channel whose measured value is to be compared to the threshold 
value must be entered with the Trigger Channel selection element. 

 

If you enter a number > 0 under Number of Post-Trigger values, measured values with the 
defined number will be recorded even after the termination condition has occurred. You 
can also set the checkbox Auto-Create Annotation at Trigger, so that when the trigger 
condition is reached, a note (annotation) is automatically created at this point, depending on 
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the type, one of the texts "Stop Rec: Threshold exceeded", "Stop Rec: Fallen below 
Threshold", " Stop Rec: D-threshold exceeded", " Stop Rec: Digital-In Rising" and " Stop Rec: 
Digital-In Falling".13 
For the termination conditions Number of values and Relative Time, the checkbox When 
finished: Generate new file can be activated at the bottom. This means that when the 
recording is finished, it is automatically recorded back to a new file and the selected 
termination condition is tested again. 

Using Automatic Recording 
After the recording configuration is closed with OK, it is saved for the next program start. To 
activate the automatic start of recording, the measurement must be started in the recorder 
Yt (or XY) by clicking on Start measuring. A message will appear: 

The Start Recording button flashes while waiting for the Start Trigger condition. Once this 
is reached, the recording will start and the Start Recording button will switch to: 

 

If multiple files are to be recorded, the status message "Number of recorded files ready: 1 
Waiting for Trigger..." 
These *.tdms measurement data files are stored in the last selected directory. To set or 
change this, it is recommended to start a recording manually once (i.e. with Start Recording 
= Manually), because only then a file selection window appears. 

Additional Configuration Options for Data Recording 
Save Memory Data tab: 
If a measurement has been taken in the Recorder Yt with Start Measuring without it being 
recorded, some data can be saved afterwards. This index card has nothing to do with the actual 
recording configuration. It can only be accessed by clicking on Configure Recording in Recorder Yt. 

Data Reduction tab: 
Especially with a high measurement data rate or many channels, the measurement data 
files can become quite large. With data reduction, this size can be reduced and, if 
necessary, short peaks can be recorded at the same time. 

 
 
 

13The Post-Trigger Values function is only available with BlueDAQ PRO 
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Recording Interval: Set to One value per time interval to enable data reduction, set to 
Record every value to disable. 
Time interval: This is where the length of the data period is defined. It must be greater 
than the reciprocal of the measurement data rate of the integrated amplifiers (data 
frequency). 
Decimating Average: If this radio button is set to Mean values inside interval , the 
arithmetic average is calculated on all measured values within the specified data 
interval. At the beginning of a new data interval, it is restarted (decimating averaging). 
Create Additional Channels with Maximum/Minimum Values: If Create Maximum / 
Minimum values is activated here, BlueDAQ creates additional channels in the 
measurement data file (one for each original channel for maximum and minimum), 
which specify the maximum value and the minimum value in the data interval. These 
are determined anew at the beginning of a new data interval. Together with 
Decimating Average, average and peak values can be recorded at a relatively high 
measurement data rate. In the File Monitor, the channels of the maximum and 
minimum values are displayed in dashed lines, and the channel names are appended 
with "_Max" and "_Min" respectively. 

 

 
Auto Export tab: 
The measurement data files have a specific binary format, the *.tdms format, which can 
only be read by a few programs (e.g. NI Diadem) except BlueDAQ. With Auto Export, a tdms 
file can be automatically converted to another format, e.g. generally readable text formats, 
at the measurement runtime when the recording is finished. Enable Auto-Export must be 
enabled. Alternatively, tdms files that have already been recorded can also be converted in 
the File Monitor. 

Select Destination file type: Specifies the file format of the exported file. 
Text file (tab separator): A table file is created in text format. The readings of 
the channels and the time/date stamp are separated by the tab character. A 
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header is generated. The file extension is *.txt. If this type is selected, you can 
alternatively select the format of the measurement data files that the BX6BT 
can write to an SD card by activating BX6 Logger Format. 
CSV file (select separator): This format is very similar to the text file , but you 
can use Cell Separator to specify the separator for the cells and the file 
extension is *.csv. This format can be opened with many popular spreadsheet 
programs, such as LibreOffice Calc. 
Excel Spreadsheet: An Excel spreadsheet is generated. The export can take a 
long time with large files / high measurement data rate and then also affect 
the system performance (in which case the csv format is more 
recommended). 
Influx DataBase: A measurement data file in Influx format is generated. If this 
type is selected, the Measurement Name should be specified. You can filter 
out missing or (e.g. due to disturbances) extremely implausible measured 
values with Eliminate missing and excess values. An influx file can be uploaded 
to a measurement data database; At ME-Systems, a small additional 
background program is available on request, which does this. 

Timestamp in UTC: For some file types, the timestamps converted to Universal Time 
can be entered into the exported file. 
Append to selected destination file: If this checkbox is enabled, the exported 
measurement data will be attached to an existing file. This should already exist and 
be of the same file type. If you set this checkbox, please use the yellow file browser 
button to the right of Destination Path of exported file(s) to select the file to which you 
want to attach. 

Advanced tab: 
Various special setting options are summarized here. 

Record Hidden Channels: If channels have been hidden with the menu bar -> 
Channels -> Hide or if hidden channels are defined in the open session, you can 
activate the checkbox to specify that they should be included. 
Additional File: At the end of the recording, a second measurement data file is 
generated, which contains readings of all channels filtered by a maximum or 
minimum value condition. Filter condition and number of values can be defined. This 
function is activated with the checkbox Create second file with filtered values. 

Filter Criterion: Specifies whether to filter by a maximum or minimum value. 
The entire original file is searched based on the criterion. 
Number of Values around trigger / Number of values in filtered file: Number of 
readings per channel in the filtered file. 
Channel to apply criterion: Channel to which the Max./Min filter condition is 
applied. 

Timestamp Calculation: With the generated *.tdms file format, timestamps are not 
stored with every line of measured values. Instead, the start time and a time 
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increment dt are stored, and the timestamps are formed from it for display or export 
to another file format. For this reason, only time-continuous (equidistant) 
measurements can be recorded. This section can specify how BlueDAQ should 
calculate the time increment dt at the end of the recording. Note: If data reduction is enabled, 
i.e. One value per time interval is enabled in Data Reduction, these entries are grayed out because the time 
increment is defined by the data reduction setting. 

Auto-Select dt mode: If this checkbox is activated (default), BlueDAQ decides 
for itself which calculation mode is to be used for dt based on predefined 
criteria. If there are amplifiers whose measurement data rate is considered to 
be insufficiently accurate, the Calculate dt from Final time mode is used. If all 
amplifiers are very precise in time and the data frequencies of all strain gage 
amplifiers are set in the same way (when using multiple devices), the 
measurement data rate of the amplifier(s) is used for the calculation, i.e. the 
use device data rate mode. 
Select dt mode: If Auto-Select dt mode is not enabled, this can be used to 
specify the calculation method for dt. 

Calculate dt from Final time: Calculates dt based on the start time, the 
end time, and the number of readings, i.e.: dt= (end time - start time) / 
(count of metrics-1). 
Use device data rate: This calculates dt based on the data frequency set 
in the amplifier, i.e. dt= 1/data frequency 
User defined dt: This can be used by the user to set dt (this may result in 
an incorrect or fictitious end time). If this method is selected, an input 
field Enter Data Period appears, in which the time increment dt must be 
entered in seconds. 

Resulting dt: When using the Use device data rate or User defined dt methods, 
the resulting time increment is specified here. 

Replace Missing values: In case of connection stability issues, this option replaces 
missing readings from a device (determined by timeout counting) with a very high 
marker value of 1E+300. If Eliminate missing and excess values is enabled under Auto 
Export, these values will be omitted when exporting to the Influx DB format. Do not 
use this option under normal conditions, especially when triggered recording is 
activated by threshold or with software-calculated special sensors! 

 
Formatting the file name 
In the Format Measuring File Name input mask at the bottom of the window, the name of 
the measurement data files can be formatted. It then applies to the tdms files and possibly 
also to exported other formats and consists of the date and time of the start time of the file 
in the initial configuration (default). This is indicated by the format string 
<%d_%m_%y-%H_%M_%S>. You can enter almost any text before or after the time/date 
format string, i.e. before < or after >. The special characters % [ ] \ / : * ? " < > | are to be 
avoided. In the case of files that are automatically started by Trigger Recording, [No] can also 
be appended, which automatically appends high-counting numbers to the file names. With 
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the Default button on the right, the entire format string can be reset to the initial 
configuration. Within the formatting codes, including < and >, almost any text and character 
may be used, except [ ] \ / : * ? " < > | and the % character, which initiates a formatting code. 
These are: 

 

Code Meaning 

%a Abbreviated day of the week (e.g. Mon) 

%A Full weekday name (e.g. Monday) 

%b Abbreviated month name (e.g. Jan) 

%B Complete month name (e.g. January) 

%c locale-specific default date/time formatting 

%d Day of the month (01-31) 

view item Hour (24-hour format) (00-23) 

%I Hour (12-hour format) (00-12) 

%j Day number of the year (001-366) 

%m Month number (01-12) 

%M Minute (00-59) 

%p AM or PM Entry 

%S Second (00-59) 

%U Week number of the year (00-53), where the first Sunday is the first day of the first week 

%w Day of the week as a decimal number (0-6), where 0 represents Sunday 

%W Week number of the year (00-53), where the first Monday is the first day of the first week 

%x locale-specific date 

%.1x long date format 

%.2x abbreviated long date format 

%X locale-specific time 

%y Year within the century (00-99) 

%Y Year, including century (e.g. 2023) 

%z Difference between local time and UTC (HH:MM:SS) 

%z Time zone name or abbreviation (depending on the operating system's local settings) 

Example 1: Format Measuring File Name: 

My measurement<Am%d-%m-%y at%H-%M-%S> o'clock[No] 
yields the file name: 
"My measurement on 15-05-23 at 11-41-15 Uhr_01.tdms" 
Under Resulting file name example, an example of the file name is displayed. 
Note: The generated names of the measurement data files must not appear more than once 
in the same directory. In the case of default formatting, this is ensured by the fact that the 
file name contains the time with seconds (since several files cannot be recorded within one 
second anyway). A time format is recommended or, if recording starts automatically, the 
function tag [No], which generates sequential numbers. 
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Using the File Monitor 
By clicking on File Monitor in the Configuration tab opens a window that opens a *.tdms file. 
Alternatively, a measurement data file in text format can be opened, which was generated by 
one of the data logger devices BSC2MSD-DI or BX6Bt. In this case, the *.txt file is converted 
to a *.tdms file before opening and the user is asked for the location of the generated tdms 
file. The TDMS tools offer further possibilities, see S. 129 

The measurement data can then be viewed, checked and exported. When opening and 
changing the tab, the following warning message may appear for large files: 

 

It means that only 200000 consecutive readings of the file have been opened. You can 
change this by setting the number of values to be opened under Settings or by selecting 
Load All Values: 

 

The opening data set options can be set separately for the Values (table) = table of values 
and Analogue values (graph) = graphical view. 
If you choose Load all values, it may take a long time to open. 
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At the bottom of the status bar, the number of loaded values is indicated by Loaded values. 
Under File content, the tree view on the left, select the channels to be displayed. If Measuring 
values is selected, all channels are displayed. To display multiple channels, select them by 
holding down the Ctrl key at the same time. 
Channel names and colors are the same as those used in the measurement. 
Properties displays the file's metadata, see Appendix. Some settings of the measurement 
with which the file was created have been stored here. 
Values (table) is a numerical table of values. 
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Analogue values (graph) is the graphical view. There are more options here. 
At the top right are three small buttons for tools with the following basic meanings: 
Left button: Move cursor (see below) 
Middle Button: Zoom Options 
Right button: Move image section by dragging with the mouse button 

After selecting the zoom option, the zoom section 
can be selected by dragging with the mouse button 
(holding down the left button). Alternatively, the 
vertical mouse wheel can be used to zoom. The 
zoom option at the bottom left means: Everything 
is visible. Alternatively, this can be achieved by 

right-clicking in the graph and selecting Autoscale X / Y or turning it off and on again (if 
already selected) or turning the mouse wheel down. 
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Using the cursor 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

reading of that channel. 
 

with high data frequency. 

 
 

To display one or more cursors, the cursor menu must 
first be displayed. To do this, right-click in the graph and 
select Visible Items->Cursor legen. 

 
 
 
 
 
 

 
At the bottom right, the cursor legend 
appears. 
Right-click on it and select Create 
Cursor->Single-Plot. With the single-plot cursor 
you have the most possibilities. The cursor is 
associated with one of the displayed 
channels. The coordinates are displayed, with 
the X coordinate in Yt diagrams 
corresponding to the time and Y to the 

 
To change the channel assignment, right-click on the cursor 
number, here cursor 0 in the cursor legend and select Snap to. A 
channel list appears, but only the top entries can be used, i.e. 
those whose names belong to visible channels. 

 
 
 
 
 
 
 
 
 

The coordinates are also displayed in the status bar at the 
bottom, the time here with higher resolution for measurements 

 The cursor appears as a yellow line cross in the graph. In order to be able to 
move it, the corresponding tool must be selected from the three small buttons 

above (see above). In addition, the vertical yellow line of the cursor must be visible in the 
zoom section. If this is not the case, you can display everything as shown above and zoom 
back in if necessary. 
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You can create a second cursor with Create Cursor as shown above, and then you have 
more options. Firstly, the coordinate differences are displayed in the status bar, and 
secondly, the function keys can be used to copy a temporal range of measured values as 
text to the clipboard, instead of just one value per channel. 

 

In the image above, you can see how you could determine the period of a signal, for 
example. Two cursors are generated, both of which are assigned to the same channel 
(=plot) (here "Dev3_2"). You can also move the active cursor, which is highlighted in yellow in 

the legend, with the arrow keys, e.g. so that dY in the status bar becomes as 
small as possible. then you can read the period with dt:, here 32.3 seconds. 
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Copying and Exporting Metrics 
Exporting to other file formats 
The entire file, i.e. all temporal readings, can  be converted to another format by clicking on 
the Export button. 

 

 
The file types and options are the same as those at Configure Recording -> Auto Export tab: 
Called. In addition, you can use the radio buttons under Export whether all channels should 
be exported (All Channels) or only the ones marked on the left in the construction view 
(Selected Channels). After clicking OK, a file selection dialog opens. If you enter a suitable, 
already existing file, the measurement data will be attached; otherwise, a new file will be 
created with headers and/or column headers. The first column always contains a 
timestamp with the date and time. 
As with automatic export, notes (annotations) are inserted in the last column for the target 
file types Text file and CSV file, and at the corresponding point in time for plot-bound 
annotations. 
Further export options are offered by the right-mouse button context menu of the graphical 
view (mouse pointer in the graphic, right mouse button >export): 

 

This means that only the data visible in the graph will be exported. 

• Export Data To Clipboard copies the data as text to the clipboard in the following 
format (here only one channel and two lines): 

-Khan. 17_3 Time - Chan. 17_3 
14:31:37,106 25.05.2023 -0,789969 
14:31:37,106 25.05.2023 -0,791009 
A separate timestamp column is created for each channel. Timestamps and readings are separated by tab; Date and time 
with spaces. 
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• Export Data To Excel opens Excel (if available on your PC) and inserts the data, 
creating a timestamp column for each channel. The file can then be edited and saved 
with Excel if necessary. 

• Export Simplified Image provides the option to export the graph as an image. You can 
select the format and enter whether the image should be copied to the clipboard or 
saved as a file. The background of the image is white, the plot color remains 

unchanged, see image below. 
 
 
 
 
 
 
 
 
 

Copy to clipboard 
In principle, data stored on the clipboard can only be pasted into suitable other programs, i.e. 
data in text format into text or spreadsheet programs and images into image processing 
programs. 
The above-mentioned possibilities are those of the right-mouse button context menu of the 
graphs: Right mouse button>export>export Data To Clipboard to copy the visible area as 
table text and ->Export>Export Simplified Image->Export to Clipboard to copy the image to 
the clipboard, which then looks like this, for example: 
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Similarly, an image can also be copied to the clipboard by right-clicking>Copy Data. In this 
case, the image corresponds more to the view of the graph in the File Monitor window, i.e. 
the background is black, e.g.: 

 

 
You can also Individual measured values or copy selected areas to the clipboard as text. To 
do this, you need one or two Cursor, as described in Using the cursor must first be 
generated. Then you can do the following by pressing the function keys F11 or F12: 

• F12: Copying the readings of all channels marked on the left in the tree view at the 
cursor position 

• F11: Append the measured values of all selected channels at the cursor position to 
the Clipboard table text data 

• Hold Ctrl and F11: Copy all temporal readings of all selected channels as table text 
between two cursors. To do this, two cursors must have been created.14 

• Hold the Ctrl key and F12: Append all temporal readings of all selected channels as 
table text between two cursors to table text data,14 
which is already on the clipboard. 

These copy functions with F11/F12 only copy the measured values without a timestamp. 
The readings are separated by tab characters. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
14Copying the area between two cursors is only available with BlueDAQ PRO 
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Copy and paste at measurement time 
Even while a measurement is running, measured values can be copied to the clipboard in 
order to be able to paste them into other programs (e.g. word or table processing). 
With BlueDAQ PRO it is also possible to insert a configurable string (text) with measured 
values directly into other programs, either by pressing a function key or automatically by 
exceeding threshold values. 

Copying Metrics to the Clipboard 
If at least one measurement channel is open and BlueDAQ has the input focus, pressing the 
F12 function key will copy text from measured values to the clipboard. If the clipboard 
already contains text, pressing F11 to the clipboard appends text from measured values. 
This works regardless of whether a measurement has been started in the recorder Yt/XY or 
not. The formatting of the measured value text cannot be changed in the standard variant 
(default format) and is as follows for multiple measurement channels: 
<Measured Value Channel 1><TAB><Measured Value Channel 2><TAB><Measured Value 
Channel N> 

Example with 6 channels: 
-0,004810 0,230499 0,083257 -0,098635 0,094652 -0,870234 

If F11 is used to append measured values, a line break is inserted before the measured 
value text, e.g. 
Text to clipboard 
-0,004293 0,210927 0,108514 -0,122475 0,083306 -0,860497 

This allows you to create several lines of measured values by placing the first one on the 
clipboard with F12 and then adding more with F11, e.g.: 

 

-0,004248 0,198070 0,101477 -0,120024 0,089766 -0,856605 
1,996082 0,214995 0,107485 -0,129403 0,104570 -0,860058 

Inserting a measured value text into other programs using the F key15 
If another program has the input focus, a text string with measured values can be inserted 
into it by pressing a function key. This feature can be configured under Menu 
Bar>Options>Copy & Paste: 

 
 
 
 
 
 
 
 
 
 
 

15This feature is only available with BlueDAQ PRO 
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For example, with the configuration shown here, when pressing F2 in another program, the 
following text is inserted: 
My values: 1,996199 

0,184941 0,098549 -0,111647 0,104588 -0.882169 First: 0.033925 

Pasting into another program must first be enabled by using the menu bar>Action->Enable 
Value Paste by F<no> or pressing F10. It is not relevant whether a measurement started 
with Start Measuring. If Paste to external enabled is enabled, "Paste to external enabled" will 
appear in the status bars of the main window. 
Specifically, the controls in Options>Copy & Paste mean: 

• If this checkbox is checked, the Paste function will be activated immediately and 
when the program is restarted. "Paste to external enabled" will then appear in the 
status bars of the main window. 

• Include All Channels When enabled, all existing channels are inserted into the 
formatting string Output Format. Otherwise, the channels inserted there can be 
selected individually with Channels to Paste. 

• Include Units If this checkbox is set, each metric is appended to its configured unit, 
with a space between the value and the unit. 

• Include Timestamp If this checkbox is set, a timestamp with a date is inserted at the 
beginning of the measured value text (default). Its format depends on the Windows 
language setting (locale) and is as follows:TT for German 
. MM.YYYY HH.MM.SS,bbbbb e.g. 8/8/2023 6:43:46.09986 PM 

• Decimal Separator = Period If this checkbox is set, a period will be used as a decimal 
separator in any case, even in German Windows; otherwise - depending on the 
Windows language setting - a comma may be used. 
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• Copy by F11/F12: Settings 

◦ Auto-format F11/F12 string If this checkbox is not set, the measured value text, 
which is copied to the clipboard with F11/F12 when focusing on BlueDAQ, will be 
formatted in the same way as defined here. Otherwise, i.e. if the checkbox is set, 
the Copying Metrics to the Clipboard default formatting. 

◦ Regular Newline with F11 If this checkbox is set, if Auto-Format F11/F12 string is 
not set, a line break will always be inserted first when pressing F11. 

• Function key for pasting This should be the function key that is used to insert the 
measured value text into the other program. Note: It is highly recommended to select 
a function key here that does not trigger any or no relevant function in the other 
program in which you want to insert 
.The user manual of that program can be useful for this purpose, or you can try it out 
first. Otherwise, both functionalities are likely to be triggered, which can lead to 
problems (possibly malfunction or even crash of this other program). 

• Value Type to Copy/Paste Here you can choose whether to insert the measured 
values of the main display or those of the single value display of the recorder Yt. 

◦ Actual Values The main display of "normal" current metrics is inserted as they 
appear in the Value Display and Configuration tab 

◦ As Shown in Single Value Display The numerical display of the Single Value Display 
in Recorder Yt can be switched between different display types, see Recorder Yt. If 
this radio button is selected, the converted values displayed here will be used for 
insertion. 

• Channels to Paste If Include All Channels is disabled, measurement channels can be 
added to the measurement text to be inserted by checking the corresponding 
checkbox. In the middle is the channel name and on the right is the channel number. 
Hidden channels cannot be selected. When selecting a channel checkbox, the 
placeholder for the measurement value of this channel {channel name} appears in 
the formatting string Output Format and from the first value the default separator \T 
is inserted between measured values. Output Format can be edited manually at the 
end and ultimately applies to the generation of the text to be inserted. 

The Formatting String Output Format 
In the formatting string, any text can be written between the placeholders for variable 
entries, i.e. measured values {channel name} and timestamp {date time}, which then appear 
in the output text. In these texts, the special characters 
\T for a tab indentation (TAB) and 
\N for a line break can also be used anywhere. 
It is also possible to change the channel order. However, the channel names must be spelled 
exactly correctly. 
For example, this configuration: 
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with the formatting string: 
My values: {DateTime}\TNo.1: {Chan. 17_1}\T{Chan. 17_4}\T{Chan. 17_6}\NThat's all 

Insert the following text (measured values & timestamps are variable, of course): 
My values: 08.08.2023 18:49:31,09163 No.1: 1.995757 mV/V -0.117022 mV/V -0.857558 mV/V 

Thats all 

If you change the channel order to, for example: 
My values: {DateTime}\TNo.4: {Chan. 17_4}\T{Chan. 17_6}\T{Chan. 17_1} 

The following text is generated: 
My values: 08.08.2023 18:57:55,31113 No.4: -0.094565 mV/V -0.869309 mV/V 1.995695 mV/V 

 
Insertion of a measured value text into other programs via trigger16 

Measured value texts of this type can also be automatically inserted into 
another program by exceeding or falling below configurable threshold values 
(instead of pressing a function key). This can be used, for example, to output 
measurement value strings at pre-configurable reference points or waymarks 
or similar. It can be configured in Menu Bar>Options Trigger & Paste: 

 
 
 
 
 
 
 
 
 
 
 

 
16This feature is only available with BlueDAQ PRO 
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If the following four conditions are met, a metric text is inserted into a different 
program: 

• The measurement was started in the recorder Yt 
• The Trigger Paste function was activated with the function key F8 or 

menu bar>Action->Enable Trigger Paste 

• The other program to insert into has the input focus 
• The threshold condition is met, i.e. the measured value of the trigger 

channel has exceeded or fallen below the current threshold 

Those controls in Options-> Trigger & Paste that have the same name as in Options-> Copy 
& Paste also have the same function with respect to the measurement value 
strings exported via trigger condition. Furthermore, there are the following: 
Edit Thresholds: 
When clicked, a window opens with which the threshold values can be defined. 
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In it mean: 

• The small number at the top left (here in the picture =0) is the index of the first 
threshold value displayed. It is important to use them (e.g. with the small arrow keys 
to the left of them) if the number of threshold values is >11; otherwise, it should be =0 
to see all thresholds. 

• The numbers to the right (top) are the thresholds. These can always be changed 
manually. A greyed-out entry means "not present"; you can also delete a threshold 
value by right-clicking on it and selecting Delete Element. The threshold values 
should be selected in a regular order, which should match Threshold Mode (in the 
Options window), see below. 

• With Create trigger thresholds = Automatically, the threshold values can also be 
generated automatically with even distances. To do this, the first threshold value is 
entered under From, the distance under Increment and the last threshold value under 
To. You can have them created either only ascending (Choosing directions = 
Ascending only) or ascending and descending. If you have configured this, the 
threshold values are created by clicking on Auto-Create (Calculate). 

• To set the final button, click OK, Close 

 
Other controls in Options > Trigger & Paste: 

• Trigger Channel: Selects the channel whose readings are to be compared 
with the thresholds. 

• Threshold Mode: Specifies whether the thresholds are in ascending 
and/or descending order and whether the trigger event should be 
triggered when a threshold value is exceeded or undercut: 
◦ Ascending only: The threshold values are in ascending order and are 

triggered when a threshold value is exceeded (i.e. when the measured 
value becomes > threshold value) 
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◦ Ascending, then descending: The first thresholds are in ascending 
order and are triggered when a threshold value is exceeded, the last 
thresholds are in descending order and are triggered when a threshold 
value falls below 

◦ Descending only: The threshold values are in descending order and are 
triggered when a threshold value falls below a threshold value (i.e. 
when the measured value becomes < threshold value) 

• Execution This can be used to specify whether the threshold-related 
output of measured value strings should continue to occur after a 
threshold set has already been completely traversed (multiple times) or 
not (only once). 

• Create Annotation for Recording: If this checkbox is set, annotations are 
set for the trigger events, i.e. notes that give short texts to the recorded 
tdms files at these points, which are displayed in the File Monitor, namely 
"Threshold No <nummer> exceeded" or "Value below threshold No. 
<Num>" (threshold value below). 

Annotations in Measurement Files 
It is possible to add text to recorded *.tdms measurement value files, e.g. to store 
information about the type or conditions of the measurement with the measured value 
curves. These texts are displayed in the File Monitor and can also be exported to text 
formats. They can be set during the measurement or afterwards in the File Monitor. 

Setting Notes While Recording a Measurement 

After a measurement value recording has been started, e.g. with Start 
Recording, notes can be set by right-clicking in the graph of the recorder Yt (or 

recorder XY) and then selecting Annotation in the context menu. 
dials. 
Then the annotation window opens. 
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The test cursor is automatically placed in the top text input line, so that you can enter the 
new text right away. The note can be assigned to a specific channel or unassigned (Free) 
using Assigned Channel. You can also edit previously set texts here. 
It is also possible to enter texts before the recording has started, they will then be added to 
an upcoming recording. The assigned time is then the start of the recording. 

 

The checkbox Delete Annotations for next Recording after this recording has finished is then 
valid for the next but one recording, as none is currently running. So, in any case, the note 
will be added to the upcoming recording; if this checkbox is set, it will then be deleted so 
that the next recording no longer contains it; if it is not set, the annotations are added to 
each recording. This behavior can also be set under Menu Bar -> Options -> Preferences -> 
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At Start Measuring using the Delete Annotations checkbox , which has the same function. If 
it is set, all notes that were added to the last recording will be deleted when a new recording 
is made. 
In the File Monitor, the notes are only displayed with Yt data17: 

 

A text assigned to a channel is marked with an arrow on this plot, while a free text is not. 
The arrow also points to the time at which Annotation... has been clicked. 

The cursor pointer can be used to move the position of the 
text or the time/arrow: 
Once you have done this, when you close the File Monitor, 
you will be asked if you want to save the file, because this 
information (text and time position) is also saved. 

 
If the tdms file is exported to a text format (Text File or CSV 

File), the notes in it will be inserted in the last column, at the time they were set. When 
exporting to Excel, InfluxDB, or BX6 format, the notes are not exported. 

 
 
 
 
 
 
 
 

17If they were set in the XY Recorder, they are present but cannot be displayed. If you go to Settings... Show XY 
Data as Yt Diagram enabled, they will be displayed. They are also exported when exported to a text format. 
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Setting Notes in the File Monitor 
You can also add new notes to the File Monitor by right-clicking on the 
graph and selecting Create Annotation from the context menu . 

 
 
 
 
 
 

The text is then entered in the following window under Annotation Name : 
The note can be assigned to a specific channel (Snap to 
One Plot) or defined as unassigned (Free) using Lock Style. 
The assigned channel is selected with Locked Plot. 
When you close the File Monitor, you will be asked if you 
want to save so that the new notes are saved as well. 

 
 
 
 
 

Offset and Zero Point 
The Set Zero button in the Configuration tab causes the amplifier to set the raw input value 
to zero. In doing so, he determines a summand "raw offset", which he adds to the raw measured 
values. 

In the case of multi-axis sensors and voltage measurement with rosette strain gages, all 
associated input channels must be set to zero so that the calculation of the physical 
quantities remains correct. As a result, this button is grayed out for channels that belong to 
multi-axis sensors. Instead, use Set All Zero in the Recorder Yt or Recorder XY tab. 

In the case of the BSC2, BX6 and BX8 amplifiers, a user offset can also be used, which the 
amplifier adds after multiplying by the scaling factor (user scaling). Measurement 
processing can be mathematically expressed as follows: 

Measured Value = (Raw Reading + Raw Offset) x Sensor Scale + User Offset 
For standard sensors, the sensor scaling corresponds to a multiplication by the User Scaling, for 
multi-axis sensors it is a more complex calculation (see p. 39 or S.46). 

This means that user offset can also be used for multi-axis sensors for individual channels. 
It is displayed in the Configuration tab under User Offset / Tare. 
If you click on this number, you will be taken to the dialog for setting the user offset: 
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You can use it to enter a new offset directly in New User Offset and save it with OK / Set or 
have a new value calculated. To do this, enter the desired measurement value in Desired 
Measuring Value (or leave 0 here) and then click on Calculate. Some measured values are 
automatically taken and the calculated value then appears in New User Offset. Save to 
device with OK / Set. 

Limitations of Zeroing 
For PT1000 and Type K temperature sensors, zeroing with Set Zero in the initial state is not 
permitted, and the same applies to the single-ended voltage input. 
If you click on Set Zero , this message appears: 

 

In the case of voltage inputs, you often want to measure the absolute voltage, like a 
voltmeter, and a change in zero point would falsify this. Even when measuring temperature, 
zeroing would falsify the measurement, unless the sensor has a temperature of 0°C. 
To remove these restrictions, click on Options in the menu bar and select the Hardware tab: 

 

To allow zeroing for voltage inputs, leave Prohibit for temperature inputs in the upper left 
corner and clear the check box for Prohibit for single-ended voltage input. In the case of 
BSC4D, the check box for Allow for single-ended with BSC4D must also be checked. In this 
case (BSC4D) the password berlin must be entered. Confirm with OK at the end. 
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To also allow zeroing for temperature inputs, you have to select zero Always allow under 
Allow Set. 
This configuration - like all settings in the Options menu - is not stored in the amplifier, but in 
the software settings. 
Restricting Zeroing for Single Channels 
The BX8 also allows you to configure the zeroing behavior for bridge and voltage inputs in 
the device settings.18 This can be set in the Input Type dialog under Setting Zero Behavior: 

 

The following options are possible: 

• Set Zero allowed, Relative Measuring 

• Set Zero prohibited, uses calibrated zero-point. Absolute measuring: Zeroing is 
prevented and absolute ("true") voltage or bridge detuning is measured. The raw offset 
used (see above) is a manufacturer's calibration value that only compensates for internal 
offset errors of the amplifier, not external ones. The currently set RohOffset may be lost. 

• Set Zero prohibited, uses actual / primary zero-point: Zeroing is prevented and the 
currently set raw offset is left unchanged. 

Memory behavior of the zero point on the BX6 
With the BX6, it is possible to specify under the menu bar → Device → 
Advanced Settings → Administration whether the zero point should be stored 
non-volatilely. This is the case in the delivery state (and fixed for all other starin 
gage amplifiers), i.e. after a zeroing with Set Zero / Set All Zero, the zero point 

is restored after switching the device off and on (Store value non-volatile). If you turn off 
saving (Don't Store (volatile), the zero point is lost after turning it off and on. This setting can 
be useful if the zero adjustment is triggered very often, e.g. by a machine or a system, for 
example as a lump sum before each measurement process. This is because the flash 
memory of the zero point (and all other operating parameters) wears out and disabling the 
memory prevents the maximum amount of memory from being exceeded. 

Auto-Zero 
The BSC2 and BX8 devices can be configured to perform a zero adjustment on their own 
under certain conditions, namely when the reading remains within a range around zero for a 

 
18Firmware version 1.54 or higher 

Sebastian wetz 
2023-10-21 03:17:00 
-------------------------------------------- 
Multi-dim sensor??? Check in source! 
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certain amount of time. This time interval and range can be set in the menu bar → the 
device → Advanced Settings → Value Mode → Auto-Zero. 

This function can be 
useful, for example, to 
suppress thermal drift of 
a sensor; in this case, 
the threshold would be 
set close to zero and 
care would be taken 
when measuring that 
the load is removed 
frequently and then for a 
sufficiently long time. 
When measuring a 
continuous load that 
never goes to zero, the 
Auto-Zero function is 
less suitable; the BSC2 

provides a special drift compensation algorithm for this application, see below. 
In the BSC2, the Auto-Zero threshold is the same as the lower threshold switch No. 1, i.e. a 
zero adjustment is performed after the specified time when threshold switch 1 is inactive. 
The time interval of BSC2 and BX8 is stored internally as a count that counts measured 
values, i.e. after a change in the measurement data rate, it may have to be reset. 
After changing the settings, click Store to device at the bottom . 

 
With the BX8, the auto-zero conditions can be linked between channels. These advanced 
settings open after clicking on Drift Compensation More... 

At the top are settings that apply 
to all channels, while those at 
the bottom are for the input 
channel selected with Channel. 

• Auto-Zero enabled: This allows 
the entire function to be enabled 
and disabled globally. 

• If Condition(s) met: Time 
Interval to Set Zero: Displays or 
sets the time interval after which 
the zeroing will occur if the other 
conditions are met. Internally, it 
is stored as a counter value, see 
above. 
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• Channel Handling: Here you can choose whether the threshold condition is checked 
independently for each channel or for all channels together: 

◦ Independent from each-other means that the time interval for each channel is 
counted independently and individually, as long as its reading is within its 
respective threshold range, as long as the channel is configured accordingly. 

◦ Grouped: Conditions ANDed means that if all channels with Apply Threshold 
Condition for this Channel enabled remain below their individual threshold, the 
time interval will continue to be counted. 

The measured values are set to zero when the time interval has expired and Perform Auto-
Zero for this channel is activated for this channel. 

• Channel: Selects the channel for which the following settings apply unless Apply the 
same settings for all channels is enabled. 

• Perform Auto-Zero for this Channel: Auto-zero this channel when the other conditions 
are met. 

• Apply Threshold Condition for this Channel: If Grouped: Conditions ANDed is also 
active, this can be used to select whether the threshold condition for time interval 
counting is checked for this channel, see above. 

• Value Range, where Auto-Zero is applied after time interval is reached: Here, the 
threshold range is set around zero, where the value must be in From < 0 and in 
To >0, and it is: From = -To. It is best to enter only the positive one in To, From will 
then be set automatically. 

• Apply the same settings for all Channels: If enabled, the channel-specific settings 
apply equally to all input channels. 

In the end, changes are saved with store to device . 
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Analog and digital filters 
Filters act in the frequency range of the measurement signal, i.e. they only allow a certain 
frequency range to pass through and the other ranges are attenuated (attenuated). All strain 
gage amplifiers originally act as low-pass filters, i.e. they process measurement signals of 
constant magnitudes with f=0 up to a certain cut-off frequency fg. The cut-off frequency is 
the signal frequency at which the amplitude is already attenuated by -3dB, i.e. by a factor of 
0.707. In the case of a low-pass, the attenuation increases further above this cut-off 
frequency. In the case of digital amplifiers, this results from the measurement data rate (see 
p. 16), the analogue pre-filter and, if necessary, an additional digital filter, see p. 90. The 
lowest of these two or three low-pass cut-off frequencies is effective for the bandwidth of 
the measurement signal. 

Analog Filters 
All digital strain gage amplifiers have an analog pre-filter, which is located in front of the AD 
converter in the signal processing chain. Usually, its cut-off frequency is half of the 
maximum measurement data rate or less. 
The settings of the analog filter can be changed on the BSC2 and BX8 under the menu bar 
→ Device → Advanced Settings → Filter → Which Filter = Analog: 

 

 
In the BSC2 and BX8, the analogue cut-off frequency can be switched in three stages. In the 
initial configuration, Set automatically, according to data rate is set and then it is set 
automatically based on the measurement data rate: 

 

Model (additional condition) Measurement data rate Analog Filter: Cut-off 
Frequency 

BSC2 
(without FIR filter, see 

below) 

Less than or equal to 7.14/s 3.5 Hz 

From 96 to 625/s 260 Hz 

Greater than or equal to 625/s 1700 Hz 

http://www.interfaceforce.com/


7418 East Helm Drive • Scottsdale, Arizona 85260 • 480.948.5555 • www.interfaceforce.com 

90 

 

 

 

Model (additional condition) Measurement data rate Analog Filter: Cut-off 
Frequency 

BSC2 
(with FIR filter, see below) 

Less than or equal to 15/s 3.5 Hz 

From 15 to 1071/s 260 Hz 

Greater than or equal to 1071/s 1700 Hz 

BX8 Less than or equal to 80/s 28 Hz 

From 96 up to and including 3000/s 850 Hz 

Above 3000/s 11400 Hz 

The cut-off frequency is displayed under Lower Cut-off frequency [Hz]. If Set automatically, 
according to data rate is not set, the cut-off frequency can be selected manually with Cut-off 
frequency. 
Since the BSC2 and BX8 are both equipped with Sigma-Delta AD converters, the original input 
sampling frequency is in the Mhz range and the analog pre-filter therefore also acts as an anti-
aliasing filter for each of the three setting options. 

Digital Filters 
Digital filters are implemented in the device's software, i.e. they process digital (discrete-
time and discrete-value) signals. Basically, there are two different types of strain gage 
amplifier devices: FIR and IIR filters. In the case of digital filters, the cut-off frequencies 
depend on the measurement data rate; it is always less than half of the measurement data 
rate and actually acts as a divisor (i.e. a factor <1) to the measurement data rate. Therefore, 
if the data rate changes, the cut-off frequency changes accordingly. BlueDAQ displays the 
measurement data rate in the configuration window. 
FIR Filter 
A FIR (Finite Impulse Response) filter processes only one sequence of input readings, this 
sequence consists of the current and past, unfiltered readings. It is always stable, i.e. the 
output signal does not contain any artifacts, regardless of the filter settings and the input 
signal, so it corresponds to the input signal or the input signal with a smaller amplitude. 
However, like all filters, it requires a certain time delay, the filter runtime. 
An important parameter is the filter order, which determines how steep the transfer function 
is in the attenuation range. The higher the order, the steeper it is, i.e. frequencies above the 
cut-off frequency are more attenuated; however, the runtime is also longer at higher order, 
see pictures below. 
The BSC2, BSC1 and BX8 devices offer FIR low-pass filters, they are configured under the 
menu bar → Device → Advanced Settings → Filter → Which Filter = Digital FIR. At the bottom 
left, the filter can be enabled or disabled with Use Filter. 

BSC2: Two different switchable FIR filters can be switched on, one of the second 
order with the -3dB cut-off frequency = measurement data rate * 0.18. Its transfer 
function is smooth, with no overshoot in the jump response and it has a runtime of 
only 3 readings. 
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Also, a 5th order with cut-off frequency = data rate * 0.23. Its transmission function is 
much steeper in the damping range, but with about 6% overshoot in the jump 
response; in addition, the runtime is 6 readings. 
BSC1: The BSC1 only offers the 2nd order FIR filter with the same characteristics as 
the BSC2. 
BX8: With the BX8, the FIR low-pass filter can be set individually for each channel, 
with the desired cut-off frequency being entered under Cut-off frequency [Hz]. The 
filter order can be selected manually under Filter Order or set automatically if the Set 
Automatically checkbox next to it is set. The value range ranges from 4 to 14 in steps 
of two (i.e. only even orders are possible). If the filter order is selected automatically, 
the filter is optimized for runtime, i.e. the lowest possible order is selected. The 
nominal attenuation in the restricted range, i.e. above the cut-off frequency, is fixed at 
60dB. 

 

FIR with fg= Fa/10: 
Order=8 automatically selected. Attenuation -60dB at 2/3xFa reached. 
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FIR with fg= Fa/10, 
attenuation -60dB at max. order=14 already achieved at Fa/4. 

 
IIR Filter 
IIR filters can be configured individually for each channel of the BX6 and BX8. An Infinite 
Impulse Response (IIR) filter handles both a sequence of input values and one of output 
values from previous filter runs. As a result, a better filter characteristic in the frequency 
range can often be achieved at a lower order. IIR filters can be unstable, but BlueDAQ's 
calculation algorithm avoids unstable results. Under certain circumstances, one of the 
following error message texts is displayed: 
"DLL.Dfilter: Digital filter calculation failed to converge" 
"DLL.Dfilter: Resulting coefficients discarded, because they may limit measuring precision (gain too big)" 

 
The filter order is set to four. With the IIR filter, you can choose between four different filter 
types (characteristics) with Filter Type, which differ in whether low or high frequencies or 
certain frequency ranges are transmitted or attenuated. 

• Low Pass: Low frequencies below the cut-off frequency are allowed through, above 
they are attenuated. Application example: Interference or vibration suppression for 
specific input channels. 

• High Pass: Frequencies above the cut-off frequency are allowed through, below which 
frequencies are attenuated. This also suppresses a constant size (f=0). Application 
example: Vibration measurement or detection of temporal changes (transients). 

• Band Pass: Frequencies below the lower cut-off frequency (lower cut-off frequency) 
and above the upper cut-off frequency (upper cut-off frequency) are attenuated and 
frequencies that fall between these two cut-off frequencies are allowed through. 
Application example: Measurement of vibrations in a certain frequency range. 
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• Band Stop: Frequencies between the lower cut-off frequency and the upper cut-off 
frequency are attenuated. Application example: Suppression of a certain interference 
frequency or vibration. 

Filter configuration and simulation with BX6 and BX8 
Typically, the controls in the menu bar are → Device → Advanced Settings → Filter in order 
from top to bottom. If you want the configuration to be different for the input channels or if 
you only want to apply to one channel, you first select it with Input Channel from. If filters are 
already configured, this will be displayed under Configured filter(s) , namely: None (never 
configured) IIR, FIR or FIR and IIR (both). With Which Filter With the BX8, you can choose 
between IIR and FIR. With Filter Type you select the characteristic of the IIR filter (Low Pass, 
High Pass, Band Pass or Band Stop, see above). If the filter has only a cut-off frequency (Low 
Pass / High Pass) it shall be Cut-off Frequency displayed or operated. If it has a lower and an 
upper one, it will be Lower Cut-off frequency (lower) and Upper Cut-off frequency (upper). In 
the case of the FIR filter, the filter order can be changed under Filter Order (see S. 90). 
By clicking on the Frequency Response→Show button, the filter is simulated in the frequency 
domain. The frequency in the range f=0 to f= Fa/2 is plotted on the right side of the image 
on the X-axis and the attenuation in dB (decibels) is plotted on the Y-axis, so that 0dB 
means: frequency is transmitted. The Step Response→Show button simulates the filter in 
the time domain. A jump is given to the filter, whose amplitude jumps from 0 to 1 at time 
t=0, and the output signal of the filter, the jump response, is displayed on the right side of the 
graph. On the X-axis, the time is plotted in seconds, and on the Y-axis, the amplitude curve is 
plotted as a factor, where 1 is the input amplitude at t>0. This allows the runtime and 
overshoot to be determined. The filter simulator depicts the true computational core with the 
original algorithm of the BX6 and BX8 in the time domain. Show coefficients can be used to display 
the filter coefficients, i.e. the result of the filter determination. 

With Store to Device, the displayed filter configuration is stored in the device. If the checkbox 
Apply to all input channels is set, it will be set for all input channels. If Use Filter is set to 
Enabled, the filter will be activated in the device; if Apply to all input channels is set at the 
same time, the filter will be activated for all input channels with configured filters and with 
Use Filter = Disabled it will be disabled. 

It is highly recommended to perform the filter simulation with frequency response and step 
response, because the filter is calculated here and you can detect any discrepancies early. 
The following are examples of simulation results of all filter types of IIR filters in the BX6. 
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At f=0 (direct signal) the attenuation is maximum, after the oscillation time of the jump 
response (right) the output signal is again =0. 

http://www.interfaceforce.com/


7418 East Helm Drive • Scottsdale, Arizona 85260 • 480.948.5555 • www.interfaceforce.com 
95 

 

 

 

 
IIR bandpass from Fa/20 to Fa*0.35. The jump response is similar to that of the high pass. 

 

IIR band lock for attenuation of 50 Hz (mains hum). 
 
 
Communication Interfaces and Measurement Data Frames 
A communication interface, also known as an interface, consists of one or more electrical 
signals that transmit information. For strain gage amplifier devices, the serial interface can 
run on different hardware ports, e.g. USB, UART, RS232, RS422, Ethernet or Bluetooth 
Classic/SPP. In Add Channel dialog, the correct communication interface is selected based 
on the selected device type (Device Type) is automatically selected; with the exception of the 
BX6, which is Communication Interface between Serial/USB/BT and CAN can be chosen. For 
CAN you need an adapter, s.S. 98. 

Bitrate/Baud Rate, On/Off 
The serial ports of all strain gage amplifier devices have the basic configuration of 8 data 
bits, no parity and 1 stop bit (8N1).19 The communication bitrate must be selected correctly 
in the Add Channel dialog on most devices. This does not apply to the USB interface of the 

 
19Except for rare special types such as BSC2HD with parity 
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BX8 and the BSC2 and to the Bluetooth Classic Interface (e.g. BX6BT). For these devices, the 
Bits/s setting in Add Channel is irrelevant on these interfaces. This also applies to BX8 over Ethernet, 
because a converter device, e.g. Moxa, is connected in between, in which the bitrate must be 
correctly configured. 

If the device type is selected, 
the default bitrate is suggested; 
however, if it is set differently in 
the device, it must be selected 
accordingly with bits/s. It is 
best to use the small arrow 
keys, because the control 
element contains a list of the 
bit rates (= baud rates) present 
in this device. 

The bit rate of serial interfaces is one of the main factors that limit the maximum adjustable 
measurement data rate (see p. 16 and 102); However, this only applies if it is relevant. The 
BX8 and some BSC2 and BX6 models have multiple communication interfaces, and the 
lowest relevant bitrate of an enabled interface limits the maximum data rate the most. In the 
case of the BX8, this can be the bitrate of a UART, RS422 or CAN interface. 
However, very high bitrates cannot be transmitted with certain hardware interfaces; e.g. the 
maximum default bitrate for RS232-V24 is often only 115200 bits/s; even a very long 
interface cable has a restrictive effect here. 
Bit rate and on/off status of interfaces are controlled under Menu Bar -> Device -> Advanced 
Settings -> Interface. Which interfaces can be operated depends on the device design; the 
Interface tab may not be present. Only BSC2, BX6 and BX8 can be used to change bit rates; 
the BSC2 must have a configuration jumper set for this purpose; see BSC2 Owner's Manual. 
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Changes to interface settings will only take effect after the device has been rebooted. After 
clicking on Store to Device , this will be noted in the text Info : 

With the BX8, UART, RS422 and the CAN interface can be switched off with the Enabled 
On/Off checkbox, if they are available. It makes sense to do this when it is not needed, 
because the maximum adjustable measurement data rate is then larger. Each device has at 
least one interface that cannot be switched off, in the case of BX8 this is USB. 
BX8 with Ethernet uses the UART interface for the Ethernet converter device; the bitrate must therefore 
be set in the same way for both devices (BX8 and Ethernet converter). With BlueDAQ, this can only be 
done on the BX8 side; The Ethernet (TCP-IP) device server Moxa Nport5110A is configured via Ethernet. 

The RS422 interface is differential, i.e. the transmit and receive signal uses two lines each, five in total. As 
a result, significantly higher bit rates and longer cables can be achieved. 

The following bitrates are supported; the default value is set to bold: 
BSC2 and BSC1, depending on the version UART, RS232, USB, RS422: 4800, 9600, 19200, 
38,400, 57,600, 115,200, 230,400, 250,000, 460,800, 625,000, 921,600, 1,250,000. 

BX6: depending on version, UART, Ethernet, USB: 19,200, 38,400, 57,600, 115,200, 230,400, 
460,800, 921,600. 
BX6 CAN interface: 25,000, 50,000, 100,000, 125,000, 250,000, 500,000, 1000,000 
BX8 UART 3.3V, Ethernet: 19,200, 38,400, 57,600, 115,200, 230,400, 460,800 
BX8 RS422: 19,200, 38,400, 57,600, 115,200, 230,400, 460,800, 921,600, 1,250,000, 1,458,333, 
1,750,000, 2,500,000, 3,500,000 
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BX8 CANopen: 50,000, 100,000, 125,000, 250,000, 500,000, 1,000,000 
GPS/GNSS and user device20, serial, USB: 2400, 4800, 9600, 19,200, 38,400, 57,600, 115,200, 
230,400, 460,800, 921,600. The bitrate is selected in the Add Channel dialog, BlueDAQ cannot 
change it on these devices. 

Permanent measurement data transmission 
When delivered, all amplifiers automatically transmit measured values at the set 
measurement data rate. The BSC2, BSC1, BX6 and BX8 can be equipped with independent 
measurement data transmission under the menu bar → Device → Advanced Settings → 
Value Mode → Value frame Transmission. 

Even if it is switched off, BlueDAQ usually still displays measured 
values because it temporarily starts the transmission when the 
device is opened, i.e. it then performs Start Transmission across 
the board. 
The setting of permanent data transmission, which is stored 
permanently, therefore applies mainly after the device has been 
switched on. It is operated under Permanent value transmission 
non-volatile state. If the top selection Values transmitted 
permanently is active, the device will send readings after powering 
on, but if Values NOT transmitted permanently is active, it will not. 
If a device stops sending readings immediately after deactivation, 
the Configuration tab of the main window will display timeout 
instead of the measured value after a certain period of time . This 
can be temporarily remedied by clicking the Start Transmission 

button under Value frame transmission -> Volatile state. The soft-LED Actually transmitting 
values will then light up again. 
Disabling permanent data transmission is useful for the following applications, for example: 

• BX6BT with high measurement data rate >200/s to facilitate Bluetooth connection. If 
necessary, the Set Frequency dialog will activate this accordingly. 

• Measurement data transmission triggered by digital input, see p.109 

• Other software, e.g. that reads measured values only on request (via the Get Value 
command) 

CAN and CANopen settings 
In addition to the bitrate, one or more CAN IDs can be changed for the CAN interface. CAN is 
a bus system to which several devices, so-called nodes, can be connected. Strain gage 
amplifiers with CAN also have several services, e.g. sending measurement data, receiving 
commands and sending command responses. Devices and services are differentiated on 
the CAN bus by the CAN IDs; each CAN-ID may therefore only occur once on the same bus. 
With the CANopen application protocol (BSC2 and BX8), only the device ID (node ID) can be 

 
20These types of devices are only available with BlueDAQ PRO. 
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changed, the CAN IDs of the services result from this in a way that is specified by the 
CANopen standard. 
BlueDAQ supports CAN converter hardware from the manufacturer PEAK Systems, namely 
the PCAN USB model as standard. Alternatively, you can use the menu 
bar>options>hardware>CAN adapter type to switch to the PCAN PCI model, etc. 
The settings for CAN-ID and bitrate can be accessed via the menu bar -> Device -> Advanced 
Settings -> interface. For CANopen devices, the node ID is displayed and changed here. The 
following IDs can be set for the BX6-CAN: 

• Command ID: ID for command request. It must be 
different from the Response ID and the Value ID. 

• Response ID: ID for responses to commands. It must be 
different from the command ID. 

• Value-ID: This ID is used to send measurement data. It 
must be different from the command ID. 

• Multicast ID: This ID is reserved and is not currently in use. 
On most BX6 models, the CAN interface settings are 
accessible even if the hardware version does not offer a 
CAN interface. They are then to be ignored, the On / Off 
state should then always be off. 

 
 

 
CRC on BX6 and BX8 

With the checkbox Menu Bar -> Device -> Advanced Settings -> Interface -> CRC for all Serial 
Frames, a checksum calculation can be activated for all serial ports on the BX6 and BX8. As a 
result, the device provides the measurement data frames with a CRC-16 checksum and 
BlueDAQ then also uses the CRC-8 checksum provided for command requests, the 
command responses are then sent with it as well. 
A checksum can be useful if the serial protocol does not run via a USB, Ethernet or 
Bluetooth interface, but is sent directly (e.g. RS232, RS422, UART), especially if 
electromagnetic interference is present. The checksum extends the measurement data 
frame by 2 bytes, so that the maximum measurement data rate may be slightly lower. More 
detailed information on the indication and calculation of the checksum can be found in the 
protocol documentation. Data frames where the CRC check fails are silently filtered out, i.e. 
if CRC errors occur (e.g. due to strong interference), measured values are omitted, but no 
distortion of the data streams occurs (i.e. it is extremely unlikely). 

Data Frame: Channel Count and Data Type 
The BSC2, BSC1, BX6 and BX8 amplifiers offer various settings regarding the type of data 
transmitted via the digital interface. BlueDAQ can evaluate all configurable data types; if 
necessary, it automatically converts the incoming measurement data using user scaling . 

Sebastian wetz 
2023-12-21 01:38:00 
-------------------------------------------- 
really without an error message? 
Testing with EMC speed cameras! 
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However, a change in the data type may be useful or necessary if other programs are to be 
used that only know a certain data type or if the measurement data rate is to be increased, 
because the measurement data type can also limit this maximum. 
The measurement data type can be changed under the menu bar → Device → Advanced 
Settings → Value Mode → Frame / Value Type. The details of the measurement data frames 
and the decoding of the measurement data are described in the instrument user manuals 
and for the BX6 and BX8 in the protocol description. 
Measurement data type for BSC2 and BSC1 

It can be chosen between two different binary data formats and text 
data format. 

• 16-Bit value, 3-Byte frame: Adjustable on BSC2 and 3. The 
measurement data frame consists of only 3 bytes, the first is a constant 
prefix, followed by 2 bytes with binary-coded readings. This setting 
allows for the highest measurement data rateS. 16. In the BSC2, the 
lowest byte of the 24-bit values is omitted, so that this setting is only 

recommended with rather high measurement data rates, where the effective 
resolution is reduced anyway due to the higher noise. For the BSC1, this is the default 
data type. 

• 16-bit value, 4-byte frame: BSC1 only: The measurement data frame consists of 4 
bytes, the first is a constant prefix, then comes a flag value that contains the state of 
the threshold switch, then the binary-coded 16-bit measured value. The 4-byte frame 
allows for safer frame synchronization when using other software, because the 
masked second byte can be taken as a preamble, making missynchronization much 
less likely. 

• 24-bit value, 5-byte frame: BSC2 only: The measurement data frame consists of 5 
bytes, the first is a constant prefix, then comes a flag value containing the state of 
the threshold switches, then the binary-coded 24-bit measured value. The 5-byte 
frame allows for more secure frame synchronization when using other software, 
because the masked second byte can be taken as a preamble, making 
missynchronization much less likely. For the BSC2, this is the default data type. 

• ASCII Text: Adjustable for BSC2 and 3. The measurement data frame is an ASCII-
compliant text, with the first byte always representing the sign + or – and the frame 
ending with the control characters CarriageReturn and LineFeed (0x0D0A). This is a 
widely compatible format and it is easiest to evaluate (with most programming 
languages) with self-written programs; however, the maximum measurement data 
rate is the lowest because it takes up to 18 bytes to transmit a measured value. 
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Formatting of the measured value text display 
With the BSC2 and BSC1, the number of 
digits of the measured value in the text 
frame can be configured in a sub-dialog 
that opens when you click on the menu 
bar → Device → Advanced Settings → 
Value Mode → Format Value Clicks. In the 
case of BSC2 models with an LCD display, 
this also changes the display of the 
measured values. The number of possible 
decimal places (decimal places) still 
depends on the display normalization 
(User Scaling=Display scaling). The 
maximum number of significant digits 

under Number of Digits is =8 for the 24-bit amplifier and BSC1 =5 for the 16-bit device. At the 
bottom of the configuration dialog, examples of the measured value text are displayed 
based on the number of digits selected above, optionally for the display (LCD) or the serial 
port (Serial Port). This can also be used to count the number of bytes per frame, where +2 
for the suffix must be added to determine the maximum measurement data rate (Byte 
Count, s.S. 102). 
This device setting Number of Digits is independent of the software (see p. 32), however, if it 
is lower than that of the software when the ASCII measurement frame is enabled, zeros are 
appended, i.e. it then requires the lowest display step. 
Measurement data type for BX6 and BX8 
You can choose between integer data format and floating-point representation. The set 
measurement data type applies to all existing interfaces except EtherCAT and CANopen. 

• 16-bit Integer values: Integer binary format in which each measurement in the data 
frame is represented by 2 bytes. This setting allows for the highest measurement 
data rateS. 16. 

• 24-bit Integer values: BX8 only: Integer binary format in which each measured value in 
the data frame is represented with 3 bytes. 

• Float values: Floating-point representation, in which each measurement in the data 
frame is represented with 4 bytes and gives fully scaled readings, provided that the 
sensor associated with the corresponding channel is correctly configured. This 
setting is for displaying physically scaled measured values for certain sensor types 
such as multi-axis sensor (s.p. 39) and temperature sensor required. It corresponds 
to the default setting. 

Number of channels in the measurement data frame 
With the BSC8D, only the channels that have been opened with Add Channel are 
transmitted . For the BX6 and BX8, this number can be configured under the menu bar → 
Device → Advanced Settings → Value Mode →Number of Channels in Frame. For these three 
types of devices, it influences the maximum adjustable measurement data rate: the fewer 
channels, the higher it is (however, the absolute maximum of the measurement data rate, 
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e.g. 48000/s for BX8 standard, cannot be exceeded). With the BSC4D, the number of 
channels is immutable =4. 

With the BX6 and BX8, only input channels can be opened in the Add 
Channel dialog that are also transmitted in the measurement data frame. 
If the number of channels is reduced, open channels are automatically 
removed and are no longer present; if this number is increased, the new 
channels can then be opened manually using Add Channel. 
The minimum number for BX8 = 2, so that only input channels 1 and 2 are 
available; for older BX6 devices only the number of channels 1, 2, 3 or 6 
can be set. The entry must be completed with Store to device. With the 
BX8, the number of channels between the UART and USB interface is 
managed independently of each other and is operated for the respective 
active interface, i.e. USB is used to set the number of channels of the USB 
frame, and UART/RS422 is used to set the number of channels of the 

UART and RS422 interface. 
If there are one or two counters or frequency counter channels (see p. 120), the maximum 
number of channels increases accordingly. 
BX6 and BX8 behave differently in terms of data acquisition in connection with this setting. 
The BX8 always captures all 8 channels21, regardless of number of channels in frame; the 
BX6, on the other hand, only captures configured channels. 

Data Frame and Measurement Data Rate 
The communication bitrate (baud, in bits/s) and the number of bytes per measurement data 
frame (number of bytes) determine the maximum measurement data rate. This may be 
limited by other settings, and there is also an absolute maximum for each device model, 
which is indicated in the data sheet or the user manual and cannot be exceeded. If there are 
multiple interfaces, such as the BX8, the lowest Fdata,max of all enabled interfaces is 
considered the maximum. 
Serial communication is used for all devices and interfaces where the communication 
bitrate is relevant (see S. 95), the maximum measurement data rate theoretically is as 
follows: 
Fdata,max = baud / (number of bytes x 10) 
The value must be rounded down, and it may be lower depending on the device. This may be 
due to the fact that only certain values can be set for measurement data rates. BlueDAQ 
displays the range of values in the Configuration Tab -> Data Frequency dialog, so you can 
first change the settings of the measurement data frame and then read the maximum there. 
BX6 and BX8 have the same serial data protocol in which the structure of the measurement 
data frames is specified. The following applies: 
ByteNumber = N x DT + 4 

 

 
21In the case of high-speed special equipment, there are 4 channels 

http://www.interfaceforce.com/


7418 East Helm Drive • Scottsdale, Arizona 85260 • 480.948.5555 • www.interfaceforce.com 
103 

 

 

or, if the CRC checksum is enabled: 
ByteNumber = N x DT + 6 
This includes: 
N: Number of channels in the measurement data frame 
DT: Number of bytes per reading, i.e. =2 for 16-bit integer, =3 for 24-bit integer, and =4 for 
float reading. 
Example: 6 channels, float, without CRC: byte count=28; Fdata,max= 822/s at baud=230400 
bits/s (e.g. BX6). 

Bluetooth settings on the BX6BT 
The dialog for device behavior and communication settings of the Bluetooth interface of the 
BX6BT can be accessed via the menu bar → Device → Advanced Settings → interface → 
Bluetooth Settings, i.e. you click on the Open Dialogue button. When entering this menu, the 
measurement data transmission is stopped, i.e. while it is open, the timeout message 
appears under Measuring Value in the main window Configuration. 

The Bluetooth mode must be 
Classic in order to open the BX6BT 
with BlueDAQ; this "SPP" device 
profile emulates a serial port. The 
Low Energy mode is not compatible 
with BlueDAQ. It follows the 
BLE/Gatt standard and there are 
separate instructions for this. It can 
be used to communicate with the 
BX6BT with smartphones and a 
BLE/Gatt app, for example, and to 
read out measured values, among 
other things. To switch, set it to 
Low Energy and then click Store to 

device. After you close BlueDAQ or use the menu bar -> Device -> Close... has removed all 
channels of this device, the low-energy mode is activated. With a Gatt browser program / 
app you can switch back to Classic Mode to be able to access the device via BlueDAQ again; 
The instructions ba-bx6bt-gattservices_en.pdf describe how to do this. 
Under Maximum Power for BT Low Energy can reduce the maximum transmit power for the Low 
Energy mode; by default it is set to Maximum = 7dBm. With less transmitting power, the battery can 
last a little longer, however, the range is reduced, less than -3dBm is not recommended. 

Device behavior when Bluetooth connection is closed 
In addition to the hardware measurement application (BX6CPU), the BX6BT contains a 
second microcontroller, which can also switch the BX6CPU on and off. When the Bluetooth 
connection is open, i.e. when the blue device LED is on, the measurement application is 
always switched on, which is indicated by the glowing green device LED (both in Classic and 
Low Energy mode). The device status when the Bluetooth connection is closed (blue LED 
off) can be viewed under On / Off state of measuring amp when BT connection is closed can 
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be configured. This is useful for recording measurement data on the SD card in stand-alone 
mode, see p.33. When the measurement application is switched off, the device is in standby 
mode and consumes very little power, so the battery lasts for a very long time. Specifically, 
the options are: 

• Device remains on: The measurement application remains on at all times. 

• Device switches off: The measurement application is switched off after the 
connection is closed and remains off. (Condition of delivery) 

• Periodical Logger: The measurement application is briefly switched on by a hardware 
clock (RTC) at a definable time interval >= 1 minute in order to record a line of 
measured values, see p.33, Single Log Periodically. 

• On/Off by Key: The measurement application can be switched on and off with a 
button connected to a specific digital line (BT-DIO3). With the BX6BT M8 model 
variant, this is already available as standard, see user manual.22 

• On/Off by Switch: The measurement application can be switched on and off with a 
switch connected to a specific digital line (BT-DIO3).23 

Other BT Settings Displays and Controls 
• BT Device Name: The Bluetooth name of the device in BT-Classic mode. Changing 

this name is possible, but not recommended for end users . 

• BGscript Version: The firmware version of the second microcontroller (BT controller). 

• Digital Out 1 / 2: This allows the digital outputs "IO_1" or "IO_2" of the BT controller to 
be switched to high as a test. The condition is fleeting. These digital outputs are not to 
be confused with "SW1-3" = "DIO1-3" = "Threshold output", which are controlled via the 
measurement application, see p.109. 

• Digital Out 4 (LED): This allows the user LED of the BT controller to be switched on as 
a test. The condition is fleeting. 

• Battery Voltage: The voltage of the battery. If it is less than 3.7V, it should be charged! 

• Read All again: Read all settings again. 

Transfer of the maximum or minimum value 
With the BSC2, BSC1, BX6 and BX8, the measured value frame can be reconfigured so that 
instead of current measured values, only maximum or minimum values are transmitted, i.e. 
positive or negative peak values. If you use this device mode, the current measured value is 
no longer displayed. To see both, you can switch a numerical display via software, as on S. 
30 shown. With Menu bar -> Device -> Advanced Settings -> Value Mode -> Maximum / 
Minimum values on the other hand, the configuration of the device will be changed. This can 
be particularly useful when using other software or if the BSC2 wants to show the 
maximum on the device display. 

 
22Available from BGscript version 1.00 
23Available and fully functional as of BGscript version 1.02 
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To transmit maximum values, Value transmission is set to Transmit maximum values. In the 
case of the BX8, the Acquire maximum and minimum box must also be set so that the max 
and min values are recorded. You can then also set the transmission with transmit minimum 
values to minimum values. 

With the BSC2 and BX8 there is the 
possibility to transfer maximum 
amounts. This means that the maximum 
of the measured values is transmitted 
with the "omitted sign". To do this, 
activate the checkbox Maximum values 
are maximum values of absolute values 
MAX(|vals|) and at the same time selects 
Transmit maximum values. The devices 
then calculate the amount of the 
measured values and determine the 
maximum value, which is always positive. 
With the BSC2 there is also the value 
transmission mode Transmit max. / min 
values. This is similar to the maximum 
amount value, but the sign is not omitted, 
but transferred as well. Example: 

Measured value first =0, then new max value 10. Now a new minimum value of -12 is 
created. With transmit max. / min values, the BSC2 now transmits -12, with maximum 
values of absolute values it would transmit 12. 

All devices generally transmit the maximum or minimum values with the set measurement 
data rate, i.e. if there is no new maximum or minimum, the previous one is repeated. 
However, the BSC2 also offers a maximum event mode. If the Transmit value on new 
maximum event checkbox is set, only new maximum values will be transferred. As a result, it 
regularly happens that the BSC2 does not transmit any measured values, i.e. the 
measurement data stream is irregular and BlueDAQ then displays timeout more often in the 
measured value display in the configuration tab. 

Definable measured value text for integration of other devices 
With BlueDAQ PRO it may also be possible to display the measured values of other 
measuring devices, under the following conditions: 

• The device transmits via a serial port (real or virtual) with the default setting of 8 data 
bits, no parity and 1 stop bit (8N1). 

• One of the following bitrates is supported: 2400, 4800, 9600, 19,200, 38,400, 57,600, 
115,200, 230,400, 460,800, 921,600. 

• The device sends text with measured value frames as an ASCII or UTF-8 string, i.e. it 
is 8 bits per character. 
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• It sends the measured value frames automatically and automatically, i.e. they do not 
have to be requested. 

• The layout of the measured value frame remains constant, i.e. its basic structure 
does not change during the measurement runtime. 

• The decimal separator in the measured value is a period, not a comma. 

• Each measurement frame is terminated by carriage return and line feed, i.e. by the 
control characters LF,CR (0x0D0A). 

To open such a device, select the UserDefined device type in the Add Channel dialog under 
Device Type. The dialog for configuring the measured value text opens automatically if 
necessary; if it doesn't, click on Value String/DEFINE. 

It offers the following setting options: 
Frame Prefix Mode: A prefix is a character that 
always comes first in each measurement 
frame; there are three choices: 
Has Character Prefix: There is a prefix and it is 
entered in Define Prefix Character as a 
character, e.g. $ or % or A. 

Has Binary Prefix: There is a prefix and it is entered into Define Binary Prefix (hex) as a 
2-digit hexadecimal number, e.g. 0A or B4 or 80. 

No Prefix, 1st char is - or digit: There is no prefix and the metric frame starts with a 
reading, i.e. the first character is - + or one of the digits from 0 to 9. 

Number of values in String/Frame specifies how many metrics/channels the metric frame 
contains. Each metric can then be mapped to a channel in BlueDAQ, but this doesn't have to 
be done for every metric in the frame. So this number should be correct, regardless of 
whether you want to display all values or not. If Open all input channels is activated in the 
Add Channel dialog, the first reading in the frame will be assigned to the first channel of this 
device, the second to the second, and so on. If you want to change the displayed channel 
order, you have to click Add Channel in the desired order for each channel to be opened, 
deactivate Open all input channels and select the channel , i.e. its position in the 
measurement data frame with channel/pos. choose. 
If the metric frame contains more than one metric/channel, a character must be defined to 
separate the values within the frame. With Value Separator, you can select the following: 
comma , 
semicolon ; 
Pipe | 
Space space 
Tab tab 
Other other 

If other is selected, enter the separator under Separator Char . 
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If, in addition to numbers and separators, the measurement value string contains other texts 
or characters that are different from the separator (see example 3), you can activate the 
Filter-Out Non-Numeric checkbox . BlueDAQ then analyzes the measurement strings in more 
detail and filters out unnecessary parts; however, this requires computing time, so that the 
performance of the PC may be weaker. 
The definition of User-defined Device will be used in the Session i.e. it is recommended if 
everything works, Save/Load Session s.S. 14. 
Examples: 
1. In the User Defined Device screenshot shown above, the frame has the prefix % and only 
one metric. This would correspond to the following string: 
%-123.789<CR><LF> 

2. A measured value text looks something like this 
:-2.699876,+0.97575,0.000001,6899.076,6,0,1<CR><LF> 
Then you configure User Defined Device as follows: 

 

3. A measured value text looks something like this 
:ST,NT,+ 1.3 <CR><LF> 
Then configure User Defined Device as follows: 
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Automatic resumption in case of loss of communication connection 
It can happen that the data stream of the measurement data breaks off; The cause can be, 
for example, an interrupted Bluetooth radio connection or an accidentally removed 
communication line. BlueDAQ notices this and displays timeout after 5 seconds in the 
configuration tab : 

If the measurement data rate is less than 2/s, then this time is not 
5s, but 10/ measurement data rate s. The further reaction of the 

program depends on the configuration and whether a measurement was started with Start 
Measuring or not. For the status of the started measurement, BlueDAQ will try to reconnect 
automatically. This behavior can be configured under Menu Bar -> Options -> Hardware -> If 
connection to device is lost:: 

In the initial configuration, the automatic resumption Try to reconnect 
is automatically enabled, it can be disabled with No auto-reconnect. 
If it is activated and the measurement is started, the following 

happens if a strain gage amplifier BSC2, -3, -4, -6 -8 does not transmit any measurement 
data for at least 4.5 seconds: 

1. The disconnection is checked with a read command. If it is successful, only the 
command Start Transmission in order to try to revive the permanent transmission of 
measurement data (see p. 98). If it is not successful, the interface connection is 
closed first. This is necessary in order to be able to open them again afterwards. If 
more than one strain gage amplifier is open, this will be done with all of them and, if 
necessary, a list of strain gage amplifiers with connection problems will be created. 

2. Now an attempt is made to reopen the strain gage amplifier with connection 
problems. If this is successful, the measurement is continued, if not, this is tried 
again and again at regular intervals of about 1 second. If measurement data is 
recorded during this time (start recording), the missing data can subsequently result 
in inaccurate time stamps. 

If the automatic resumption of the connection is disabled under option>hardware , the user 
will receive the following message after 5 seconds without measurement data and the 
measurement starts: 

The user can then click on Stop, so the measurement and, if 
necessary, the data acquisition will be stopped. You can then 
use the menu bar -> Device -> Close or Remove Channel to 
close and reopen the connection manually (Add Channel / 
Device -> Open). Or you can click on Continue in this message 
and the program will continue to wait for measurement data 
without any other actions. 
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Digital inputs/outputs and threshold switches 
The BSC2 and BSC1 models offer configurable threshold switches, and the BSC4D, BX6 and 
BX8 offer freely configurable digital inputs and outputs that can also be configured as 
threshold switches. A threshold switch is a digital output that is switched on or off when the 
measured value is above or below a threshold value. 
The settings dialog for the digital inputs and outputs can be accessed with the menu bar -> 
Device -> Advanced Settings -> Digital I/O 
On the BSC4D, BX6 and BX8, several soft LEDs are displayed on the right under DIO levels, 
which "glow" bright green when the digital I/O is high, i.e. when 5V or 3.3V is present; when 
low =0V is present, they are dark green. The number of soft LEDs displayed corresponds to 
the number of digital I/Os: 12 for the BSC4D, 5 for the BX6 and 16 for the BX8. Only for the I/O 
types QEI input, Sync. Master and Sync. Slave (see below) the states are not displayed or are not reliably 
valid because they change too quickly. 

Actual Level is a soft switch that displays the state of the I/O that is currently selected with 
I/O number. In the case of the I/O type GP output, the level of the digital output can be 
changed with this, see below. The Actual Level and DIO levels controls are well suited to test 
the function of the digital inputs and outputs. 
If the configuration is changed, it can be applied to all digital connections if the Apply to all 
DIOs checkbox is set (provided it is allowed for everyone). As the last step of a change for 
each I/O store to device to be configured , click. 

 

It is useful to first select the digital line whose configuration you want to view or change with 
the I/O number, as some functions are fixed to specific lines. The BSC1 has only one threshold 
switch, here I/O number cannot be changed. The BSC2 has two threshold switches, which can be 
selected with it. 
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Under Terminal name / Pin-No, the name or pin number of the line is displayed, as it is 
mentioned in the user manual, for example. The I/O type shows the function of the line; this 
is also described in more detail in the text output Function. In case of a configuration 
change, it should be set after selecting the I/O number. The following functions are available: 

GP Input: Digital input for general use, e.g. triggered measurement data acquisition as 
from S. 59 described. 
QEI Input (BX8 only): Digital input is assigned for counter function, here Read-Only, i.e. 
this type cannot be set here and cannot be changed if it is set. Instead, the counter 
input can be changed in the Counter/Frequency dialog, see S. 
Tare Single: Digital input to perform zeroing on a single input channel, which can be 
selected with input channel to set zero. 
Tara All : Digital input to perform zero matching of all input channels 
Reset Digital Out: (BX6 & BX8 only) digital input that puts all digital IOs configured as 
output into the power-on state that can be defined with Default output level. 
Reset Max/Min: (BX6 & BX8 only) Digital input that can be used to reset the maximum 
and minimum value determination. In the case of the BX8, this only makes sense if it 
is activated in the Value Mode tab under Acquire maximum and minimum. 
Trigger Send value (BSC4D & BX8 only): Digital input with which the transmission of 
one or more measured values via the USB and UART interface is triggered, provided 
that the permanent measurement data transmission is deactivated (see p.98). The 
type of reading and other details are displayed on the BX8 with Triggered value 
sending Mode set; with the following choices: 

Actual Values: Triggering the sending of a measurement frame with current readings 
via the interface(s) to the inactive-to-active edge of the digital input. 
Maximum Values: At the inactive-to-active edge on the digital input, the maximum 
value determination (all input channels) is started and at the active-to-inactive edge, a 
frame with these maximum values is sent to the interface(s). 
Minimum Values: At inactive-to-active edge on the digital input, the minimum value 
determination (all input channels) is started and at active-to-inactive edge, a frame 
with these minimum values is sent to the interface(s). 
Mean values: At the inactive-to-active edge on the digital input, a decimating 
averaging of all input channels is started and at the active-to-inactive edge, a frame 
with these mean values is sent to the interface(s). 
Send while active: While the input level is active, frames of measured values with 
current readings are sent through the interface(s) at the set data rate. 

GP Output: Digital output for general use (general-purpose); the state can be set with 
other programs or with the software switch Actual Level . 
Threshold Switch: The digital output serves as a threshold switch, see S for details. 
111 
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Sync. Master: The amplifier generates a square wave signal at this digital output, 
which is used to synchronize the transmission of measured values on devices that 
are used as Trigger Sync. slave, see S.14. 
Sync. Slave: Digital input to which a square wave signal should be applied, which is 
used to synchronize the transmission of the measurement data, see p.14. 
Trigger File Log (BX6BT only): Digital input on which the recording of measurement 
data files on SD card can be triggered, so that measurement data is logged while the 
active level is applied, s.S.33. 

Threshold switch 
The threshold encoder compares the measured value with two configurable threshold 
values, an upper (ON-Threshold, or an upper threshold). Upper Threshold) and a lower (OFF-
and Lower Threshold). Depending on the result of the comparison and depending on the 
mode, the digital output is enabled, deactivated or the previous state is left unchanged. With 
Threshold switch Mode, you can choose from up to four different modes. Depending on the 
device model, not all of them are available, i.e. entries may be grayed out. 

Hysteresis switch (normal): The threshold transmitter with hysteresis distinguishes 
three cases and behaves as follows: 

• If the reading "MW" (or maximum or minimum value) is greater than the upper 
threshold value "SWo" (ON Threshold), the output is activated, i.e. if MW>SWo: 
out,new=active 

• If the reading (or maximum or minimum value) is less than the lower threshold 
value "SWu" (OFF Threshold), the output is disabled, i.e. if MW<SWo: 
out,new=inactive 

• If the measured value (or maximum or minimum value) is between the two 
thresholds, i.e. in the hysteresis range, the digital output remains unchanged, 
i.e. if MW<SWo || MW>SWu: out,new=out,old. This avoids, for example, the output 
quickly switching back and forth when the reading is rushing around the 
threshold value. 

 
 
 
 
 
 
 
 
 
 
 

Threshold switch with hysteresis 

http://www.interfaceforce.com/


7418 East Helm Drive • Scottsdale, Arizona 85260 • 480.948.5555 • www.interfaceforce.com 

112 

 

 

Window Comparator: (BSC2, BSC1, BX6 and BX8) The threshold sensor works as a 
window comparator, i.e. two cases are distinguished: 

• If the reading (or maximum or minimum value) is greater than the upper 
threshold or less than the lower threshold, the output is disabled, i.e. if 
MW>SWo || MW<SWu: out,new=inactive 

• If the measured value (or maximum or minimum value) is between the two 
thresholds, i.e. within the "window", the output is activated, i.e. if MW<SWo && 
MW>SWu: out,new=active. 

 
 
 
 
 
 
 
 
 
 
 
 

Window Comparator 

 
Bipolar hysteresis switch: (BSC2, BX6 and BX8) Bipolar threshold sensor with 
hysteresis: This mode is similar to the hysteresis switch (normal), but the 
functionality is additionally "mirrored" in the negative range, i.e. it behaves as follows: 

• If the reading (or maximum or minimum value) is greater than the upper 
threshold (ON Threshold) or less than the negated upper threshold, the output 
is activated, i.e. if MW>SWo || MW<(-SWo): out,new=active 

• If the reading (or maximum or minimum value) is less than the OFF threshold 
or greater than the negated lower threshold, the output is disabled, i.e. if 
MW<SWu || MW>(-SWu): out,new=inactive 
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Bipolar Hysteresis 
Threshold Switch 

• If the reading (or maximum or minimum value) between the two thresholds is 
in the positive or negative range, i.e. in one of the two hysteresis ranges, the 
digital output remains unchanged. I.e. if (MW<SWo && MW>SWu) || (MW>(-SWo) 
&& MW<(-SWu)): out,new=out,old. 

 
Bipolar window comparator: (BX6 and BX8) Bipolar window comparator: This mode is 
similar to the window comparator, but the functionality is additionally "mirrored" in the 
negative area, i.e. it behaves as follows: 

• If the reading (or maximum or minimum value) is greater than the upper 
threshold or less than the lower threshold or less than the negated upper 
threshold or greater than the negated lower threshold, the output is disabled, 
i.e. if MW>SWo || MW<SWu || MW<(-SWo) || MW>(-SWu): out,new=inactive. 

• If the reading (or maximum or minimum value) between the two thresholds is 
in positive or negative range, i.e. within one of the two "windows", the output is 
activated, i.e. if (MW<SWo && MW>SWu) || (MW>(-SWo) && MW<(-SWu)): 
out,new=active. 
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Bipolar Window 

Comparator 

 
The Threshold compared with selector can be used to select whether the actual value, 
maximum value, or minimum value should be compared with the thresholds. If maximum or 
minimum value is selected, you have to make sure that the BX8 ticks the checkbox  Acquire 
maximum and minimum is set under the menu bar -> Device -> Advanced Settings > Value 
Mode → Maximum / Minimum values, so that the BX8 actually carries out the maximum and 
minimum value determination. 
The threshold values themselves are divided into ON-Threshold and ON-Threshold values. 
Upper Threshold for the upper threshold and in Off-Threshold or Lower threshold is entered 
in the unit in which the input channel to be compared is configured. With the BSC4D there 
are only 8 threshold pairs available, which are assigned with threshold number, they are also 
assigned to the input channels, see below. 
With Input channel to react on In the case of the BX6 and BX8, the input channel is selected 
for the measurement/max/min value to be compared with the two threshold values. In the 
BX8, numbers 1 to 8 are analog input channels and 9 and 10 are counter channels. This 
selection is possible for the BX8 regardless of whether the channel is selected in the setting 
of the number of channels in the data frame (s.p.101) is present or not; However, counters 
should only be selected if they are configured. In the case of the BX6, on the other hand, the 
channel to be compared must also be present in the frame; here are 1 to 6 analog input 
channels and No. 7 is the counter channel on the BX6BT. 
In the BSC4D, the input channel that is compared to the threshold values is selected with the 
threshold number, where Nos. 1 and 2 are assigned to the input channel 1, Nos. 3 and 4 to 
channel 2, Nos. 5 and 6 to channel 3, and Nos. 7 and 8 to the input channel 4. 

Active/Inactive Level, Inversion 

In the description of the functions of the Digital IOs, the terms "active" and "inactive" are 
used. In the case of the BSC2, BSC1, BSC4D and the BX6 and BX8 in the delivery state (Not 
inverted) they mean the following: 
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Active: High, i.e. 5V (or BX6: 3.3V)Inactive: Low, i.e 
. 0V 
With the BX6 and BX8, this mapping can be reversed, i.e. inverted, for most digital I/O types 
with line inverted. If this radio button is set to Inverted, it means:Active: Low, i.e. 0V 
Inactive: High, i.e. 5V (or BX6: 3.3V) 
The following I/O types can be inverted: Tara 
Single, Tara All, Reset Digital Out, Reset Max/Min, Trigger Send value, Threshold Switch, 
Trigger File Log. 

Default Digital Output Level 
In the case of the BX6 and BX8, digital IOs configured to one of the output types can be 
specified which level should be applied after the device has been switched on, if the output 
has not yet been set elsewhere, e.g. by the threshold switch or, in the case of GP output, by 
the user. This is set under Default output level. The inversion setting with Line inverted is 
irrelevant, i.e. the default output level is either Low (0V) or High (5V/3.3V). 

Analog output on the BX8 
The BX8 offers eight configurable analog outputs, which can be configured under Menu Bar 
-> Device -> Advanced Settings -> Analog Out. 

 

 
With Output Channel , you first select one of the 8 analog outputs whose configuration you 
want to view or change. 
Analog output type is the type of analog output that specifies the output current or voltage 
and the range of values. The following types are available: 
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Voltage 0 .. 10V: Voltage output, unipolar from 0 to 10V. 
Zero point: 0V (if user offset =0) 
Saturation: negative: -0.5V, positive: 10.5V 
Voltage -10 .. +10V: Voltage output, bipolar from -10 to 10V. 
Zero point: 0V (if user offset =0) 
Saturation: negative: -10.5V, positive: 10.5V 
Default type of manufacturer setting 
Voltage 0 .. 5V: Voltage output, unipolar from 0 to 5V. 
Zero point: 0V (if user offset =0) 
Saturation: negative: -0.25V, positive: 5.25V 
Voltage -5 .. 5V: Voltage output, bipolar from -5 to 5V. 
Zero point: 0V (when user offset =0) 
Saturation: negative: -5.25V, positive: 5.25V 
Current 4.. 20mA: Current output, unipolar from 4 to 20mAZero point: 4 mA (when user 
offset =0) 
Saturation: negative: 3.2mA positive: 20.8 mA 

 
Current 0 .. 20mA: Current output, unipolar from 0 to 20mA Zero point: 0 mA (when 
user offset =0) 
Saturation: negative: 0 mA positive: 21 mA 

 
The zero point at the analog output can be changed by user offset, so that even unipolar 
types can be measured bipolarly, i.e. positive and negative numerical or measured values 
can be displayed analogously. The user offset can be entered either as a percentage of the 
output range (%) or in volts (V) or mA, for this unit must be selected with the pull-down 
menu next to it. 
For example, if the analog output type is voltage 0 .. 10V and user offset is set to 50% or 5V, 
the ranges change as follows: 

Voltage 0 .. 10V: Voltage output, bipolar from 0 to 10V. Zero point: 5V 
(when user offset =50%) 
Saturation: negative: -0.5V, positive: 10.5V 

In order for the negative full gain to be displayed by 0V and the positive by 10V, the user 
scaling factor must be =0.5. User offset and user scaling factor only affect the analog 
output and are not to be confused with user scaling and user offset, which are operated in 
the main window (Configuration tab). 
These results can be read after each change of the inputs by the output in Transfer 
characteristic (Transfer function). In this case, the positive and negative full control value of 
the User Scale or, if the six-axis sensor is activated, its maximum value. The User scale In the 
case of general sensors, this usually does not correspond to the nominal value of the 
connected sensor, see p. 8. With the above example, the following can result: 
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The positive full output of 1590.91 results in 10V at the output. 
To be able to measure bipolar, set the user offset to 50% or 5V, the user scaling factor is 
then automatically set to 0.5: 

 

The digital value =0 (Zero value at input) now results in 5V at the output, the negative full gain 
results in 0V at the output. 

In this example, the input value Value at input of 1590.91 N is obtained from a 1000 N force 
sensor with the following data: 

 

 

Here: (1590.91/1000) * 0.5 = 0.795455 

Often you want the nominal value of the sensor 
to correspond to the full gain on the analog 
output and not the input full drive. In this case, 
that would be: 
1000 N => 10V-1000 N => 0V 

 
So you convert the user scaling factor manually: 
New user scaling factor = (full level/sensor 
rating) x old user scaling factor 
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Analog Output Mode 
By default, the analog output follows the sensor signal of the corresponding input channel, 
i.e. input 1 -> output 1, etc. However, this assignment can be changed by analog output 
mode. 
You can do this in the following ways: 

Active, follows analog input: The analog output follows the reading of the 
corresponding input channel; Default mode of the manufacturer's settings. 
Active, follows Counter Input: The analog output follows the measured value of the 
counter or frequency measurement. This setting is only possible on output channels 
7 and 8 and the counter/frequency measurement itself should be configured as from 
S. 120 described. Output channel 7 corresponds to the first counter channel and 
output channel 8 to the second; If only one meter channel is configured, output no. 7 
is used. 
Input independent, write direct only: The analog output is separated from the input and 
can only be set by the software's write command. This is useful, among other things, 
for testing the output. To do this, first select this mode and then click on Store to 
device. Afterwards you can go to Output Voltage or Output Current, use the slider or 
numeric number input to set the voltage or current, and then click Write Value / Set. 
Then this value should be output, regardless of user offset and user scaling factor. 

 

 
Active, Software Input: The analog output is separated from the input and is described 
by BlueDAQ at the measurement runtime. This setting is only available with BlueDAQ 
PRO and is explained in more detail below. 
Channel off: The analog output is disabled. 
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Analog output of software channels 
With BlueDAQ PRO it is possible to output any channel continuously to the analog output. 
This is particularly useful when it comes to software-calculated channels, e.g. math 
channels or software-calculated multi-axis sensors (see p. 39). Math channels are channels 
that display the results of a user-defined computational rule (MathScript) issue; they are 
described in detail in a separate manual. 
If this analog output mode is selected, you have to use the Software Input Channel selection 
element to select the source channel, i.e. it must already be integrated at the time of 
configuration. Only displayed channels can be selected, not hidden ones (i.e. not those that 
have been hidden with menu bar -> Channel -> Hide). 
If you then Store to device clicks, in the BX8 the Input independent, write direct only mode and 
the information about the analog output via software is stored by BlueDAQ in its 
configuration file. It makes sense to store the entire channel configuration in a Session file, 
see S. 14 
The analog output settings User offset and User scaling factor are also taken into account 
for the calculation of the software-generated analog output, but Transfer characteristic 
cannot display any meaningful values with them (see above). 
The analogue output only takes place during the measurement runtime, i.e. after clicking on 
Start Measuring. 
The update rate of the software analog output follows the measurement data rate if it is less 
than 1000/s. Otherwise, it tries to output a value every millisecond. However, the refresh rate 
may be limited by the load and performance of the PC. Also, the temporal equidistance of 
the samples of the output DAC is not necessarily given, i.e. it can happen that a little more 
time passes between two updates than usual. 
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Counter and frequency measurement with BX6BT and BX8 
With the BX6BT and the BX8 you have the possibility to evaluate the signal from digital pulse 
generators and to configure one (or in the case of the BX8 two) additional measurement 
channels. The pulse generator can be an incremental encoder with A/B track or a simple 
optical or magnetic switch. Depending on the sensor, arrangement and device configuration, 
variables such as position, angle of rotation or displacement as well as speed, frequency or 
speed can be measured. Detailed descriptions are available for both devices in the form of 
separate operating instructions, the connection assignment can be found in the general 
operating instructions. The configuration dialog is opened via Menu Bar -> Device -> 
Advanced Settings -> Value Mode by clicking on Counter/Frequency/Speed Open Dialogue. In 
the lower area you can control User Scale, User Offset and the Unit unit ; these settings 

correspond to those in the main 
configuration window. In addition 
to Measurable Value Range, the 
measurable range of values from 
(From) to (To) is displayed, which 
is also updated based on user 
input. 
With the BX8, up to two sensors 
with pulse output can be 
connected, which can then be 
connected with Counter No. If 
only one is used, it must be 
number 1. Function describes the 
basic function: 
Disabled: The meter input is 
turned off and the meter channel 
does not exist. 

Counter / Position / Angle: The counter input is configured as a counter, i.e. pulses or 
pulse sequences are counted as integers. More details below. 
Frequency/Speed: The counter is used to measure frequency. This setting is suitable 
for measuring speed, frequency or speed, for example. More details below. 
Both Counter and Frequency (BX8 only): From meter input 1, both the meter reading 
and the frequency are calculated and output in two additional channels. The 
operation/ display User Scale, User Offset, the unit unit and the display of the value 
range is switched with Show/Store values for. 

Under Hardware and Input Mode, settings are defined, which can be selected on the basis of 
the connected heart rate sensor, among other things. The Input Mode determines the type 
of pulse evaluation, they may depend on the type of pulse evaluation. with other modes 
Function and Method, see there. 
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Non-QEI: A=freq, B=dir: The QEI encoder evaluation is disabled, a 
square wave signal is expected at input A. Input B determines the 
counting direction (or the sign in the case of frequency 
measurement): High = left open: Forward. Low = Set to ground: 
Backwards. This mode can be applied to all measurement types 
and methods. 
QEI input x1: In the case of a complete quadrature cycle (see 
figure), a count is carried forward or backward by 1; the counting 
direction results from the forward or lagging of the A- to the B 
signal: A-pulse first: forward, B first: backward. This mode has 
the highest coverage of false signal suppression. 
QEI input x2: For a complete quadrature cycle (see figure) it is 
counted forward or backward by 2 and for a half cycle by 1. The 
counting direction always results from the forward or lagging of 
the A- compared to the B-signal. 
QEI input x4: For a complete quadrature cycle (see picture) it is 
counted forward or backward by 4 and for 1/4 cycle by 1. 

 
 
 

Under Hardware you can set the BX8 as follows: 
Use Pull-Up: If this checkbox is set, there are pull-up resistors at the QEI/meter inputs. 
This setting is necessary if the connected pulse sensor only switches between the 
states 'open' = high impedance and 'closed' = connected to GND (so-called open-drain 
output). In this way, encoders with an operating voltage different from 5V may also 
be used. If, on the other hand, it is a 5V push-pull output, you can omit use pull-up. 
Input filter: The evaluation hardware offers an input filter that can suppress very short 
interference pulses; however, the maximum frequency of the inputs is reduced to 
200kHz in all modes and the measurement accuracy for period duration 
measurement is also somewhat degraded (see ba-bx8-incremental-encoder.pdf). 

Meter Measurement 
For measurements as counters, the Function selection is set to Counter / Position / Angle. 
This setting is suitable, for example, for measuring position, angle of rotation or 
displacement. It can be counted forward and backward, see description of the Input Mode, 
which are all available here. User Scale and User Offset are used to convert the meter 
reading to the quantity of interest, so the final result can also be non-integer. The counter 
can be set to 0 with Set Zero, just like any analog reading . The following options are 
available: 

http://www.interfaceforce.com/


7418 East Helm Drive • Scottsdale, Arizona 85260 • 480.948.5555 • www.interfaceforce.com 

122 

 

 

Store value at power-off: When the device is switched off, the 
current meter value is saved and restored the next time it is 
switched on. This is useful, for example, for absolute 
displacement measurements; however, care must then be 
taken to ensure that the displacement sensor is never moved 

when the device is switched off. 
Saturate to numeric limits: The count is saturated when the maximum is exceeded 
and the minimum is not reached; This saturation value depends on the set integer 
measured value data type (see p.101) and is 10 million for the float type. When the 
counting direction is reversed and it returns to the representable value range, the 
saturation state is automatically reset. BX8: When saturation is off, the counter overflows, i.e. 
from high positive or negative values to zero, and when the internal 32-bit counter overflows, from high 
positives to negative values and vice versa. BX6: When the saturation is off, the counter overflows, i.e. 
from high positive to negative values in the forward direction and vice versa in the reverse direction. 

Use Home / Index input: In addition to the necessary connections A, B and GND, the QEI 
decoder offers an additional input Home/Index. With this option it is used and if the 
input is then active, the counter value is set to a predefined value, which you enter 
under Home / Index start value. In many cases, 0 is used, so a pulse at the 
home/index input resets the counter. 
Home/Index inverted (BX8 only): If Use Home / Index input is set, you can use it to set 
the active level: Checkbox set: Active=Low; not set: Active=High. On the BX6, the 
Home/Index input is inverted by default. 

Frequency / RPM / Speed by Count 
Here, the difference between 2 meter readings within a measurement data period is 
evaluated. The frequency to be measured must therefore be higher than the measurement 
data rate. 
The different input modes are all available. The counting frequency measurement mode is 
suitable for measuring rather high frequencies at a relatively low data rate, e.g. those 
supplied by an encoder with many pulses per revolution. Method under Frequency / Speed is 
set to Counting Pulses in this mode. In this mode, the basic unit, i.e. the evaluation of the 
measured values with user scale = 1, is Hz, i.e. /s. 
Gate time 
In order for the frequency (or speed/speed) to be displayed correctly, the raw meter value 
must have changed as often as possible within a data period, i.e. the difference in amount of 
a new meter value to the previous one must be >=1. 
The measurement data rate is the same for all channels, i.e. it also applies to the evaluation 
of the meter. In order to be able to measure relatively low speeds/frequencies at rather high 
data rates, it is possible to increase the data period for frequency measurement. This is 
done with the help of an (integer) data period multiplier, the gate-time counter. The gate time, 
which consists of the gate time counter and the measurement data rate, is also displayed 
and operable, which indicates the gate time in seconds. 
The minimum frequency that can be measured is thus calculated as: 
fmin = Data Rate / Gate-Time-Counter [Hz] 
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Frequency / speed / velocity by period duration measurement 

Here, the period duration of arbitrary square wave signals is measured directly. 
This mode is particularly suitable for speed measurement where only a few 
pulses (e.g. 1 pulse per revolution) are generated per revolution, e.g. by a 
magnetic switch moving relative to a magnet on the rotation circuit. 

BX8: The quadrature encoder mode is irrelevant here; it always evaluates 
the time between one edge at input A and the next at input B. If the QEI 
evaluation is off (Non-QEI: A=freq, B=dir), the period duration of a square 
wave signal is measured at input A and B determines the direction of 
rotation. In this measurement mode, the accuracy and range of values of 
the measurement are independent of the measurement data rate and the 
QEI decoder mode. 
BX6BT: In this case, the BX6BT switches on an oscillator with f=1MHz at 
input A and the measurement input is input I ("index"). The input mode is 
therefore set to Non-QEI: A=freq, B=dir, i.e. the rotary encoder A/B input is 
not available. Input A must be left open, otherwise the device could be 
damaged! 
Input B determines the sign of the measured value or the direction of 
rotation; If it is left open (=high), it is always positive. 
The measurement data rate in this period duration mode must be 
significantly greater than the maximum frequency to be measured, and 
at least 3 times higher than this. 

In both devices, the gate-time counter has a different meaning in this mode: it determines 
the time after which the measured value is set to zero when there are no more pulses at the 
measurement input. At the same time, this requires the measurable minimum. 
Even in the period duration mode, the basic unit, i.e. the evaluation of the measured values 
with user scale =1, is Hz, i.e. /s. 
BX8: Frequency / Speed Measurement with Auto-Period Mode 
When the Method measurement method is set to auto-period mode, the BX8 automatically 
decides whether to use the counting method or the period duration measurement based on 
the measured frequency. If the counter value is less than 2000 per period of the 
measurement data rate, the period duration measurement is used, otherwise the counting 
method. The threshold value, for example, is 20 kHz at the default measurement data rate of 
10 frames/s. In this way, the measurement uncertainty can be kept below 0.05% v.s. over 
the entire measuring range. 
Gate time is not used in this mode, nor does QEI input mode have any effect. 
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Examples of setting User Scale to fit specific encoders: 
Example 1: With a rotary encoder, the speed is to be measured in revolutions per minute 
(unit rpm). The encoder delivers 360 complete quadrature cycles per revolution. The input 
mode is QEI input x1. Then User Scale is set to the following value: 60 rpm / 360 = 1/6 = 
0.1666667 rpm. 

 
Example 2: With the same encoder, you want to display RPM = rpm, but the input mode is 
QEI input x4. Then you set User Scale to the following value: 
60 rpm / (360*4) = 1/24 = 0.041666667 rpm. 

 
 
 
 

Example 3: With a magnetic linear encoder 
and BX8, position in mm and speed in m/s 
should be displayed at the same time. It 
delivers 4 complete quadrature cycles per 
mm. For example, you can configure it like 
this: 
The first measurement channel is the 
Counter, User Scaling = 1/(4*4 ), the second 
is Speed, User Scaling = 1/(4*4*1000) 

 
 
 

 
When the counter/frequency measurement is configured, a new channel is created in the 
device, which can be opened as on S. 13 described. 

Learn more about device administration 
In the following, previously uncovered settings and information are described, which can be 
accessed in the menu bar → Device → Advanced Settings → Administration. 

Fault memory of the BX8 
The BX8 has an error memory, which mainly stores faults caused by an incorrect connection 
or a faulty sensor. Up to 81 errors are saved. They can be viewed by clicking on Fault 
Memory / Open Dialogue : 

http://www.interfaceforce.com/


7418 East Helm Drive • Scottsdale, Arizona 85260 • 480.948.5555 • www.interfaceforce.com 
125 

 

 

Clicking on them will highlight the 
entries and show details of this error 
at the bottom under Details.No/age is 
the number of the entry, starting with 
the most recent. Under Occurred at 
working hours, the operating time 
(the time of the operating hours 
counter, s.S.) at which the error 
occurred, is displayed in the format 
Hours:Minutes. Fault type no / Kind of 
fault specifies the type of fault and 
can contain the following entries: 
1: Sensor input saturation: One sensor 

input was saturated, i.e. the measuring range was exceeded. Under Details, input 
channel(s) identifies the input channel(s) where the error occurred. Possible causes: 

• Defective sensor 

• Overloaded sensor 

• Defective sensor cable 

• Incorrect sensor connection 

• Input type selected incorrectly, i.e. input measuring range too small 
2: Sensor maximum exceedance: A multi-axis sensor exceeded the maximum stored 
for that sensor. Under Details is used with physical channel(s) the input channel(s) 
where the error occurred. It may have the same causes as (1), in addition, incorrect 
sensor calibration data may have been loaded, see p. 39 
3: Sensor or sensor connection broken: An incorrect common-mode voltage at Ud+ or 
Ud- was detected at a bridge input. Under Details, input channel(s) is used to indicate 
the input channel(s) where the error occurred, and the line Ud+ / Ud- is also 
mentioned. Possible causes: 

• Defective sensor 

• Incorrect sensor connection 

• Defective sensor cable: short circuit or line open 
4: Analog output: wrong connection: Fault at the connection of an analog output. 
Possible cause is an open current output or an overheated output driver, e.g. due to a 
short circuit of a voltage output. An unconnected current output (open current output) 
is interpreted as an error, the output channel is mentioned under details (... at 
channel...) 
5: Digital output: Wrong connection: Short circuit on a digital output (DIO no), which is 
mentioned in details. The cause can also be that an output has been connected to a 
DIO configured as an output (level collision) 
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Flags (hex) are information about channel or I/O numbers that are defined differently for each error 
number and documented in the log description. 

With Save to File, the error memory content can be exported to a text file, which has the 
name FaultMemory.log by default. It contains a header that specifies, among other things, 
the current operating hours (device working hours) and a line for each entry. For example, the 
error memory shown above yields the following file header and the first line: 
Fault memory saved from BX8 Ser.No: 16256044 Date: Wed, Jan 24, 2024 Time: 19:59 Device working hours: 4895:5 

No/age Fault type no / Kind of fault Occurred at working hours [H:MM] Flags (Hex) Details 
1 2: Sensor maximum exceedance 4231: 9 8 663:56 before now, a multidimensional sensor maximum exceedance occurred. at physical channels: 4 

With Erase Fault Memory , the error memory can be erased by asking for the device 
password. The deletion cannot be undone! 
By clicking on Refresh, errors that may have occurred can be reloaded. The BX8 stores new 
errors in a time interval of at least two minutes. 
The log file of the error store is also part of the Settings ArchiveS. 25. 

Hour meter of the BX8 and BX6BT 
The BX8 and BX6BT have hour meter that counts the time the device is turned on. They 
appear in the Administrator tab under Device working hours. There are two counters: an 
absolute one that cannot be reset (Total device working hours) and one that can be set to 0 

by the user, e.g. to check the duration of a specific measurement 
campaign. It is called User device working hours and is set to 0 by clicking 
on Reset user device working hours / Clear. 

 
 

BSC2 Menu Language 
For BSC2 amplifiers with keyboard and LCD menu, you can set the language of 
the device menu under Menu language of device (English or German = German). 

 
 

Drift compensation with BSC2 
Most sensors drift due to temperature changes. For some, this is well compensated, for 
others, such as strain indicators and individual strain gages, this is not always possible. For 
such cases, the BSC2 offers a drift compensation algorithm that compares the transient of 
the measured value (i.e. its temporal change/derivation) with a predefined threshold. 
Readings that change more slowly than this transient threshold are not output by the BSC2, 
but are stored internally. Measured values that change faster than this transient threshold 
are output, and the difference to the stored ("drifted") measured value is formed. 
It is therefore crucial for the applicability of this drift compensation that the measured 
values of interest (the useful signal) immediately follow a rather rapid change. 
You can access the Drift Compensation configuration dialog by clicking on the Drift 
Compensation button at the bottom right of the menu bar -> Device -> Advanced Settings -> 
Value Mode. 
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Configuration for drift compensation, 

measurement data rate here 5/s 

The transient threshold is given under Threshold for Value Transient in Slope in <unit> per 
200ms for a constant time interval of 200ms. If the measurement data rate is less than 5 /s, 

the transient is also specified under Slope per Data Period 
(<1/Measurement Data Rate>) ms per measurement data 
period, because this is then less than 200ms. In the picture 
on the left e.g. for 3 /s. 
Multiplying the slope per 200ms by 5 gives the change per 

second. 
You activate drift compensation with Drift Compensation enabled. The measured value is 
then only output after a valid useful signal change, i.e. if the measured value changed faster 
than the transient threshold value. In addition, you can define a waiting period within which 
even rapid changes (e.g. vibrations) are ignored after a valid measured value. This is 
displayed under Wait Time in seconds; Wait Counter is a counter of this time at 200ms 
intervals. After detecting a valid reading, this time is waited until the current transient is 
compared with the transient threshold as described above. 
Low measurement data frequencies <50/s are recommended for the use of drift 
compensation. 
A typical application is an elongation indicator on a metallic pillar supporting a crane. The 
load lifted and dropped by the crane is to be measured. The pillar is subject to temperature 
fluctuations, which are noticeable as drift in the signal of the strain indicator. The pick-up 
and release of the load is much faster than the temperature drift, as long as the load does 
not fall below a certain minimum. First, test measurements without drift compensation are 
made in order to determine the useful signal transients and the optimal measurement data 
rate (s.p. 16, but you don't need a very high rate when testing here; approx. 10 Hz) and 
records them. In this example, the test measurements should include the recording and 
specification of minimum and maximum loads and, if necessary, different travel speeds. 
From the recording of the measurement, one can then determine the transient threshold 
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value and, if necessary, the waiting time (the latter e.g. from the time of oscillation due to the 
load change) in order to configure the drift compensation. Subsequently, further tests with 
compensation activated are recommended. Drift compensation can increase the 
measurement uncertainty somewhat. 

 
 
Other Software Preferences 
Here, previously uncovered settings are explained under Menu Bar -> Options -> Preferences 
and ->Default Settings. 

In the initial configuration, when the measurement is started, the user is asked if he wants 
to record it. This question can be suppressed by activating the checkbox Don't ask anymore 
and always perform selected action for this message : 

Depending on whether Yes for Record or No for Not Record is 
clicked, this will apply to any future click on Start Measuring. 
This behavior can also be configured in Menu Bar -> Options -> 
Preferences -> At Start Measuring: 

If the Ask for recording the measuring data checkbox is not 
set, the question about recording is not asked at Start Measuring. Then you 
can go to If not, do you always want to record the data? Specify whether 
Start Measuring always records automatically (Yes) or not (No). 

 
 
 

By the Closing the program the user is asked if he wants to save a session file if something 
has changed that is relevant to the session file (e.g. channels have been added or removed), 

see S. 14. 
You can suppress this question by activating the 
checkbox Don't ask anymore and always perform 
selected action in this message . Depending on 
whether Yes for Save or No for Don't Save is clicked, 
this applies to any future program exit, but in any case 
it will only be saved if relevant information has been 

changed. With automatic session saving, a file selection box opens at completion, in which 
the last session file is pre-selected. This behavior can also be configured in Menu Bar -> 
Options -> Preferences -> When closing the program: 

If the checkbox Ask for saving the session, if session data has changed is 
not set, the question of saving when the program is terminated will not 
be asked. Then you can go to If not, do you always want to save the 
session? Specify whether to save after each relevant change (Yes) or 
never automatically (No). 
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If several strain gage amplifiers are integrated and they have different measurement data 
frequencies (which is not recommended), the user will be warned if the difference is greater 
than 5 when clicking on the Recorder Yt or XY tab: 

If you activate the checkbox Don't show this warning again, this 
warning will no longer be displayed. This can also be configured 
with a checkbox under Menu Bar -> Options -> Preferences with 
Warn if device data rates are different. 

 

 
Other settings in Options->Preferences concerning the XY 

recorder (p. 58), the Single Value Display (p. 30), the number of decimal places of measured 
values displayed (p. 32) and the time interval of reading measurement data from the 
amplifiers (p. 32). 
Under Menu Bar -> Options -> Default Settings you can reset to the basic settings of the 
software. 

If you click Yt / XY recorder: Reset Graph Scaling, currently (up to and 
including version 2.1) only the scales of both axes of the XY recorder 
and the Y-axis of the Yt recorder are reset. When you enter the 
corresponding index card, this comes into effect. 
If you click Reset all program settings to default values, all software 
settings will be reset to the state they were in after installing BlueDAQ. 

To do this, a query must be confirmed (Are you sure to reset the program settings?) and you 
will then be informed that the reset will only take effect after a restart of the program. The 
reset does not affect the settings of the amplifier hardware, but it cannot be undone. 

 
 

 
Tools for Measurement Data Files TDMS Tools 
The standard format for measurement data files, *.tdms, has been mentioned several times, e.g. S. 
33. The -> File -> TDMS Tools menu bar opens a selection of different tools that can be used 
to perform special tasks and repairs on measurement data files. 

 

With Try to Fix File / Repair you can try to repair a broken tdms measurement data file. There is no 
guarantee that this will succeed and it is also possible that parts of the data will be lost, but the rest 
will become readable again. Such a defective file can occur, for example, if the PC crashes during a 
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recording or if there was a power failure or BlueDAQ has been closed irregularly (e.g. by the Windows 
Task Manager). When trying to open such a file using the File Monitor, an error message appears. 
After clicking on Try to Fix File / Repair, select the broken tdms file, it will then be saved under a 
different name, namely appending _fixed to the original file name. 
Make Compatible / Fix Group Name makes a *.tdms file created by another program compatible with 
BlueDAQ so that it can be opened with the File Monitor. In tdms files, the channels are always 
assigned to groups and BlueDAQ expects a group named Measuring values. After clicking on Make 
Compatible / Fix Group Name, select the file you want to change. The first group of the file is 
renamed after confirmation by the user and its channels can then be viewed in the File Monitor, as 
long as they are regular measurement data. Attention: BlueDAQ does not rename this file up to and 
including version 2.1, but only changes it. Therefore, it is recommended that you manually rename 
the file before using Fix Group Name. As of version 2.2, _changed will be appended to the original 
filename. 
Defragmentation/Defragment is used to defragment tdms files. This can be useful for very large files, 
because they can have some redundant entries, such as properties. 

Assembling Master-Slave Files from BX6BT 
The BX6BT supports the S. 14 hardware synchronization described. The recording of 
measurement data on the SD card (see p. 33) cannot, however, be synchronized in a trivial 
way for various reasons. The recording can and should be started via a hardware switch by 
configuring the digital input not used for master-slave (see p. 109Type: Trigger File Log) and 
is wired, but the timing of when the recording will actually begin is somewhat uncertain. 
However, the BX6BT supports a mechanism to mark two lines about 0.2 to 0.4 seconds 
after the start of recording a file in the master and slave devices at the same time. The 
master writes an M at the end of this line and the slave an S. 
For example: 
22/04/01,17:43:27.46500 -0.00423 2.10000 2.10000 -2.10000 -2.10000 -2.10000 19964.02930 M 

22/04/01,17:42:27.18348 -0.00410 2.10000 2.10000 -2.10000 -2.10000 -2.10000 32014.39063 S 

In this example, the two RTC clocks had a time difference of about 1 minute. You can minimize the 
time difference a bit by changing the RTCs of both BX6BT by clicking on Sync. as from S. 33 
described, but they will still diverge somewhat. 

To merge these two files, first click on Merge and import Master/Slave txt files / Concatenate 
in the TDMS File Tools and the following dialog will open: 
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With Add File, you select the files that belong together one after the other. One should be 
that of a master, which you can see by the X in the Master column . Then click on Merge 
files and select the destination directory for the measured value file in text format, which 
then contains all channels of both devices in adjacent columns and is time-composed. If 
necessary, measured values are omitted at the beginning and at the end in order to equalize 
the number of measurement lines. Then you can choose whether you want to convert this 
file to another one in tdms format. The channels of the master form the first columns, those 
of the slaves the others, whose channel names _1 and possibly _2 and so on are appended: 

 
 

 
 
Troubleshooting 
The following describes common problems, error messages, and possible solutions. Further 
tips can be found on the Me website, e.g. in the Knowledge base. 
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1. The device cannot be opened with Add Channel 
In order to be able to open a device successfully, three pieces of information should be 
known and entered correctly: 

• The device model, e.g. BSC2, BX8, BX6 serial or BX6CAN. Some smart sensors have 
a built-in digital amplifier, e.g. a BX6 CAN. The nameplate, data sheet or operating 
instructions should provide information. 

• The COMport number. In many cases, there are only a few 
entries in the pull-down menu COMport Number of the Add 
Channel dialog and you can easily find the right one. Entries in 

angle brackets, as shown here, are probably not correct. In 
rarer cases, the COMport number is known, but not in the list. 
Then you can enter them in the small number input element to 
the right of the pull-down menu. To find out an unknown 
COMport number, you can look in Windows Device Manager: 
click on the Windows icon in the Start bar, type Dev or type 
Device Manager in the search box on the taskbar and then 
open it. 

It can contain entries such as "USB Serial Port", strain gage amplifers 
with USB, or "BX-8 Communication", a BX8. "Serial-over-Bluetooth connection" or similar is 
the COMport of a Bluetooth device. To do this, however, it must already be coupled. If there 
is no serial over BT entry in the device manager, you have to pair the device. To do this, the 
power supply must be connected and it must be nearby, and the PC also needs a Bluetooth 
adapter. Then you can proceed as follows: here , select the Windows version at the top and 
proceed as under "How to pair a [...] other device". If that doesn't work or the strain gage 
amplifier can't be found: Windows 11 needs to set Device Discovery to Advanced be 
provided. To do this, select "Show more devices" in the Bluetooth settings. The assigned 
COMport number can also be seen under "More Bluetooth options", where "Outgoing" is the 
correct port. 

• The baud rate (bit rate). For most serial ports, it must be selected correctly, see S. 95 
If the device fails to be opened, an error message often appears. Here is the breakdown of 
the most common messages: 

• Error 2 occurred ... or: 
Error 536870914 occurred at ... Possible reason(s): OS reported Error 2: Port or file not found. 
Windows returns this error message (File not found), most of the time the COMport 
number is wrong see above. 

• Error 5 occurred ... or: 
Error 536870917: Windows returns this error message (Access denied), usually the 
COMport is already open by another program. 

• Error 121 occurred ... Windows returns this error message. If it's a Bluetooth device , 
the battery could be low or not plugged in. Error messages with the same text but 
different error numbers <2000 can also occur with a BT-COMport. 
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• Error 805306456 occurred ... Possible reason(s): MEGSV86xx.DLL: Command response 
from device timed out. The BX6/BX8 API returns this error message. Or: 
MEGSV4.dll Error: No answer from strain gage amplifier Or: 
Error 805306612 ... Possible reason(s): MEGSV.DLL: Com port could be opened, but no 
strain gage amplifier answered. The BSC2/BSC13 API returns this error message. 
The COMport could be opened, but no strain gage amplifier answered. Possible 
causes: 

◦ The strain gage amplifier is not properly powered 

◦ A USB converter cable (if used) is defective or incorrectly connected on the UART 
or strain gage amplifier side 

◦ An RS232 cable (if used) is defective or incorrectly connected 

◦ The baud rate is incorrect, see above and S. 95 

◦ The baud rate is correct but is not supported by the USB converter (if used) or 
other interface converters or converters or are not configured accordingly (e.g. 
Moxa for Ethernet). 

◦ There is a different strain gage amplifier model connected to the COMport than 
the one set under Device Type, or a completely different device or no device at all 
is connected 

◦ BX8 over UART: The UART interface used in the BX8 is switched off, see S. 95 

2. There are no readings 
This problem also occurs if only one of the strain gage amplifiers is not transmitting any 
readings. BlueDAQ expects a measurement data stream from all open strain gage 
amplifiers. Often, timeout is displayed in the measured value display of the Configuration 
tab.displayed inses: 

• The device is configured as a synchronization slave, see p. 14. If the strain gage 
amplifier is to be operated as a stand-alone device without a master, it should be 
None of the Digital IOs as Sync Slave be configured; If necessary, this should be 
GPinput s. S. 109 
If it is to be operated together with a master, it must be properly configured and 
connected to the slave with a sync line. 

• The permanent transmission of measurement data is switched off, see S. 98 

• The set measurement data rate is too high, see S. 16 

• Communication has been interrupted in the meantime. Tips on how to do this on S. 
108. The cause can be, for example, a disconnected interface cable or a poor BT 
radio connection. 
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3. The measured values run slowly and jerkily in the graphical display 
This is usually just a display problem, i.e. data is only lost in extreme cases and the 
timestamps are correct. Possible causes: 

• The measurement data rate is set unusually low (e.g. 1/s), see p. 16. The BSC2 or 
BSC1 may be set to slow mode. To change, simply increase the measurement data 
rate. 

 
• Driver setting unfavorable. With the following strain gage amplifiers with USB: 

BSC2TSD-DI, BSC1USB, BSC4DUSB or BX6Dev, you can shorten the waiting time of 
the buffer of the FTDI interface driver. To do this, open the Device Manager (see 1.) 
and right-click on the corresponding COMport entry and select "Properties", then 
Connection Settings and click "Advanced". Then set the waiting time to 1ms in the 
following dialog, confirm everything with OK and restart the PC if necessary. 

• The PC is very busy. To find out which program is slowing down your PC, you can 
hold down the Ctrl and Alt keys at the same time, then press Delete and then select 
the Windows Task Manager. In it, open the Processes tab and sort by CPU so that the 
top one shows the highest CPU load. Consider closing this process. If it is 
BlueDAQchannel that requires the high CPU load and perhaps also a lot of RAM, this 
can be normal with many measurement channels and high measurement data rates. 
MathChannels, in particular, can require a lot of power (depending on the 
computational overhead). What can help: 

◦ Avoid opening the Graph Display tab , especially if there are more than 3 channels 
open. The many individual counts in this require more power than the Yt recorder. 
The Configuration tab requires the least amount of power. 

◦ Do not resize a window during the measurement. Window scaling requires 
performance, which is delayed and low-prioritized, but still temporarily takes away 
performance from the measurement task. 

◦ For MathScript: If possible, reduce the complexity of the script, e.g. summarize 
constants and reduce the number of operations. The MathScript parser does not 
perform any optimizations. 

◦ Remove channels you don't need (Remove Channel) or hide, see p. S. 16 

◦ Reduce the measurement data rate, see S. 16 

http://www.interfaceforce.com/


7418 East Helm Drive • Scottsdale, Arizona 85260 • 480.948.5555 • www.interfaceforce.com 
135 

 

 

4. When using multiple strain gage amplifiers, the readings are divergent in 
time. 
Solution: Set the measurement data rate of all devices as equally as possible and, if 
possible, use the master-slave synchronization, see p. 14 

5. Deleting data from a graphical chart 
The recorder Yt stores a history, i.e. "behind" the left edge there is still measurement data 
stored in the graph. This has a constant depth of data packets. If Autoscale X is selected, it 
can happen that data falls out after a certain time; something similar can also happen in 
Recorder XY at high measurement data frequencies or very long recording times. The 
following can help: 

• Increasing the acquisition interval, see S. 32 

• Recording of the measured values (start recording) and subsequent evaluation 
instead of live evaluation 

• In Recorder XY: Use of the trigger function, if possible, see S. 56 

6. Attempting to change a configuration setting in strain gage amplifiers fails 
If you get an error message when trying to change a device setting (yellow control) or if you 
don't read it as expected when you read it again, but it is unchanged, this can have various 
causes. For the BX6 and BX8, one of the following error messages is usually displayed; 
however, the causes and solutions described may also apply to the BSC2 and BSC1: 

• Error 939524213 occurred ... Possible reason(s): Device: Access from this port denied 
(other port seems to have write access): Another interface has the Writing rights and 
the one with which the device has just been opened must not change any operating 
parameters. This other interface can be another serial one (e.g. UART on BX8) or 
CANopen at BSC2 and BX8-CAN or BX8 EtherCAT. With CANopen, you can switch off 
the CAN interface as a remedy (see p. 98 or use a CANopen master program to put 
the device in the stopped state. With EtherCAT, you can restart the BX8 with the 
EtherCAT interface disconnected or put it in the INIT state; in both cases, the green 
LED on the device must be off. 

• Error 939524209 occurred ... Possible reason(s): Device: Access denied, because write 
functions are blocked: The general Write protection is enabled. This state can also be 
activated in BSC2 and BSC1, see p. 28 

• Error 939524183 ... Possible reason(s): Device: Parameter too big in relation to other 
parameters / Settings: The parameter is too large, possibly in relation to other 
parameters. Often when setting the measurement data rate. 

• Error 939524180 ... Possible reason(s): Device: Parameter absolutely too big: The 
parameter is absolutely too big. 

• Error 939524181 ... Possible reason(s): Device: Parameter absolutely too small: The 
parameter is absolutely too small. 
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• Error 939524188 ... Possible reason(s): Device: Parameter improper with respect to 
device settings: The parameter is inappropriate due to other device settings. 

 
 
7. Readings are not within the expected range 

If a reading has a significant deviation at a known test load on the sensor or does not show 
zero at no-load, it can have many causes. 
First of all, you should work at zero load Set Zero or Set All Zero execute (see p. 84) and then 
apply a test load. If the result deviates significantly from the expected value, the following 
can be checked: 
- Is the correct calibration matrix configured for multi-axis sensors? s. S. 39 
- Is a common sensor configured correctly? s. S. 8 
- If the measured value is in saturation, i.e. it does not increase even when the load is 
increased, then the input measuring range may be too small, see p. 7. In this case, you 
typically see an error message when using BX6 or BX8 Sensor Fault! which appears at the 
top. 

If you click on it, a saturation error Input raw measuring value saturated is 
displayed, e.g. 

 

 
 
8. The readings are unstable 

There is slow instability, which is called drift. The readings then typically travel in one 
direction. The most common cause is temperature changes, and the amplifier and sensor 
also drift after being switched on. Therefore, you should wait about 20 minutes to an hour 
after switching on until the sensor and amplifier have reached their operating temperature. 
If the sensor is temperature drifting and the BSC2 is used, drift compensation may be used, 
see p. 126. 
Rapid instability is most often caused by the noise of the amplifier or disturbances, namely 
electrical EM disturbances or unwanted mechanical vibrations. This can be remedied, for 
example, by better shielding of the cables, better power supply or lower measurement data 
rate, see S. 16. 
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9. Problems with data evaluation with TDMS files 
If information about the acquisition of the measurement data is unknown, such as the 
display scaling or the measurement data rate, it can be found by typing in the File Monitor 
into the index card Properties Changes. To do this, select the group on the left side of the 
tree view Measuring Values or the channel. In Appendix B on p. 139 are the Properties listed. 
If a TDMS file cannot be opened, an error message appears, or the measurement data is or 
appears to be incomplete, the data set to S. 129 repair tools described above. 
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Appendix A: Hotkeys 
If BlueDAQ has the keyboard focus, you can trigger functions with the following keyboard 
combinations: 

 

Keyboard 
shortcut 

Path of the menu bar Meaning 

Ctrl o File->Open Session Open Session 

Ctrl s File->Save Session Save Session 

Ctrl t File->Open File Monitor Open File Monitor 

F1 File->Start Recording Yt Start recording with Recorder Yt 

F2 File->Start Recording XY Start Recording with Recorder XY 

F3 File->Stop Recording Stop Recording 
Ctrl q File->Quit Close program 
Ctrl n View->Configuration Switch to Configuration Flashcard 
Ctrl y View-> Yt Recorder Switch to Recorder Yt Flashcard 
Ctrl x View-> XY Recorder Switch to Recorder XY Flashcard 
Ctrl d View->Value Display Switch to Value Display Flashcard 
Ctrl + View->Add Graph Window... Open a new graphical window 
F4 Action->Start Measuring Yt Start Measurement in Time Graph 
F5 Action->Start Measuring XY Start Measurement in XY Diagram 
F6 Action->Stop Measuring Stop Measurement 
F8 Action->Enable Trigger Paste Enable triggered pasting into another program 
F9 Action->Disable Trigger Paste Disable triggered pasting into another program 
F10 Action->Enable / Disable value Paste 

by F-Key 
Enable/disable pasting into another program 

F11 Action->Append values to clipboard Append readings to clipboard 
F12 Action->Copy values to clipboard Paste Readings to Clipboard 
Ctrl a Action > Set All Zero Zeroing All Channels 
Ctrl l Device->Load Settings... Load device settings 
Ctrl e Device->Save Settings... Save device settings 
Ctrl f Device->Frequency... Changing the Measurement Data Rate 
Ctrl Image↑ Channel >Next Increase Display Channel 
Ctrl Image↓ Channel->Previous Decrease the displayed channel 
Ctrl z Channel >Zero Set Displayed Channel Zero 
Spacebar - Retrieve a single measured value from your 

device (send command GetValue) 
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Appendix B: TDMS Properties 
With the recorded TDMS files, properties are saved, which can be displayed in the File 
Monitor. Here is a list of all the properties. 

 

Name Description / Contents Data 
type 

Condition/Sensor/File 
Type 

1. At group level, i.e. in Measuring values 

File Type "Standard" / "Raw data" String All 

Diagram Type "Yt"/"XY" chart type String All 

Program Version BlueDAQ version used to create this file String All 

Start Mode Method of starting the measurement String All 

Finish Mode Method of starting the measurement String All 

Decimation About Software Decimation String All 

AnnotationNum Number of notes Int Only if available 

AnnotName<0..N> Note text String Only if available 

AnnotVals<0..N> In-program encoding of additional note 
information 

String Only if available 

2. At the channel level 

Final Time Termination Time Time 
Stamp 

All of them, but only 
available in the 1st 
channel 

DT Mode Timestamp calculation method for wf_increment 
"tf": start, stop time, and value count" 
1/f0" Device Measurement Data Rate 
"user": User-defined time increment 

String All of them, but only 
available in the 1st 
channel 

ToffsetUTC Time zone: Offset to UTC, in hours Double All of them, but only 
available in the 1st 
channel 

ChannelType Input type:"analog": 
Analog input"counter": 
Counter/Frequency","Longitude": GPS/GNSS 
Geocoordinates"Altitude" GNSS Height of geoid in 
m"Speed" GNSS speed in km/h"UTC 
time" UTC time of GNSS/GPS" 
Math 
 
" 
Computed MathChannel (MathScript) 

String All 

NI_ChannelName Channel Name String All 

NI_DataType Encoded data type of content (=10) Int All 

NI_ChannelLength Total number of readings per channel Int All 
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Name Description / Contents Data 
type 

Condition/Sensor/File 
Type 

NI_UnitDescription Unit String All 

wf_start_time Acceleration time Time 
Stamp 

All 

wf_increment Time increment in seconds Double All 

wf_samples Number of readings in the last data packet Int All 

wf_start_offset Start offset, always =0 Double All 

InputNo Amplifier input channel Int All 

Serialnumber Serial number of the amplifier or MathScript No. Int All 

DevComNo COM port or device number Int All 

Color RGB value of channel color Int All 

DeviceType Amplifier Model Name String All 

Frequency Set measurement data rate of the amplifier Double All 

Scaling user scaling or hardware-calculated multi-axis 
sensors. Measuring range 

Double All 

name Channel name (Unique identifier!) String All 

unit_string Unit String All 

Axis Plot axis mapping "X"/"Y" String XY only 

PysicalName Default name, e.g. "Com1_1 String Raw File 

SensorIndex Index of the multi-axis sensor in the sensor array Int Raw File 

Emodul Elasticity Module Double Rosette Measurement 

Poissons Transverse Contraction Number Double Rosette Measurement 

GageFactor K-Factor of Strain Gauge Double Rosette Measurement 

InSens Input Sensitivity of Measurement Amplifier Double Rosette Measurement 

SpecialSensor "Multi-dimensional/Six-Axis/RosetteStress" String Raw File 

CalculationInput Multi-dimensional: "Component1-6" Int Raw File 

SensorTypeNo Type of multi-axis sensor / calculation Int Multi-axis sensor (SW) 

SensorSerNo Sensor Serial Number Int Multi-axis sensor (SW) 

GeoOffsetX Geometric distance in m, X-direction Double Multi-axis sensor (SW) 

GeoOffsetY Geometric distance in m, Y direction Double Multi-axis sensor (SW) 

GeoOffsetZ Geometric distance in m, Z-direction Double Multi-axis sensor (SW) 

SensorPath Sensor calibration data file path String Multi-axis sensor (SW) 

MadeFromChan For additional file Max/Min/Average: Source 
channel 

Int Max/Min/Mean Channel 
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Name Description / Contents Data 
type 

Condition/Sensor/File 
Type 

MscriptPath Path to MathScript that created this channel String Math channels 

InType Input Type (Device-Dependent Enumerator) Int All 

InRange Analogue input range Int All 

HW-Sync Hardware Synchronization: "Master"/"Slave" String When using HW-Sync 
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Proof of change  

Version Status Processor 
00.00.01 Initiated HK, SW 
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